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Welcome to Papyrus!

The Papyrus Bibliography & Knowledge Management System helps you maintain a perma-
nent collection of reference citations.

If you need to locate all references on a particular topic, or track down an article you recall
having read last year, you can use Papyrus to rapidly search your citation collection. The re-
sults can then be sorted and formatted however you like.

If you are a student, a scholar, a researcher, or the secretary of any of these, then Papyrus can
also automate the bibliographic aspects of your work. Whenever you need to print a bibliog-
raphy for a manuscript in preparation you can select the appropriate references from your
collection and use Papyrus to print the bibliography in any desired format. Papyrus can work
with your word processor to automatically read your manuscript, create the bibliography, and
produce a final draft of your manuscript in which the in-text citations have been appropriately
edited.

New references may be added to your collection at any time, and existing references can, of
course, be edited or deleted. You can also import references from virtually anywhere—national
online databases, CD-ROM bibliographic databases, monthly diskette update services, other
personal bibliographic database programs, general-purpose database applications, or existing
bibliographies from your word processor.

You can also attach an unlimited number of notecards to each of your references. Each notecard
provides ample room for your comments on your reading, or quotations from the original
sources. Notecards are ideal for preparing a dissertation or for summarizing a series of lengthy
works. Notecards can also help you organize your own works in progress.

Papyrus lets you link your references to each other to indicate various kinds of connections;
e.g., that one reference refutes another reference, or that one work is a review of another.

The current version of Papyrus incorporates literally thousands of suggestions from our users
over the past decade. We believe that Papyrus stands alone among bibliographic programs in
its power and ease of use. Nevertheless, we still consider Papyrus a work in progress, and will
always welcome your further recommendations.

This edition of Papyrus, Version 8.0, has been implemented on Macintosh computers running
System 7 or Mac OS 8. A full Windows implementation of Papyrus Version 8 is under develop-
ment—check our Web site, www.rsd.com, for news. In the meantime Papyrus Version 7 for
DOS continues to be available.
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Full vs. Limited Versions of Papyrus

Papyrus Version 8 is available in two editions: the Full Version and the Limited Version. The
two are identical in all but a few respects.

First, the Full Version allows an essentially unlimited number of entries in your database. The
Limited Version will allow you to enter up to 200 references.

The second difference between the two versions is that the Limited Version is free. You and
your colleagues or students can download a copy from our Web site, www.rsd.com. You may
also make copies of the Limited Version and distribute them to others (provided that you copy
the entire Limited Version without modifications, changes, additions or deletions).

If you use Papyrus to assemble a large collection of references and your colleagues begin clam-
oring for their own copies of your database—or you think you could entice them to send you
large sums of money for their own copies of your database—then they will also need their own
copies of the Papyrus application in order to make use of your data files. While we do like to
think that all of your colleagues will rush out and purchase their own copies of Papyrus, the
Limited Version can serve as an interim solution. A legal interim solution.

When someone uses the Limited Version to access a database containing more than 200 refer-
ences, the database will be opened in read-only mode. This means that they can review all the
information already in the database, but they cannot make any changes or additions.

So when you provide copies of your Papyrus database to your colleagues, you can simply
include a copy of the Limited Version of Papyrus along with your database files.

Of course, Research Software Design’s usual unlimited technical support  is available
only to those of you who purchase the Full Version of Papyrus.
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Our Ridiculously Reasonable License Policy

We recognize that many of you will need to access your bibliographic database on more than
one computer. Perhaps one at work and another at home, or one on a researcher’s desk and
another on a secretary’s. So rather than restrict the number of computers on which you can use
this copy of Papyrus, we license the program based on the number of distinct Papyrus data-
bases you use, regardless of how many different computers or people are accessing copies of
the same database.

For full details of our license policy, as well as some Site License options, please refer to the
License Agreement section.

We have taken this approach because we feel that you deserve it. But we won’t be able to
continue to offer these services if we go out of business, so please do your share—feel free to
distribute copies of the Limited Version to your friends, but don’t distribute copies of the Full
Version, and please do not use the Full Version yourself unless you are a fully licensed Regis-
tered User.

Thank you!
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Overview of the Papyrus Documentation

Different people learn best in different ways, so we have provided you sufficient materials for
more than one approach to learning Papyrus.

There are three main parts to the Papyrus documentation: WORKBOOK, CONCEPTS, and REFERENCE.
The WORKBOOK takes a tutorial, task-oriented approach. One chapter, for example, leads you
step by step through the process of entering references into Papyrus. Another walks you through
the steps of searching your database for a particular set of references and then printing them.
Using Papyrus with your word processor to assemble a bibliography for a manuscript is the
task reviewed in a later chapter.

The CONCEPTS section explains several fundamental ideas that, sooner or later, you need to un-
derstand in order to work with Papyrus. Some of these may already be familiar to you from
work with other computer programs, while others are specific to Papyrus.

Finally, the REFERENCE section contains a detailed review of each Papyrus feature.

If you like to jump right into new software, then turn to the WORKBOOK. The first few chapters
will help you master basic Papyrus operations—you can later work through the more advanced
chapters as you need them. When you require more detailed information on a particular fea-
ture, the WORKBOOK will refer you to the appropriate chapter of the REFERENCE section. And sooner
or later you should take the time to review the CONCEPTS section to ensure that you are not
missing any important ideas.

On the other hand, maybe you prefer a solid understanding of what this program is going to do
with your valuable information before you start giving it free rein. Then you should start with
CONCEPTS. Afterwards you will probably want to peruse at least the first several chapters of the
REFERENCE section. At that point you should feel quite confident entrusting your data to Papyrus,
understanding exactly how Papyrus will manipulate it. And when you later need to accom-
plish a particular task for the first time, you can turn to the appropriate chapter of the WORKBOOK.

Of course, there are some people who can only absorb difficult information directly from an-
other human being. Unfortunately, Research Software Design lacks the resources to provide
your with a personal Papyrus tutor. But if you find yourself stymied despite all of our docu-
mentation, then please contact us.
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License Agreement—Summary

This Summary of the License Agreement is included for your convenience only, and
does not constitute a part of the License Agreement. For the text of the License Agree-
ment, see below.

We encourage you to share Papyrus with your friends and colleagues. In fact, we give you full
permission to distribute copies of this documentation, in electronic or paper form, and copies
of the Limited version of the Papyrus application. Just be sure to include the entire Limited
application, including all associated files, plus all copyright and trademark notices, as well as
the License Agreement, without any modifications, changes, additions or deletions. The actual
License Agreement explains the details of these arrangements.

Basically, you may distribute copies of the Limited Version to anyone who would like to try it
out. But since we are hoping to make a few bucks here, you may not distribute the Full Version.

Research Software Design will only provide full technical support for those of you who pur-
chase your own Full Version.

Just to be sure that you’re paying attention here:

You may distribute copies of the Limited Version of Papyrus.

You may not distribute copies of the Full Version of Papyrus.

Got it?

Next important point:

Your purchase of a Full Version entitles you to up to four
(4) distinct databases.

Two databases are “distinct“ if they contain independently maintained reference collections.
Allow me to explain.

First, you may keep as many Papyrus databases as you like on a single personal computer’s
hard disk(s) or on its collection of floppy disks, Zip disks, or other media. All of these databases
together constitute a single “distinct” database for our purposes here.

The preceding paragraph does not apply to either a network of computers nor a multiple-user
fileserver or minicomputer. In these situations, each and every Papyrus database is considered
a distinct database.

Second, if you make a copy of your database and bring it to a second computer for your own
use—e.g., you want a copy of the same data on both your work computer and your home com-
puter—the copy does not count as an additional distinct database. Similarly, if a principal
investigator purchases Papyrus, then the same database may be copied to several computers
within the research group, and still be considered only a single distinct database.
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Of course, in these situations we give you permission to copy the Full Version of the
Papyrus application to each of these computers as well.

Note that your entitlement to four distinct databases does not mean that you get one, your
sister gets one, and two of your fellow graduate students each gets one. All four databases
must be used by you or your employees/staff/students.

Most of you will actually have only one “distinct” database, whether it is used by a single
person or by an entire research group—the point in these situations is that each of the comput-
ers has a copy of the same data. However, if Papyrus is purchased by, say, a university
department, then each research group in that department will presumably have its own distinct
database. In this case you will probably soon exceed the limit of four distinct databases.

If you plan to have more than four distinct databases, you
must purchase a Site License from us.

A Site License costs $200, in addition to your initial Papyrus purchase price. (Local resellers
may add an additional service charge.) Once you have paid this one-time fee, you may main-
tain a total of up to twenty (20) distinct databases, provided that all of them are used by the
Registered User or his/her/its employees/staff/students.

If you find your department exceeding 20 distinct databases, you may purchase additional
$200 Site Licenses at any time. Each raises your authorized limit by another 20 distinct data-
bases.

In addition to these Departmental Site Licenses we also offer Institutional Site Licenses for
entire universities or corporations. Contact Research Software Design for details.
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RESEARCH SOFTWARE DESIGN™ END USER LICENSE AGREEMENT

CAREFULLY READ ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT PRIOR TO USING
THESE PROGRAMS. YOUR USE OF THE PROGRAMS OR YOUR REGISTRATION INDICATES YOUR
ACCEPTANCE OF THESE TERMS AND CONDITIONS.

1. LICENSE: You are hereby granted a limited, non-exclusive right to use the enclosed programs (together
known as “PAPYRUS”).

2. REGISTRATION: When you purchase a copy of PAPYRUS and complete the Registration Process, you
become a Registered User. The Registration Process involves your completion of a Registration Form or
Registration Card as provided by RSD, and your return of that completed Registration Form or Registra-
tion Card to RSD via postal, electronic, or other means acceptable to RSD.

3. SCOPE OF REGISTRATION: When you complete the Registration Form or Registration Card, you must
indicate the Registered User—either a specified organizational entity (such as a particular research group,
a particular university department, or a particular company), or a specified person. Use of the programs
and related documentation by any individual, as part of that individual’s duties to the specified entity or
person, will be considered to represent use by the Registered User.

4. DISTRIBUTION OF LIMITED VERSION: You may make and distribute copies of the Limited Version of
the enclosed programs, related files, and documentation to other individuals. These individuals will not
themselves be Registered Users, unless they too purchase their own copy of PAPYRUS and complete their
own Registration Process. You must include all copyright notices in any copies you make of the programs
or documentation, and you must make clear to any such individuals that they are bound by all terms of
this Agreement, whether they register or not. Furthermore, the obligations of RSD to Registered Users, as
specified in this Agreement, do not extend to unregistered users of the programs.

    When distributing copies of the programs and documentation to other individuals, you may include
any or all of the files provided on your disk(s), tape(s), or other medium, except for the file representing
the Full Version of the PAPYRUS application. COPIES OF THE FULL VERSION OF THE PAPYRUS AP-
PLICATION MAY NOT BE GIVEN TO INDIVIDUALS WHO ARE NOT REGISTERED USERS.

    YOU MAY NOT COLLECT ANY PAYMENT FROM SUCH INDIVIDUALS, BEYOND YOUR ACTUAL
COSTS OF MAKING AND DISTRIBUTING THE COPIES.

5. DISTRIBUTION AND USE OF FULL VERSION: Your purchase of the Full Version of PAPYRUS entitles
you to use the enclosed programs to create a maximum of four (4) distinct databases. Two databases are
considered “distinct” if they contain independently maintained collections of data.

    Any number of PAPYRUS databases maintained on the hard disk(s), floppy disks, Zip disks, or other
media all used with a SINGLE PERSONAL COMPUTER AND NOT ACCESSIBLE BY OTHER COMPUT-
ERS will be considered to together constitute a SINGLE distinct database.

    Any PAPYRUS database accessible via a NETWORK OF COMPUTERS or via a MULTIPLE-USER
FILESERVER will be considered a distinct database.

    If a COPY is made of all or part of a database and placed on one or more other computers belonging to
the Registered User, for the sole purpose of accessing the same data at additional locations, these copies
will NOT be considered additional distinct databases. You may copy the Full Version of the PAPYRUS
program to each of these computers as well, provided that use of such copies of the Full Version is re-
stricted to the Registered User as per Section 3 of this Agreement.

    In the event of any dispute, RSD will have the sole right to determine how many distinct databases are
in use by a Registered User, provided such determinations are a reasonable interpretation of this provi-
sion.
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    If you will have more than four distinct databases, you must purchase a Site License and pay an addi-
tional Site License Fee. The initial payment of this Fee will raise your authorized maximum number of
distinct databases from four (4) to twenty (20). Subsequent additional payments of the Site License Fee
will raise your authorized maximum number of distinct databases in increments of twenty (20) additional
distinct databases per Site License Fee paid.

6. TRANSFER OF REGISTRATION: You may transfer your Registration to another party if the other party
agrees to the terms and conditions of this Agreement and completes a Registration Card or equivalent
form and returns it to RSD. If you transfer your Registration, you may not keep any copies of the Full
Version of the PAPYRUS application, although you may keep and use copies of the documentation and
the Limited Version program and related files. If you do keep copies of any of the files, you remain bound
by all terms of this Agreement, even though RSD’s obligations to Registered Users no longer extend to
you.

7. COPYRIGHT: The programs and their related documentation are protected by the copyright laws of the
United States and other countries, as well as by international treaties and conventions. You may not make
any modifications, changes, additions or deletions, nor translate the programs nor documentation in any
way, without the prior written consent of RSD. Any preparation or distribution of copies of the programs
or documentation not in accordance with this License Agreement is in violation of both this Agreement
and U.S. and foreign copyright laws.

8. TERM: This license is effective until terminated. You may terminate it by destroying all copies of the
programs and documentation which are in your possession, plus all of your data-files created by these
programs. This license will also terminate if you fail to comply with any term or condition of this Agree-
ment. You agree upon such termination to destroy all copies of the programs and documentation which
are in your possession, plus all of your data-files created by these programs.

9. LIMITED WARRANTY: RSD warrants to Registered Users that the enclosed programs will perform
substantially as indicated in the accompanying documentation. In the event they do not so perform, and
provided you are a Registered User, RSD will have the option of either providing corrections to the pro-
grams as per Section 10 of this Agreement, or of accepting return of all materials for a full refund of the
price you paid. You have no other remedy for breech of this warranty.

    RSD warrants the disk(s), tape(s), or other medium on which the programs and documentation are
recorded to be free from defects for ninety (90) days from the date of shipping. RSD will replace any
defective disk, tape, or other medium which is returned to RSD within this ninety day period.

    THE ABOVE IS THE ONLY WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, IN-
CLUDING, BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE THAT IS MADE BY RSD ON THIS RSD PRODUCT. THIS
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS
WHICH VARY FROM STATE TO STATE. NEITHER RSD NOR ANYONE ELSE WHO HAS BEEN IN-
VOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS PROGRAM SHALL BE LIABLE
FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING OUT OF
THE USE, THE RESULTS OF USE, OR INABILITY TO USE SUCH PRODUCT EVEN IF RSD HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR CLAIM. SOME STATES DO NOT ALLOW
THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAM-
AGES SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

10. UPDATES, CORRECTIONS AND NEW VERSIONS: A “Maintenance Update” of PAPYRUS is a modi-
fied edition of the programs incorporating corrections or minor changes. A “New Version” of PAPYRUS is
a modified or new edition of the programs incorporating significant enhancements. RSD shall make these
designations at its sole discretion, provided that RSD uses the same categorizations for all of its custom-
ers.
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    RSD will announce the availability of Maintenance Updates and New Versions on the RSD Web site
and through any relevant e-mail subscription lists maintained by RSD.

    Maintenance Updates will be offered to all Registered Users free of charge, except for the actual costs of
materials, shipping and handling.

     Should New Versions of the programs become available, these will be offered to all Registered Users at
not more than one third (1/3) of the suggested retail price.

11. SUPPORT SERVICES: RSD will respond in a timely fashion to any telephone calls or correspondence—
whether by mail, fax, or electronic mail—from Registered Users regarding difficulties with the programs
or documentation. There will be no fee for such services. RSD reserves the right to change its support
services, institute a charge for support services, or terminate support services at any time.

12. MISC.: This Agreement shall be governed by and construed in accordance with the laws of the State of
Oregon, United States of America. Any disputes under, or arising from, or related to this Agreement shall
be subject to the exclusive jurisdiction and venue of the courts of the State of Oregon, with venue in the
Multnomah County Circuit Court. Alternatively, at the election of RSD, jurisdiction and venue may in-
stead lie with the United States District Court for the District of Oregon (Portland Branch).

13. ACKNOWLEDGMENT: YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT,
UNDERSTAND IT, AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU ALSO AGREE
THAT THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BE-
TWEEN THE PARTIES AND SUPERSEDES ALL PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR
WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE
SUBJECT MATTER OF THIS AGREEMENT.

    Should you have any questions concerning this Agreement, please contact: Research Software Design,
2718 SW Kelly Street, Suite 181, Portland, OR 97201; 503/796-1368; fax 503/241-4260; e-mail: info@rsd.com.
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Reference

A little raised number at the end of a statement is not an icon of inerrancy.

—David C. Slawson and Allen F. Shaughnessy,
British Medical Journal, March 1997
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Introduction

The details of how you get the various Papyrus-related files onto your Macintosh’s hard disk
depend on whether you install Papyrus from our CD or download it from the World Wide Web.

I suppose there might also be a few misguided individuals who try to install a pirate copy
of Papyrus illegally obtained from a “friend.” To such venturesome individuals I cannot
offer very detailed installation advice. Nor can I guarantee that such a copy of Papyrus
will not seriously rearrange the contents of your hard disk, or perhaps cause your
Macintosh to make lengthy overseas phone calls while you sleep.

Installing from CD-ROM

Insert the Papyrus CD into your computer’s CD-ROM drive. Then double-click the Install
Papyrus icon. After asking you to review our Papyrus license agreement, the installer will offer
you choices about which files to install, and let you specify the location on your hard disk to
which these files will be sent.

Also included on the CD are installers for the Limited Version of Papyrus. You may copy any of
these Limited Version installers and distribute them to your friends or colleagues so that they
can try the Limited Version of Papyrus for themselves.

Installing from the Web

You can download Papyrus and its associated files from our Web site, <http://www.rsd.com/> .
The Web site includes all necessary instructions for downloading and decompressing the vari-
ous files.

You should place all of the downloaded files into a single folder on your hard disk.
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Organization of folders

The Papyrus application and its attendant folders should be organized as shown below. Here
they all reside in a folder named Papyrus, but that is not essential. What matters is that all three
of these items live together in a single folder.

The Papyrus Help folder contains an online version of the Papyrus manuals, in a form suitable
for use with your Web browser. The documents in this folder have names ending in .html—
these contain the text of the online documentation.

Inside Papyrus Help you will also find a pair of folders, named Images and Images2. These
folders each contain a large number of .gif documents, which are the graphic images for the
online documentation.

The complete set of help files take up a lot of disk space. If you have our CD-ROM version of
Papyrus, then instead of installing the Papyrus Help folder onto your hard disk you can instead
make an alias to this folder on your CD-ROM. Move the alias into the Papyrus folder, and make
sure that the alias is named Papyrus Help:
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You can use this same approach if you wish to store the help files on a separate hard disk, Zip
disk, or other medium.

The Papyrus Additions folder contains various plug-in filters that are necessary for certain
Papyrus tasks. In the future we may also find other uses for this folder.
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Introduction

You will find no surprises in launching Papyrus. As with most Macintosh applications, you can
double-click either the Papyrus application itself or else a Papyrus database document.

See also:

WORKBOOK

Creating a fresh Papyrus database
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Launching the application

Once you have installed Papyrus on your Macintosh, simply double-click the Papyrus applica-
tion icon to launch it.

When Papyrus then gets itself started up, it will display this dialog asking you to identify your
database:

Since you don’t yet have any Papyrus databases, click New. Papyrus will ask you to name your
new database:
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Enter whatever name you like, then click Save.

Next Papyrus requests some basic information about your database. In most cases you will
enter a description but will make no changes to the Allowable Reference Numbers:

This dialog is discussed in a bit more detail elsewhere.

Papyrus now creates two documents that together represent your database:

My References is your main Papyrus database document. All of the information you enter into
Papyrus will be stored here.

My References.idx is your database’s index file. Papyrus maintains quite a few indices in here,
including the author index, editor index, reference number index, keyword index, journal in-
dex, etc. Papyrus uses these indices to rapidly carry out its operations.
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Given a main database document, Papyrus can always regenerate the corresponding index file.
So when making back-ups of your data you can save a copy of just the main database docu-
ment, if storage space is limited.

Launching a database

Once you have created a Papyrus database, in the future you can launch Papyrus by double-
clicking either of your Papyrus database documents, rather than the Papyrus application itself:

This is a Good Thing for two reasons:

• You accomplish in a single step what would otherwise take two steps (launch-
ing Papyrus, and then pointing Papyrus to your database).

• The database document can be located in a folder you usually keep open on
your desktop, while the Papyrus application might be buried deeply within
an Applications folder somewhere.
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Using an alias

As a further shortcut beyond double-clicking one of your Papyrus database documents, you
can make an alias to the document and move that alias to your desktop or other convenient
location.

In the Finder, select your main database document and then choose Make Alias from the File
menu:

Drag this alias to a convenient location on your desktop. You might then want to erase the word
“alias” from its name.

Henceforth you can double-click this alias to launch Papyrus and automatically open the cor-
rect database.



Chapter 3: Online Help R13

C
O

N
C

E
P

T
S

R
E

F
E

R
E

N
C

E

CHAPTER 3

Online Help

Introduction ..........................................................R14
Balloon help ..........................................................R14
Getting to the online help ..................................R16
Navigating the online help .................................R17



R14 Getting Started

Introduction

Papyrus provides two forms of online assistance.

Balloon help is available for most Papyrus windows, and for all menus. It is especially useful
for answering the questions What does this thing do? and Where do I click to make Papyrus do what
I have in mind?

The online help is a complete copy of the Papyrus manuals, in the HTML format employed on
the World Wide Web. Papyrus uses your Web browser to display the help pages corresponding
to your needs of the moment.

Balloon help

Balloon help is a standard feature on the Macintosh, although not all applications take advan-
tage of it. Once balloon help has been turned on, whenever you point at something on your
screen a cartoon-like balloon will appear with a brief description of that object:

Papyrus offers three ways to turn balloon help on and off.

The Help menu

In Mac OS 8.0 and newer, all applications include a Help menu. In System 7 this menu is indi-
cated by a  symbol near the right edge of the menu bar.

To turn balloon help on, select Show Balloons from the Help menu. To turn balloon help off,
select Hide Balloons.
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The Help key

Most Macintosh keyboards include a key labelled help. In Papyrus, pressing this key turns
balloon help on or off.

The Balloon Help button

All Papyrus windows for which balloon help has been provided include this button in their
lower left corner: . Clicking this button turns balloon help on.

The button changes to  whenever balloon help is on. Clicking the button will then turn off
balloon help.

Besides turning balloon help on and off, this button provides two other benefits.

First, if a window includes a  button then you know that balloon help is indeed available for
the window.

Second, if you double-click the  button, Papyrus will give you a balloon tour of all the con-
trols in the window. You can sit back while Papyrus displays a balloon for each element of the
window, one after another.

If you wish, when you are done reading a balloon you can hurry Papyrus on to the next
by pressing your keyboard’s space bar .



R16 Getting Started

Getting to the online help

Papyrus uses your Web browser to display detailed online help. There are two ways to access
this help from within Papyrus.

The Help menu

In Mac OS 8.0 and newer, all applications include a Help menu. In System 7 this menu is indi-
cated by a  symbol near the right edge of the menu bar.

Papyrus adds four items to the Help menu:

Papyrus Help
Selecting this item takes you to the master table of contents for the online help.
From this page you can move to the table of contents page for the WORKBOOK,
CONCEPTS, REFERENCE, or SHORTCUTS section of the online manuals.

Help for front window
Selecting this item takes you to the page in the REFERENCE section correspond-
ing to the current front window in Papyrus.

Shortcuts for front window
Selecting this item takes you to the page in the SHORTCUTS section correspond-
ing to the current front window in Papyrus. (If there is no SHORTCUTS page for
the window, you will find yourself instead at the corresponding REFERENCE page.)

Visit the RSD Web site
Selecting this item sends your browser out to the World Wide Web, to Research
Software Design’s site at www.rsd.com .

The Online Help button

Most Papyrus windows include this button in their lower left corner: 

Clicking this button is equivalent to choosing Help for front window from the Help menu—
your browser will display the REFERENCE page for the window.

Option-clicking this button is equivalent to choosing Shortcuts for front window from the
Help menu—your browser will display the SHORTCUTS page for the window.
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Navigating the online help

All of your Web browser’s usual navigation controls—Back, Reload, etc.—are available to you
as you move about the Papyrus online help.

Wherever you see one of these symbols:

␣␣ ␣␣ ␣␣ ␣␣

clicking that symbol will take you to the corresponding table of contents.

Most chapters include multiple pages. You can read through a chapter in order by clicking the
 button at the bottom of each page.

You can also move directly to a particular page via the navigation bar in each window:
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Number of records

A Papyrus database can create and store approximately 16 million records, including refer-
ences, notecards, keywords, journals, formats, etc. It can additionally store approximately 16
million records transferred from each of 254 other Papyrus databases.

Size of references

Each field of a reference can hold approximately 32,000 characters.

Each reference can cite over 1,000 authors (up to a total of 32,000 characters for all authors).

Each reference can cite up to approximately 4,000 keywords.

Each reference can hold over 1,000 pictures or graphics, each of which can be up to approxi-
mately 100 Megabytes in size.

Reference types and fields

Papyrus currently includes 16 built-in reference types and 59 built-in fields. Future versions
may add further built-in types and fields.

You can add up to 100 additional reference types and 100 additional fields. If this should
prove overly restrictive we can increase these numbers in future versions of Papyrus.

Writing systems

Papyrus is WorldScript-savvy, which means that it will correctly handle text from non-Roman
writing systems such as Japanese, Greek or Arabic.
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See also:

WORKBOOK

Fields & Reference Types

CONCEPTS

Reference Types and Fields

REFERENCE

Reference Types and Their Fields
Database Settings
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Introduction

Papyrus is a normal Macintosh application—the application itself, your database, or both can
reside on a network-accessible drive rather than a local drive. As you’d expect, of course, ac-
cessing either the application or your database over a network will be somewhat slower than
working locally.

With Version 8.0 of Papyrus only one person can be working on a given database at any mo-
ment, unless the database is being accessed in read-only mode.

A future version of Papyrus will provide for client-server arrangements, allowing multiple
users to simultaneously update a shared database.

See also:

REFERENCE

Status window
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Read-only mode

If your database is locked:

then Papyrus will open it in read-only mode:

A read-only database can be searched, printed, etc., but you will be unable to make any changes
or additions.

A network file system may allow you to deny “write” privileges to certain users for certain
documents. If a user opens a Papyrus database for which she lacks write privileges,
then Papyrus will limit her to read-only access—just as if the document were locked in
the Finder as shown above.

When a given database is open in read-only mode, other users on your network can also access
that database in read-only mode. Hence a shared database can simultaneously be used by sev-
eral people looking up information or preparing bibliographies. However, while anyone has
the database open as read-only, no one else can make any changes to that database.

This limitation will be removed in the future client-server  implementation of Papyrus.

So over a network, a given Papyrus database can be in use according to either of two scenarios:

• A single user working in normal (read and write) mode.
• Any number of users, all of them working in read-only mode.
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In practice, the most common situation involves several co-workers who use a shared database
for looking up information and perhaps preparing publications or reference lists. But only one
or two trusted individuals ever make changes or additions to the database.

In this situation, you can maintain two copies of your database. A master copy is used by the
one or two trusted individuals, but is not available to the rest of the co-workers. Periodically a
secondary copy of the master database is made and placed on a network drive that everyone
can access. Via the Finder, or via network file system permissions, this database is locked or
otherwise made read-only. The various co-workers always work with this secondary copy of
the database.
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Introduction

In this chapter I’ll review Papyrus’s built-in reference types, and the various elements—fields,
in computerese—available to each.

In addition to the built-in ones, you can add your own new types and fields to your database.
We recommend, though, that before you create your own types or fields you first give some
thought as to whether existing ones could serve you adequately. For one thing, each time you
add a new reference type you will have to create a corresponding new template in each of the
output formats you use. For another, each new reference type or field you create results in an
increased possibility that you or one of your colleagues will enter data inconsistently from one
reference to the next.

Still, if you do have references of a kind not represented by Papyrus’s built-in types, or you
wish to store information that really doesn’t fit in any of Papyrus’s built-in fields, then by all
means feel free to create your own.

See also:

WORKBOOK

Fields & Reference Types

CONCEPTS

Reference Types and Fields

REFERENCE

Reference Entry Window
Database Settings
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Ubiquitous fields

Some fields are available in all references, regardless of reference type.

Reference #

Papyrus assigns its own consecutive Reference # to each and every reference entered. The very
first reference typed into Papyrus is #1, the next is #2, and so on. This Reference # provides a
concise and unambiguous way of referring to any particular reference within Papyrus. It also
enables you to examine, say, the most-recently entered batch of references, as these will be those
with the highest Reference #s.

Do not confuse Papyrus’s Reference #, which can be considered an inherent part of the
reference, with the ad hoc sequential numbers often printed beside references when
they appear in a bibliography.

You can override Papyrus’s suggested Reference #. So those of you who have a collection of
index cards or reprints with numbers already assigned need not worry—Papyrus will allow
you to use your existing numbers. The same applies for those of you who will be importing
numbered references from another personal bibliographic application, in case you wish to re-
tain the old numbers.

Papyrus’s Reference #s are just that: numbers. You cannot, for example, mix letters in with
them (A108, 291-b, or whatever). The highest allowable number is 8,000,000.

When you set up your database, you can restrict the allowable range of Reference #s.
For example, you might only allow entries with numbers from 1 through 1000, while your
colleague with whom you will be sharing data restricts her database to 1001 through
2000.
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ID Field

Some of you in fields such as mathematics or computer science are used to citing references by
some compact combination of their first author and year, such as Smith-95 or SMIT95. Papyrus
offers an ID Field where you can enter such an identifier.

The ID Field will accept any combination of letters, digits, and these punctuation characters: ' ~
@ # $ - + _.

If you enter an identifier—say, Smith95—that is already in use by another reference, Papyrus
will offer to find the next available ID for you. To do so, it will automatically append a letter to
the end of the field, as in Smith95a.

If you later have Papyrus create a bibliography using an output format in which each
reference is prefaced by its ID Field, Papyrus will automatically remove such appended
letters. If two or more references in the bibliography then have the same ID, Papyrus will
add ad hoc sequential letters to them as needed.

Titles

As discussed in the CONCEPTS chapter Bibliographic Conventions, the titles of articles, books, chap-
ters, etc. may be capitalized in either sentence or headline style.

If you are confident that all of the Bibliography Editors who will ever see your work will agree
on the style of capitalization, then by all means enter your titles using the correct capitalization
in the first place. Otherwise always use sentence style when entering titles. Your output for-
mats can later instruct Papyrus to capitalize the words of titles in your printed bibliographies
using whichever style is appropriate.

When you enter titles in sentence style, as in The rise and fall of New Jersey, it is a
relatively simple matter for Papyrus to correctly convert this to headline style, The Rise
and Fall of New Jersey. But if you enter your title in headline style, then Papyrus cannot
reliably know which words to leave capitalized—even with a spelling dictionary it might
well produce The rise and fall of new jersey. So always enter titles in sentence  style.

Abstract

You may keep an Abstract of up to 32,000 characters with each reference.

If you need more than 32,000 characters then you will want to use Papyrus’s notecard
feature.

Comments

For your own working lists of references you might wish to include additional information
about each reference, information that you do not intend to include in your published bibliog-
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raphies. The Comments field provides a place for you to do so. For example, you can enter
cross-references to other works (See also Jones, 1989, in which the same points were ad-
dressed by...), your own pithy observations and insightful reactions (lousy study, but always
cited), or more mundane notes (2nd author spelled correctly?).

As with the Abstract field, if you have more than 32,000 characters for the Comments field then
you should instead use Papyrus’s notecards. These allow a more structured approach to your
note-taking, as each notecard can address a specific topic or a specific passage from the refer-
ence.

Keywords

Each reference can have up to approximately 4,000 keywords associated with it, as discussed in
the Keywords chapter of the CONCEPTS section. You’ll recall from that chapter that a keyword can
be either a single word (such as Cortex or Glass) or an entire phrase (such as Review Article or
Gyrase, DNA).

Typing a number sign (#) in front of a keyword designates it as major for a particular reference.
You can later search either for all references citing a certain keyword, or for only those refer-
ences that cite it as major.

URL

If a reference has a corresponding entry somewhere on the Internet or Usenet, you can enter
that location in the reference’s URL field. Later you can use Launch URL from the Edit menu to
have Papyrus take you to that location.

Be sure to enter a complete  URL, such as http://www.rsd.com/  rather than just, say,
www.rsd.com . Papyrus uses the Internet Config  extension to launch a URL, and Inter-
net Config uses the first part of the URL (http://, news://, etc.) to decide which helper
application is appropriate for the job.

Picture

You may paste or drag any sort of graphic into the Picture field.

Graphics usually come in multiple formats, such as PICT, JPEG, GIF, EPS, etc. When
you paste or drag a picture into Papyrus, Papyrus will display the included PICT repre-
sentation. However, Papyrus stores all available representations of the graphic. So if
you later copy or drag the graphic from Papyrus to another application, it will be as if you
had copied it directly from the original application.
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Common fields

Some fields are available in almost all reference types, apart from Notecards.

Accession #

You can use this field to store a locally-meaningful number, a universal library code number, or
whatever you like.

Note that several references types—including Book, Chapter, Dissertation and Map—also in-
clude a separate field for Catalog #. Typically you would use Catalog # rather than Accession #
for a library shelf code (Dewey Decimal, Library of Congress, etc.).

Authors and Editors

Papyrus allows over 1,000 authors per reference, plus a similar number of editors (where appli-
cable). Most human authors will have a surname plus one or more firstnames or initials. You
may enter either full firstnames (Richard Milhouse or just initials (R.M.) or a combination (Rich-
ard M.), whichever is most natural for you. When you have Papyrus output references, your
output format will tell Papyrus whether it should include full firstnames—where available—
or should convert all names to just initials.

Everything in this discussion of author names also applies to editors.

When you enter an author’s name into Papyrus, you always do in the form Surname,First or
Surname,First,Suffix. Here are some examples:

Einstein,Albert P    Picard,J-L    Gates,W,III

Papyrus will rearrange and re-punctuate these as necessary when they are output, according to
whatever rules are specified in the output format you choose at the time.

There is no problem if you include some spaces or periods when you enter a name.
Papyrus will automatically convert the name to the above form.

In fact, Papyrus includes a useful shortcut for entering most author or editor names. If
you are entering a normal human’s name you can forget about your Shift  key. For
example, you can enter the above names as:

einstein,albert p    picard,j-l    gates,w,iii

Papyrus will automatically give these the correct capitalization.

If for some reason you actually want a name in all lowercase letters (cummings,e.e.
comes to mind), type a backslash  at the end of the name:

cummings,ee\
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The backslash will not appear when Papyrus later outputs the name.

“Corporate” names are also acceptable:

The Flat Earth Society

But if you include a comma within the name of a corporate author, Papyrus will insist on inter-
preting this as a human’s name. To avoid this problem, when entering a corporate author name
that includes a comma, add a backslash at the end:

Big Brother and Sons, Ltd.\

If a reference is anonymous, and actually lists Anonymous as its author in the original publica-
tion, then enter Anonymous in the Papyrus Author field. But if no author is given in the original,
then enter Anon. (including the period). Your output format will specify whether or not to sup-
press the Anon. at the time the reference is output to a bibliography.

Sometimes when you are entering a reference you will know that you don’t know all of the
authors. In these cases you can enter et al. as the final author:

Author #1  Smith,AB
Author #2  Jones,PQ
Author #3  et al.

Papyrus will automatically flag the reference as INCOMPLETE. Later if you fill in the rest of the
authors you can remove the INCOMPLETE keyword. (See the Incomplete References chapter of
the CONCEPTS section.)

You can use et al. in the same fashion for editors.

“Authors” Role

Papyrus does not provide separate fields for editors, compilers, translators and commentators.
Instead, it provides Author and Editor fields, followed by corresponding fields for specifying
their roles.

For a work’s Authors, there is one combined field for their roles:
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In most cases you will not need to check any of these boxes, since the “authors” really are authors.
But when appropriate you can select one or more of these choices, as needed.

Role of “Editor”

For a work’s Editors, there is a separate role field for each name:

Most commonly you will just check the Editor box for each “editor.” But when appropriate, as
shown here, you should select whatever combination of roles applies—Papyrus is quite intelli-
gent about handling the resulting formatting.

Affiliation/Address

You can use this field to keep track of the authors’ institutions and/or addresses.

Year

You can almost always enter just two digits for a year. Papyrus is relatively clever in guessing
which century you have in mind.

If you simply must know the details...

When entering a year, if you provide only two digits Papyrus will usually assume the
current century. Thus, if during 1999 you enter 78, Papyrus will immediately expand this
to 1978.

However, if assuming the current century would result in a date 98 or more years into
the past, Papyrus will instead assume that you mean the next century. So if during 1999
you enter 00, Papyrus will convert this to 2000.
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On the other hand, if assuming the current century would result in a date more than two
years into the future, Papyrus will instead assume that you mean the previous century.
So if during 2001 you enter 95, Papyrus will convert this to 1995.

If you have multiple references by the same author or authors from the same year, do not ap-
pend a letter after the years to distinguish them:

Year    1990b    ←wrong!

Papyrus will take care of sticking letters after the year when it assembles and outputs particular
bibliographies.

Occasionally a reference will have a year such as 1976-1980. Such references include items
such as statistical compendia and reports. You may enter years like this, but be careful—many
reports include a range of years in their title, but were themselves actually published in a par-
ticular year. For example:

Kounter,BN; Sensus,D (1987): Electoral results in Southern California Primaries: 1960-
1986. Numeric Press, Los Angeles.

You can also put other things into the Year field, such as in press or submitted. Papyrus will flag
such references as INCOMPLETE. As suggested in the Bibliographic Conventions chapter of the
CONCEPTS section, a Papyrus output format can be told to suppress such non-numeric years.

Short Title

If you work in an area of study that commonly uses footnotes or endnotes in addition to bibli-
ographies, then you will be aware that a reference in a note often includes only an abbreviated
version of the work’s full title—particularly if this is not the first time that reference has been
cited. For example, this reference:

Kounter,BN; Sensus,D (1987): Electoral results in Southern California Primaries: 1960-
1986. Numeric Press, Los Angeles.

might appear in a footnote as:

B. N. Kounter and D. Sensus, Electoral results, 132.

Shortening a title in this way requires some human decision making, rather than leaving the
process to Papyrus. You can enter your preferred abbreviation in the Short Title field. When
Papyrus outputs a reference for use in a footnote, if it is the second or subsequent citation
Papyrus will use your Short Title rather than the full Title.
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Original Title

Works translated from one language to another have two versions of their title: the original
title and the translated title. In many areas of study—such as biomedical research—you will
mainly refer to such works by their translated title, which you will therefore enter into Papyrus’s
Title field. You can then place the original title into the Original Title field.

On the other hand, some of you—particularly those of a philological bent—will prefer to
use the Title  field for the original title, and will want a separate field named Translated
Title . Papyrus does not currently have such a field, but you can easily set one up for
your database.

Work reviewed

Reviews of books, plays, films and so on can appear as articles in journals, chapters in books,
newspaper articles, etc.. So for many reference types Papyrus provides a Work reviewed field
where you can enter the name and author of a work being reviewed:

Language

If you work with references that appear in a variety of languages, you can use this field to
record the original language of publication.
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Document/Media Type

This field provides a place to indicate that an “Article” in a journal or newspaper is actually a
Letter, a Review, a Correction, or some other special sort of communication:

You may also find uses for the Document/Media Type field with other sorts of reference. For
example, you could identify a “Book” as a Catalog, or a “Presentation at a meeting” as a Poster
Session.

Also Print

On occasion, some information that doesn’t belong in any of the other fields must be appended
to a reference. Examples might include in press or Work in progress. Whatever you enter into a
reference’s Also Print field will appear at the very end of the reference when it appears in a
bibliography.

You would usually only put in press  into the Also Print field if there were also an actual
Year to be displayed, or if you intended to use an output format that suppresses non-
numeric Years. Otherwise you could simply enter in press  as the reference’s Year.

Location

If you keep your reprints in separate cabinets or folders, you can indicate that information here.
Or you might use this field to indicate which library holds a particular book.
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Archival materials

Archival materials are original letters or other documents or artifacts held in a collection. For
example:

In the general case, the item being referenced is part of a series of items held within an archive,
which is located in some particular city. The “series” might consist of a particular set of filing
cabinets, or perhaps a medium-sized cardboard box.

In some cases, as illustrated above, the item in question might exist in more than one archive.
You can list multiple archives and cities.

Depending on the specific details of the item cited and of the collection, you might leave several
of these fields blank.
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Article in journal

An Article is a reference that appears in an issue of some sort of periodical publication. There is
usually no confusion in recognizing an Article for what it is, except perhaps in the case of an
article appearing in a hardbound annual publication.

Here is a sample Article:

As I explained in the CONCEPTS chapter Journals, to cite works from most journals you need only
include responses for the Volume and Page(s) fields. However there are a few journals that also
require answers for Issue, Supplement, Day & Month, and/or Journal Series.

Rarely, special issues of journals appear that list one or more Issue Editors. There is also an
Issue Title field for such special occasions.

Although the Page(s) field is usually straightforward when citing scholarly journals, it can get
a bit more complicated with popular magazines or “throw-away” professional journals. These
often “jump” an article across a series of discontinuous pages. In such cases you may have to fill
in Page(s) with something like 36-37, 67, 70-72. Of course, if you are both a non-purist and
lazy, I suppose you could just enter 36-72. I’ve also occasionally seen this sort of thing cited as
36+. So use whichever style seems familiar in your field.
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Book/Monograph

A Book or Monograph is a bound volume, cited in its entirety. For example:

As we discussed at length in the Bibliographies vs. Footnote Lists chapter of the CONCEPTS section,
no specific page numbers have been entered here. However, a Total # pages field is available for
those of you whose bibliographies require it.

Sometimes the “authors” of a book actually edited or compiled it, and should therefore be identi-
fied as editors when the reference is printed (e.g., Diem,K; Lentner,C (Eds.) (1970): Scientific



Chapter 6: Reference Types and Their Fields R41

C
O

N
C

E
P

T
S

R
E

F
E

R
E

N
C

E

Tables. CIBA-GEIGY, Basle, Switzerland.). Use the “Authors” role field when the “authors” have
some other role.

Sometimes the people associated with a book have a multitude of roles. The “Authors” role field
applies to all Authors. If there are individuals with different roles, they should be entered using
the Editor and Role of “Editor” fields:

Other fields available for Books and Monographs include Volume and Total # Volumes—for a
given reference you would generally cite either a single volume or the whole set of volumes.

Papyrus also provides Catalog # and ISBN fields for those of you who need to keep this infor-
mation.

Books that are part of a larger series of books may have a Series Title, a Place in Series (Part 4
in the example below), and one or more Series Editors. So a particularly verbose entry could
look like:

Kat, Felix T (Ed.) (1992): Barks: Worse than Bites? 4th ed. Vol. 2. (Series Eds:
Sylvester,TC; Boots,PN, Analysis of the Enemy, Part 4.) Garfield Press, Boston.
324 pages.



R42 Papyrus Conventions

Reports

Most reports can be entered using the Book/Monograph reference type. The Day & Month and
Additional Information fields provide places for report numbers and such, while the various
Series fields can also come in handy:



Chapter 6: Reference Types and Their Fields R43

C
O

N
C

E
P

T
S

R
E

F
E

R
E

N
C

E

Now and then a report will be a compilation of many authors’ contributions. So an individual
part of such a report would be entered as a Papyrus Chapter:
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Chapter in book

A Chapter is a section of a book, with its own author or authors. The same book will have other
Chapters, some or all of them by different authors. The book itself will have been assembled by
an editor or editors. Note that in keeping with our previous discussions, if all of the chapters of
a book were written by the same author or authors, then a bibliographic citation should refer to
the entire work—as a Book/Monograph.

So here is a sample Chapter:



Chapter 6: Reference Types and Their Fields R45

C
O

N
C

E
P

T
S

R
E

F
E

R
E

N
C

E

Chapter # is seldom cited by most scientific Bibliography Editors.

As with Books, Papyrus provides fields for Edition, Volume, Series Title, Series Editor(s) and so
on. Those of you who like to drop names, therefore, might enjoy citing a chapter by one set of
authors in a book edited by another group of scholars which is in turn part of a series with its
own collection of editors. (Though you have to wonder how they’ll split up the royalties...)

Dissertation/Thesis

A Dissertation or Thesis is a bound work submitted in partial fulfillment of an academic de-
gree, such as a Ph.D. or M.A.

For example:

The Dissertation or Thesis field will almost always contain one of those two words, except
perhaps for non-English works. For very well-known institutions it is customary to omit the
institution’s city, as above.

Now and then I’ve seen a Day & Month included in the citation of a dissertation. A Catalog #
field is also available for those dissertations that have been assigned a library shelf code.
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Dissertations on Microfilm

When a dissertation has been published on microfilm, it should be entered as a Book rather
than as a Dissertation/Thesis:
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Internet source

Papyrus provides two different reference types for sources from cyberspace. Postings to news-
groups have their own type, Usenet post. All other Internet references, including Web pages,
ftp sites, telnet addresses, etc. use the Internet source reference type:

Obviously, the most important field here is URL. You should provide a complete URL, includ-
ing the prefix of http:// or ftp:// or whatever. Papyrus will then be able to use the appropriate
Internet helper application to link directly to the source.

Good scholarship requires that you include both Date posted and Date accessed, since Inter-
net sources are so subject to change over time.
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Issue of journal

Sometimes a journal will publish a special issue devoted to a single topic. You can cite such an
issue in its entirety:

This sort of special issue includes an Issue Title, and usually one or more Issue Editors. Other-
wise the various fields are mostly identical to those of the Article in journal reference type.



Chapter 6: Reference Types and Their Fields R49

C
O

N
C

E
P

T
S

R
E

F
E

R
E

N
C

E

Map

Maps are frequently referred to by geologists, geographers, political scientists, and Boy Scouts.
Here is a sample :

As with Books and Chapters, a Catalog # field is available.



R50 Papyrus Conventions

Newspaper article

Articles appearing in newspapers are very similar to articles appearing in periodical journals:

Papyrus treats entries in the Newspaper field as journals—they will appear in the Journals
window, where you can edit all the usual fields (Journal Abbreviation, ISSN, etc.).

Unlike journals, most newspapers will have a City of Publication—some national or interna-
tional newspapers are exceptions. Other fields that differ from journal articles include Edition
and Section.
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Patent

Patents are issued by governments to inventors (or to their employers). Sometimes these are
quite simple:

Note that in a patent the usual Author fields have been renamed Inventor.

Different countries issue different patent documents. What is called a Patent in the U.S. is a
Demande in France, a Kokai in Japan, an Offenlegungsschrift in Germany, and so forth.

Patents can also get rather more complex:
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Patent applications may be made in more than one country. In such cases the earliest is called
the Priority application. The Principal patent and all of the other Equivalent patents can together
be considered a “patent family.” However else they differ, the family members will all have the
same Priority application information.

Papyrus allows you to enter as many Equivalent Patents as necessary.
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Presentation at meeting

Among the reports that come out of conferences and symposia you will find some of the most
convoluted and inconsistent bibliographic references in existence. Unfortunately, for some ar-
eas of study they are also among the most common sorts of references.

The problems arise because there is more than one way to publish conference proceedings.
They may appear as a supplement to a regular issue of a journal, or take over the regular issue
itself. They may be printed and bound like a book—complete with an overall editor or editors,
a publishing organization, and a city of publication. Such a bound publication might be a one-
time event, or an annual one. On the other hand, some proceedings may never be published at
all—the conference attendees will simply take home copies or abstracts of the various papers
they heard presented.

• • •

The simplest situation is that of a paper presented at a conference whose proceedings are not
subsequently published. This is what Papyrus’s Presentation at meeting reference type is for:

Presentations at meetings take various forms, such as papers and poster sessions. Hence the
Presentation Type field.
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The Symposium Title and Chair fields allow you to indicate a particular session within the
meeting, perhaps with one or more chairpersons.

If the attendees walk away with a printed summary of the conference’s presentations, then you
can use the Page(s)/Abstract# field to reference a particular paper or abstract.

• • •

When a meeting’s abstracts or papers are subsequently gathered together and published, other
Papyrus reference types will usually fit better than Presentation at meeting. To enter into Papyrus
a reference from such a publication, first figure out how it was published.

If you see a publisher (which might be an organization, rather than a commercial press), a city,
and one or more editors, then treat the reference as a Chapter:

Note that the Book Title may potentially contain several pieces of information: the name of the
conference, its dates and/or its location. If you wished, you could move some of these to the
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Additional Info field. Also note that the city where the conference was actually held may differ
from the City of Publication for the published Proceedings.

You might run into a reference that looks almost like this one, but lacks editors. Go ahead and
make it a Chapter anyway, leaving the Editor field empty.

If your reference does not look much like a Chapter, next try to see it as an Article. First, perhaps
it was published in a supplement to a regular issue of a normal journal:

I’m showing this series of examples complete with editors. In other cases everything
else might be the same, but without editors.



R56 Papyrus Conventions

Or maybe a regular issue of a normal journal was completely devoted to the proceedings from
a conference:
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If the conference proceedings don’t seem to have been published as part of a normal journal,
then perhaps they themselves represent an annual periodical. If so, you would still use Papyrus’s
Article reference type:

In this case, the 22 in the Volume field implies that this was the 22nd annual meeting of this
society.

On aesthetic grounds, one might object to a journal named Proceedings of the 1990
Meeting of the McMurdo Sound Historical Society . After all, next year this “journal”
will change its name to Proceedings of the 199 1 Meeting of the McMurdo Sound
Historical Society . However, there is no hope for aesthetics when dealing with confer-
ence proceedings, so don’t worry about it.
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Quoted citation

Occasionally a reference is so obscure or ancient that you will not be able to actually find a copy
of it. Often in such cases you will lack the information necessary to completely enter the refer-
ence to the satisfaction of Papyrus (or of your Bibliography Editor). However, you will have a
copy of a more recent reference that cites the obscure one. How do I know this? Because it is
only due to this more recent reference that you learned of the obscure reference in the first
place.

A Quoted citation, then, is an unprocurable reference whose existence you can only document
via some other reference.

Here is a sample of a Quoted citation:

Usually Papyrus will not display the Reference #  for the quoting reference. The STAN-
DARD format, however, does always include the Reference #, as shown in the reference
preview above.

Note that for the quoted reference, only the Authors, Year and perhaps Title are provided.
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The quoting reference is entered separately into Papyrus. The Quoted citation then refers to this
other Papyrus reference. The quoting reference may be of any type except Quoted citation.
(Think about it...)
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Slide/Visual

You can use the Slide/Visual reference type to keep track of your collections of slides, nega-
tives, prints, overheads, etc. For example:

The usual Author field has been renamed Photographer, Title is now called Subject, and Abstract
is Description.

Some of the fields are intended for items that you have obtained from commercial or published
collections, such as illustrations from a book, or a series of slides of anatomical illustrations. You
can identify the origin of the item in the Source field, and use the Catalog # and/or ISBN fields
as appropriate.

For slides that you use in your classes or presentations, the Place Shown fields are available to
track your usage.

As with all predefined Papyrus reference types, the Slide/Visual type includes a series of Pic-
ture fields. If you have a digital rendition of the item being referenced, you can include that
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right in the Papyrus record. In some cases, such as computer graphics, you might actually em-
ploy Papyrus as your graphic library application:

If you have a lot of these, you might wish to rename the Photographer field to Artist or Designer
or Illustrator.
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Usenet post

Postings to newsgroups, unlike other Internet sources, get their own Papyrus reference type:

Including the Message-id from the post’s header provides for unambiguous identification of
the relevant post.

If you include an Archive URL, such as the DejaNews link shown above, then you and your
readers will have an easy time finding a copy of the post—even years after it has been erased
from everyone’s news server.
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Notecard

Notecards allow you to organize knowledge in manageable pieces. In many cases a notecard
will represent one bit of information from an article or book you have read. For example:

This particular notecard would be linked to its corresponding reference. Presumably you would
have several other related notecards, each summarizing a different aspect of the study to which
they are all linked.

Use the Place in reference field to indicate to which part of the linked reference this notecard
applies. Besides a section title, as shown above, this field might contain a chapter number, or a
range of pages.

The Quotation field provides room for a direct quotation from the reference. Saving each inter-
esting quote on its own notecard will make it easy for you to later do searches for specific
quotations.

Notecards do not need to be linked to any reference. They can be free-standing objects where
you jot down ideas or observations. These can be linked to each other to form a web of informa-
tion to help you organize your thoughts. You can even use notecards when preparing your own
publications, to store textual footnotes or (in the Picture field) illustrations and figures.
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Other reference

Very rarely, a reference will not fit into any of the specific Papyrus reference types predefined
by us or added by you. In such extremely unusual cases, you are dealing with an Other.

A small percentage of Papyrus users may find themselves using Others more frequently.
This might apply to you, for example, if you often cite personal communications, unpub-
lished letters, interviews, or the like.

For example:

Note that besides the always-available Abstract, Comments and Keywords (and several other
such generic fields that are hidden in the above example), there are only four important fields
here: Authors, Year, Title, and Rest of reference. As a result, Papyrus can do very little to make
an Other fit the requirements of any particular format. Whatever punctuation or underlining
you use when you enter an Other will appear unchanged when the reference is subsequently
printed, regardless of the demands of any Bibliography Editors. Also, you many need to repeat
the year within the Rest of reference field to get it to show up in the right spot—in such cases
you will then want to have your output format suppress the usual Year from appearing in the
bibliography. Keeping all this straight can occasionally get a little complicated.

In other words, while each of Papyrus’s other reference types provide explicitly-labeled fields
that Papyrus can rearrange as needed when you output a bibliography, for references of type
Other what you enter for Rest of reference is exactly what you will see in all output listings.
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Introduction

Certain questions about data entry arise so frequently that I thought it best to answer them
here. This information is also presented elsewhere, especially in the Reference Entry Window
chapter of the REFERENCE section, and the corresponding chapter of the SHORTCUTS section.

See also:

WORKBOOK

Modifying References

REFERENCE

Reference Entry Window

SHORTCUTS

Reference Entry Window
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Overriding Papyrus assumptions

Many field types expect certain sorts of information. For example, a Number field expects a
number, while a Name field expects a person’s name.

If you try to enter an unexpected kind of information into a field:

then Papyrus will either ask you to confirm its unusualness, or else reject it altogether:

Once in a while you do need to enter information that doesn’t fit the rules. In such cases, you
should type a backslash (“\“) at the end of the field:

The backslash tells Papyrus that you know what you’re doing, and so it should just accept what
you’ve typed without raising any concerns.

Of course, the backslash will never appear when the reference is subsequently dis-
played or printed.
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Inserting a Symbol

To enter a Greek letter or other character from the Symbol font, you can of course simply choose
this font from the Font menu and then type the appropriate character.

Somewhat easier, though, is to choose Paste Symbol from the Edit menu. This dialog will then
appear:

You can pick a character using either your arrow keys or your mouse. When you click OK the
character will be pasted at the current insertion point in whatever text you are entering.
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Inserting a line-break

When you enter a long Comment or Abstract you might wish to insert a line-break or two to
break the text into paragraphs:

To type a line-break, press Option-Return.
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Specifying a keyword or journal

Keywords

You can enter just the first few letters of a keyword, with no concern for capitalization. If there
is only a single matching keyword, then Papyrus will automatically complete your entry. If
there is more than one match, then Papyrus will take you to the Keywords window to pick the
one you desire.

You can also use an asterisk as a wildcard. For example, typing neuro*gy  might result
in a window containing the choices Neurology , Neuropathology , and Neurophysiol-
ogy .

If you enter a keyword that Papyrus does not recognize, it will bring up a dialog window to
confirm the new keyword.

Papyrus tries very hard to be helpful, but there is a situation in which this obsequious-
ness can become annoying. Suppose that your database contains the keyword
Presidential campaigns . Now you would like to enter a new keyword, President . In its
eagerness to please, Papyrus will automatically “complete” this keyword, turning it into
Presidential campaigns .

When this happens, change the entry back to your intended President , but then add a
backslash  at the end: President\ —the backslash tells Papyrus to back off and simply
accept what you’ve typed as a new keyword.

If you modify a keyword that has already been entered, the following dialog will appear:

If you simply intended to replace the previous keyword with a different one, then choose Switch
to different keyword. On the other hand, choose Modify keyword spelling if you are correcting a
spelling error, or if you have decided on a better name for the keyword.

You can change choices in this dialog from your keyboard: use your ↑ or ↓ keys, or type
the first letter of the radio button you desire.

To indicate that a keyword is to be considered a major keyword for this reference, type a “#“
before its name, as in #Marsupials.
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You may also add keywords to a reference by selecting them in the Keywords window and then
clicking that window’s Select button. Or you can drag them from the Keywords window to the
Reference Entry window.

Journals

As with keywords, you can identify a journal by typing just a few letters of its name. You can
also enter any halfway-reasonable abbreviation: Papyrus is smart enough to realize that your
nej probably refers to New England Journal of Medicine.

As with keywords, if Papyrus does not recognize your entry, a dialog window will appear
where you can provide the name, abbreviation and other information about your new journal.
And, as with keywords, you will sometimes need to add a backslash to the end of a new journal
name to prevent Papyrus from “helping” you by replacing it with an existing “match.”

You can choose a journal for a reference by selecting it in the Journals window and then either
clicking that window’s Select button or else dragging the journal to the Reference Entry window.

Editing, etc.  items in place

Some items—Names, Journals, Keywords, Quoting References—have their own windows for
being edited. When one of these appears in a Reference Entry window, you can use some mouse
shortcuts to bring up this editing window, or to accomplish some other tasks:

Option-double-click For a Name, Journal or Keyword field, open
an editing window for that item.

For a Quoting Reference field, open a
Reference Entry window for that reference.

Shift-Option-double-click For a Keyword or Quoting Reference field,
open a Links window for that item.

�  -double-click Equivalent to choosing Launch URL from the
Edit menu.
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CHAPTER 8

Look Up
The “Look up” command in the Edit menu changes according to the type of field you are
currently entering or editing. For example, if you are working on an Author field, the menu
command will read “Look up Author”. This applies for Authors, Editors, Journals, Keywords,
and for any other field that is whole-indexed. For the remaining fields (such as Title), the com-
mand will read “Look up in Glossary”.

If you choose “Look up” for an empty field, the appropriate window will open from which you
can select your intended author, keyword, etc.

If you first type a few letters and then choose “Look up”, one of two things will happen. If
Papyrus knows of only one item that begins with those letters, it will insert that item immedi-
ately. If Papyrus knows of no such items, or it knows of two or more matching items, it will take
you to the appropriate window.

You can also use an asterisk as a wildcard. For example, typing neuro*gy and then choosing
“Look up” might open a window containing the choices Neurology, Neuropathology, and Neuro-
physiology.

See also:

WORKBOOK

Inputting References, Part 2

REFERENCE

Glossary Window

SHORTCUTS

Reference Entry Window
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CHAPTER 9

Picking From a List
There are many places in Papyrus where you will want to pick an item from a long list of
choices. For example, the Keywords window:

Of course, you can simply use your mouse or your ↑ and ↓ keys to select an item. But especially
in the case of a very long list, you can quickly jump to the correct item by typing.

For example, suppose you wish to choose the keyword Politics from the above list. Typing the
letter p will have this effect:
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Papyrus has selected the first item in the list that begins with the letter p.

Now type the letter o, and Papyrus will select the first item beginning with po:

If you were to change your mind, deciding that Psychic surgery is really the keyword you
want, then you would now press your Delete key (to “backspace” the o) and then type s.

You may have noticed a similar type select feature in other Macintosh applications, including
the Finder. But usually these require you to type rather fast if you wish to enter more than a
single letter. Papyrus lets you take your time to deliberate upon your selection. Which comes in
handy when you wish to, say, bypass Neuropharmacology in favor of Neurosurgery.
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CHAPTER 10

The Target Window
When a “dictionary” window, such as Keywords or Journals, is active, it usually shows a Select
button:

Clicking this button will add the currently-selected keyword to another window—generally a
Reference Entry window or a Group window. But if you have more than one Reference Entry or
Group window open, how do you know which one will receive the selected keyword?

As you have probably already deduced, the target window is simply the frontmost Reference
Entry or Group window. Or, more generally, the target window is the frontmost window to
which the active window’s selection might apply.

For example, suppose that you have opened your All References window, and then a Reference
Entry window for one of your references, and then the Journals window, and finally the Key-
words window:
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The active window is the Keywords window. The target window is Reference #9.

If you have any question as to which window is the target window, there are two ways you can
check. First, take a look at the Windows menu:

The bullet (•) indicates the target window.

Or you can simply click and hold the Select button. While you hold down the mouse button,
Papyrus will highlight the title bar of the target window:
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If this isn’t the window you had in mind, move your mouse away from the Select button before
releasing the mouse button.
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CHAPTER 11

The Hollow Cursor
When you start a search, or an import, or any other time-consuming activity in Papyrus, the
usual arrow cursor becomes hollow: 

When the operation is complete the cursor returns to its normal filled-in form: 

Papyrus allows you to do more than one thing at a time, and the hollow cursor behaves identi-
cally to the filled cursor in all respects. The hollowness is simply a reminder to you that Papyrus
is still working on some task, perhaps in a window that is currently hidden behind other win-
dows.
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CHAPTER 12

Status Window
The Status window gives you a summary of the currently-open Papyrus database. It displays
the name of the database (including an indication of the folder in which your database resides),
the database description, and counts of the various kinds of database records.

Clicking the  button, or choosing Get Info from the File menu, will bring up the Database
Info dialog.

If the database file is locked, then the Status window will indicate that the database is read-
only:

A read-only database can be searched, printed, etc., but you will be unable to make any changes
or additions.

See also:

REFERENCE

Database ID Dialog
All References Window
Keywords Window
Journals Window
Formats Window

SHORTCUTS

Status Window
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CHAPTER 13

Reference Entry Window

Introduction ..........................................................R86
Elements of the Reference Entry window .........R88
Reference type ....................................................R89
Fields ......................................................................R90
Field types .............................................................R93
Moving from field to field ....................................R99
Saving the reference .........................................R100
Incomplete references......................................R101
Show hidden fields checkbox ..........................R102
Collapse fields checkbox..................................R102
Links window button ..........................................R104
Preferences button ............................................R105
Drag and Drop ...................................................R106
File menu.............................................................R107
Edit menu ............................................................R108
Reference menu ................................................R110
Group menu .......................................................R110
Font menu...........................................................R111
Style menu ..........................................................R111
Windows menu...................................................R111
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Introduction

You use this window to enter or edit individual references and notecards.

Each reference is assigned a reference type, such as Article in journal, Book/Monograph, Presen-
tation at meeting, Internet source, etc. Besides the several reference types already defined in the
program, Papyrus will let you create your own additional reference types. But most people
should be well served by the predefined types.

A notecard  is simply a special kind of reference—one whose reference type is set to
Notecard. Papyrus treats notecards just like any other references.

A reference’s information is split into fields. For example, each reference has a Reference #
field that contains that reference’s unique identifying number. Most types of reference include
a field for Authors, a Year field, and fields for Abstract, Comments and Keywords. Other fields,
such as Volume, Editors or Publisher, are available only for certain reference types.

Each field has its own field type. For example, Authors and Editors are both Name fields. Some
other field types are Year, Page numbers, Day & Month and Free text.
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See also:

WORKBOOK

Inputting References, Part 1
Inputting References, Part 2
Modifying References

CONCEPTS

Reference Types and Fields
Journals
Keywords
Names
Incomplete References
Notecards and Linked References

REFERENCE

Data Entry—Special Cases
Look Up
Group Window
All References Window

SHORTCUTS

Reference Entry Window



R88 Windows

Elements of the Reference Entry window

Field 
values

Click this button for 
information about the 
reference

Reference preview

Click this button 
for help; 
option-click  for 
shortcuts

Click this button to turn 
balloon help on or off; 
double-click  for a “tour” 
of the window

Click this button to view 
the previous reference in 
the database or Group

Click this button to view 
the next reference in the 
database or Group

Field names
(italic  names are 
optional fields;
the others are 
required fields)

Reference type 
menu

When you open a Reference Entry window for a new reference, its title bar simply shows its
Reference Number:

But when you edit a reference by choosing it from a Group, the Reference Entry window’s title
bar will also indicate this Group:

When you click the window’s  or  button, Papyrus will show you the previous or next
reference. If the title bar indicates a Group, then this will be the previous or next reference in the
Group. Otherwise it will be the previous or next reference in your overall database.
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Reference Type

Use this pop-up menu to select the reference type you desire.

Papyrus comes with many predefined reference types. Most
Papyrus users will find these sufficient to their needs.

You can change a reference’s type at any time. Any information contained in a field that is
absent in the new reference type will be transferred to the Also Print field.

To specify the default reference type for new Reference Entry windows, click the Preferences
button.
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Fields

The fields of a given reference type fall into one of three categories:

Required
Papyrus expects you to enter something for every required field. If you leave a
required field empty, then when you try to save the reference Papyrus will
notify you that it is incomplete and ask how you wish to proceed.

Optional
Optional fields are always shown in the Reference Entry window, but Papyrus
does not care whether you fill these in or leave them blank.

Hidden
Many of the fields that Papyrus provides are used only in occasional unusual
references. These fields do not appear in the Reference Entry window unless
you click the “Show hidden fields” checkbox. However, once you do enter some
information into a hidden field, that field will continue to appear even if you
uncheck the checkbox.

• • •

Some fields appear multiple times. For example, when you begin to enter a new reference, you
will see a single Author field:

As soon as you enter a name in this field, a second Author field will appear:
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This continues until you leave the final field empty and move on to some other set of fields:

Among the other common fields that act this way are Editor and Keyword.

• • •

Many field types expect certain sorts of information. For example, a Number field expects a
number, while a Name field expects a person’s name.

If you try to enter an unexpected kind of information into a field:

then Papyrus will either ask you to confirm its unusualness, or else reject it altogether:
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Once in a while you do need to enter information that doesn’t fit the rules. In such cases, you
should type a backslash (“\“) at the end of the field:

The backslash tells Papyrus that you know what you’re doing, and so it should just accept what
you’ve typed without raising any concerns.

Of course, the backslash will never appear when the reference is subsequently dis-
played or printed.
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Field types

There are several field types, each of which expects a certain kind of information. Some of these
also include shortcuts for data entry.

Reference #

Every reference and notecard in your database is assigned a unique Reference #. This is a
number between 1 and 8,000,000.

Particular databases can impose a more restricted range of acceptable numbers. This
comes in handy when you and your co-workers are each working on your own data-
bases, but want to ensure that you can share entries without running into numbering
conflicts.

For a new entry, Papyrus automatically suggests the next available reference number. How-
ever, you can enter a different number to override this suggestion; one reason you might do so
would be if you were using the Reference # as a systematic index to your personal filing sys-
tem.

If you enter a number that is already in use, Papyrus will offer to find the next available number
for you.

ID Field

If you wish, you may assign a unique ID Field to each reference and notecard in your database.
Papyrus will allow you to enter any combination of letters, numbers, and these punctuation
characters: ' ~ @ # $ - + _

A common use for this field is to enter the first author’s surname, or an abbreviation thereof,
combined with the reference’s year, as in Smith-95 or SMIT95.

If you enter such a value—say, Smith95—that is already in use by another reference, Papyrus
will offer to find next the available ID for you. To do so, it will automatically append a letter to
the end of the field, as in Smith95a.

Free Text

In a Free Text field, Papyrus allows anything at all. Many fields, including Comments and Ab-
stract, are of this type.

If you wish to insert a line-break inside a Free Text field, press Option-Return.
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Title Text

For fields such as Title or Series title, you can enter any characters you like. There is only one
difference between a Free Text field and a Title Text field: if you end a title with a period, Papyrus
will automatically erase the period. This is to prevent extraneous punctuation should you later
output your references in a format that puts a comma or other punctuation mark after the title
field.

Now and then you will want to override this behavior. For example, a title ending with an
abbreviation: Cows of the U.S.A.  In this situation, you can add a backslash  to the end
of the title to tell Papyrus to ignore its usual rules: Cows of the U.S.A.\

Number

These fields expect an integer value, such as 123.

Ordinal

Ordinals are position numbers, such as 1st, 2nd, or 3rd. A typical Ordinal field is Edition.

If you enter a plain number, such as 2, then Papyrus will automatically add the correct suffix.

Name

Name fields are used for authors, editors, compilers, translators, etc. The standard way to enter
a name into Papyrus is Surname,Firstname—always type the surname first, then a comma,
then the first name(s). For multigenerational names, enter another comma and then the suffix:
Smith,Joesph Q,III.

You may provide either the full first name or just the person’s initials. When entering initials
there is no need to include spaces or periods between them—in fact, Papyrus will automatically
remove any such punctuation when you move on to the next field. At the time of later output,
Papyrus will provide whatever punctuation is called for by the output format you are then
using.

You can enter a name all in lowercase, such as smith,roger p. If there are no uppercase letters in
your entry, then Papyrus will automatically convert the entry—in this case to Smith,Roger P.

Papyrus recognizes some special cases. If you know the first few authors of a reference but not
the rest, enter those you know and then type et al. for the final author.

If a reference is anonymous, you can enter either Anonymous or Anon. If you enter the former,
then when you later output the reference it will display Anonymous as its author. But if you
enter Anon., then the output format controls whether Anon. will be displayed, or whether the
author field will be suppressed entirely.
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For a “corporate” author, such as Committee to Study Important Issues, Papyrus will ask you to
confirm the absence of a comma. But if the corporate author does include a comma, such as
Department of State Funding Procrastination, Queensland, then you should add a backslash to
the end of the field so that Papyrus does not try to interpret this as a person’s name.

Editor Role

Papyrus does not provide separate fields for editors, compilers, translators and commentators.
Instead, it provides a series of Editor fields, followed by a corresponding series of Editor Role
fields:

You should choose as many of these as apply. Papyrus will automatically display the appropri-
ate label, such as Compiler & Translator, when the reference is later output.

If you’d rather not reach for your mouse, you can turn these checkboxes on or off by
typing, respectively, e, c, t, or m.

Year

Usually you will simply enter a four-digit year into one of these fields, as in 1995. As a shortcut,
you can type just the final two digits, such as 95; Papyrus will intelligently guess the century
you intend.

Do not enter a letter after the year, even if you have two references by the same author
from the same year. Papyrus will automatically add such letters when needed at the
time you output a list of references.

Papyrus understands these special entries for a Year field: In press, In preparation, Submitted.
For other entries Papyrus will ask you to confirm that you really intend what you have typed.

Day & Month

A typical use of this type of field is for journal articles, in which Day & Month is an optional
field.

You may type either a month and day of the month—as in 12 September or aug 4 or 5/29—or
else just a month or season—as in March or Summer.

Papyrus uses date-recognition software built into your Macintosh, so you can use most
any reasonable format when typing this information. This also means that you need not
worry about capitalizing month or season names.
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Day, Month & Year

For fields of this type, Papyrus expects a day, month and year, such as 8 November 1998. You
may type this information using any reasonable format.

Papyrus also recognizes the ISO standard format for dates, often encountered with
Patents. For example, for 12 September 1996 you could type either 960912 or 19960912.

Keyword

You can enter just the first few letters of a keyword, with no concern for capitalization. If there
is only a single matching keyword, then Papyrus will automatically complete your entry. If
there is more than one match, then Papyrus will take you to the Keywords window to pick the
one you desire.

You can also use an asterisk as a wildcard. For example, typing neuro*gy  might result
in a window containing the choices Neurology , Neuropathology , and Neurophysi-
ology .

If you enter a keyword that Papyrus does not recognize, it will bring up a dialog window to
confirm the new keyword.

Papyrus tries very hard to be helpful, but there is a situation in which this obsequious-
ness can become annoying. Suppose that your database contains the keyword
Presidential campaigns . Now you would like to enter a new keyword, President . In its
eagerness to please, Papyrus will automatically “complete” this keyword, turning it into
Presidential campaigns .

When this happens, change the entry back to your intended President , but then add a
backslash  at the end: President\ —the backslash tells Papyrus to back off and simply
accept what you’ve typed as a new keyword.

If you modify a keyword that has already been entered, the following dialog will appear:

If you simply intended to replace the previous keyword with a different one, then choose Switch
to different keyword. On the other hand, choose Modify keyword spelling if you are correcting a
spelling error, or if you have decided on a better name for the keyword.

You can change choices in this dialog from your keyboard: use your ↑ or ↓ keys, or type
the first letter of the radio button you desire.
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To indicate that a keyword is to be considered a major keyword for this reference, type a “#”
before its name, as in #Marsupials.

You may also add keywords to a reference by selecting them in the Keywords window and then
clicking that window’s Select button. Or you can drag them from the Keywords window to the
Reference Entry window.

Journal

As with keywords, you can identify a journal by typing just a few letters of its name. You can
also enter any halfway-reasonable abbreviation: Papyrus is smart enough to realize that your
nej probably refers to New England Journal of Medicine.

As with keywords, if Papyrus does not recognize your entry, a dialog window will appear
where you can provide the name, abbreviation and other information about your new journal.
And, as with keywords, you will sometimes need to add a backslash to the end of a new journal
name to prevent Papyrus from “helping” you by replacing it with an existing “match.”

You can choose a journal for a reference by selecting it in the Journals window and then either
clicking that window’s Select button or else dragging the journal to the Reference Entry window.

Pages

When entering a range of page numbers, such as 235-239, you may abbreviate: 235-9. Papyrus
is fairly intelligent about understanding what you intended, and will automatically expand
your entry when you proceed to the next field.

When necessary, you may enter discontinuous page numbers such as 17,45. This tends to occur
mostly with non-professional magazines or newspapers.

Yes or No

Simply answer Y or N for such fields.

Degree

Degree fields arise in Dissertations and Theses. Papyrus recognizes Ph.D. and Masters, and
will automatically handle their capitalization and punctuation for you. For other sorts of de-
grees you are on your own.

If you enter Ph.D. into the Degree field, then Papyrus will automatically insert Dissertation into
the Document Type field. Otherwise it will suggest Thesis.
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Document Type

For a Thesis or Dissertation, you will usually enter Dissertation or Thesis here. Papyrus will
suggest a default answer based on your previous entry for the Degree.

For a Patent, you will enter into this field something like Patent or Demande or Kokai. Papyrus
will provide a default answer based on your previous entry for the corresponding Patent Coun-
try.

Associated Reference

This field is present for references that quote another reference. You identify the relevant refer-
ence by entering its Reference #.

You can also drag a reference to this field from another window.

Picture

You may paste or drag any sort of graphic into this type of field.

Papyrus will display the graphic’s PICT represtation. However, it will store all  available
representations. So if you later copy or drag the graphic to another application, it will be
as if you had copied it from the original application.
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Moving from field to field

After you have typed in the value for a field, the simplest way to move to the next field is to
press either Return or Tab.

Or you can press ↓ to proceed downo the next field.

To move up to the preceding fi press ↑ or Shift-Tab or Shift-Return.

You can jump to a particular field with your mouse, by clicking its field name or field value.
Clicking the field name will simultaneously select the entire value.

Another way to jump to a particular field is to click its value in the reference preview:
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Saving the reference

When you are ready to have Papyrus save your reference, you he some choices.

To save the reference but keep it open in the Reference Entry window for further changes,
choose Save from the File menu.

To save the reference and dismiss it, you have a few choices:

Press the Enter  key
or
press the Return  key from the final field in the window

If this reference was opened from within a Group (as indicated by a Group
name showing in the rence Entry window’s title bar), Papyrus will save your
changes and then close the Reference Entry window.

Otherwise Papyrus will save the reference and then ready the Reference Entry
window for you to enter a new referce.

Click the window’s  button

If this reference was opened from within a Group, Papyrus will save your
changed reference and then fill in the Reference Entry window with the next
reference from that Group.

Otherwise Papyrus will save the reference and then proceed to the next refer-
ence in your database. If thisas already the highest-numbered reference, then
Papyrus will ready the Reference Entry window for you to enter a new refer-
ence.

Click the window’s  button

If this reference was opened from within a Group, Papyrus will save your
changed reference and then fill in the Reference Entry window with the previ-
ous reference from that Group.

Otherwise Papyrus will save the reference and then proceed to the previous
reference in your database.
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Incomplete references

Papyrus considers a reference to be incomplete if certain information is missing. This might
occur because a reference has not yet been published—as in an article “In Press” or “Submit-
ted”—or because you simply do not have all of the information at hand when you enter the
reference into Papyrus.

As I’ve indicated elsewhere, some of the fields in the Reference Entry window are considered
required, while others are optional. If you leave empty any required field, Papyrus will con-
sider the reference incomplete.

For each reference type, you can adjust which fields are required and which optional
through the “Database Settings...” function from the File menu.

There are also a few other situations in which Papyrus considers a reference to be incomplete.
These include a non-numeric Year, such as “In Press”, or an Author or Editor of “et al.”

When you attempt to save an incomplete reference, Papyrus will bring this fact to your atten-
tion:

If you choose Cancel you will find that Papyrus has highlighted the offending field for you. In
many cases you will realize that you’ve accidentally left out some information, so now you can
repair this omission and save the reference correctly.

If you choose OK then Papyrus will add INCOMPLETE to the reference’s list of keywords, and
save the reference. This will come in handy later, as you can use this keyword to quickly search
your database for incomplete references and fill in their missing pieces before including them
in the bibliography for your next grant application.

Select No, but save anyway when you are aware of the reference’s deficiencies but not con-
cerned about them.
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Show hidden fields checkbox

As I’ve indicated elsewhere, some of the fields in the Reference
Entry window are hidden. These are fields that occasionally
prove helpful for a particular reference type, but that in most
cases are left empty.

To avoid cluttering up the Reference Entry window, these hid-
den fields are normally not shown. When you need to access them, however, you need only
click the Show hidden fields checkbox, and all fields available for the current reference type will
appear.

After you have entered your information into one or more of the normally-hidden fields, you
can uncheck Show hidden fields. The fields that now contain information will remain visible; all
the still-unused hidden fields will disappear.

For each reference type, you can adjust which fields will be hidden through the Database Set-
tings... function from the File menu.

Collapse fields checkbox

Some fields, such as Abstract and Comments, can extend for
many lines. If your window is fairly small, or an Abstract or
other field quite large, then this field may end up filling most of
the window, requiring you to constantly scroll the window to
see other fields.

Checking Collapse fields causes every field in the Reference
Entry window to shrink itself to a single line:
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When you move into a collapsed field, it automatically expands itself to its full height:

When you move to another field, the previous field will automatically shrink back to a single
line.
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Links window button

Clicking this button will open a new window for this refer-
ence. This Links window allows you to view or modify
connections between the chosen reference and other references
or notecards in your database.

You cannot open a Links window until the current reference
has been saved to your database.

This is how the button appears if this reference currently has no links.

This is how the button appears if this reference already has links.



Chapter 13: Reference Entry Window R105

C
O

N
C

E
P

T
S

R
E

F
E

R
E

N
C

E

Preferences button

Clicking this button brings up the following dialog box:

Use this menu to set the starting reference 
type for a new Reference Entry window

Click this button to change 
the format used for the 
reference preview

Use these menus to set the 
font and size used for the 
reference preview

The starting settings of these 
two checkboxes for a new 
Reference Entry window

You might choose Right 
if you are working in a 
right-to-left language, 
such as Hebrew or Arabic

Click these buttons to set 
the text style, including 
font and size, for field 
names and values

If Use as default settings for new Reference windows is checked, then these settings will apply
to all future Reference Entry windows as well as the present window. If it is not checked, then
these changes will only apply to the current window.
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Drag and Drop

Text and pictures

You may drag selected text from one field to another, or to and from other windows.

You may drag graphics to and from a Picture field.

To a Group window

Dragging the reference preview to a Group window adds this reference to the Group.

From a Reference Entry or Group window

Dragging a reference to a Reference Entry window sets any empty fields in the target window
to the values present in the dragged reference.

For example, you might drag an existing Book or Chapter reference onto a new Chapter refer-
ence in another Reference Entry window to fill in the Editors, Book Title, Publisher, etc.

From the Keywords window

Dragging one or more keywords to a Reference Entry window will add those keywords to the
reference.

From the Journals window

Dragging a journal to a Reference Entry window will add that journal to the reference (assum-
ing that the current reference type includes a Journal field).

From the Formats window

Dragging a format to a Reference Entry window makes that the format for the reference pre-
view.
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File menu

The items in the File menu that pertain to the Reference Entry
window are:

Close
Closes the window.

Hold down the Option key to close the window without sav-
ing any changes

  Save
Saves the current reference.

  Revert
Restores the current reference to how it appeared in your
database prior to the changes you have so far made in the Reference Entry
window.

  Get Info
Displays the origin of the current reference—e.g., whether it was typed in or
imported—plus the date and time of both its original entry and its latest modi-
fication.

The same information will appear if you click the  in the lower left corner of
the Reference Entry window.

Page Setup...
Brings up the standard Macintosh dialog about paper size, orientation, etc.

Print/Export...
Use this item either to print this reference, or else to export it to your word
processor. The resulting Print/Export dialog contains many options that you
can adjust.
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Edit menu

The items in the Edit menu that pertain to the Reference Entry
window are:

Cut
Copies the currently-selected text or picture to the clipboard,
and removes it from the reference.

Copy
Copies the currently-selected text or picture to the clipboard.

Paste
Pastes text or graphics from the clipboard to the current field.
(Graphics can be pasted only to a Picture field.)

Select All
Selects all the text of the current field.

Look up...
The Look up command changes according to the type of field you are cur-
rently entering or editing. For example, if you are working on an Author field,
the menu command will read Look up Author. This applies to Authors, Edi-
tors, Journals, Keywords, and any other field that is whole-indexed. For the
remaining fields (such as Title), the command will read Look up in Glossary.

If you choose Look up for an empty field, the appropriate window will open
from which you can select your intended author, keyword, etc.

If you first type a few letters and then choose “Look up”, one of two things
will happen. If Papyrus knows of only a single item that begins with those
letters, it will insert that item immediately. If Papyrus knows of no such items,
or it knows of two or more matching items, it will take you to the appropriate
window.

You can also use an asterisk as a wildcard. For example, typing neuro*gy and
then choosing “Look up” might open a window containing the choices Neurol-
ogy, Neuropathology, and Neurophysiology.

Duplicate This Field...
Duplicate Remaining Fields...

If a second Reference Entry window is open, then you can use these commands
to copy information from that window to the present one.

Duplicate This Field will only be available if the present field is still empty.
Choosing it will fill in the present field with the value used in the other window.



Chapter 13: Reference Entry Window R109

C
O

N
C

E
P

T
S

R
E

F
E

R
E

N
C

E

Duplicate Remaining Fields will fill in all empty fields in the present window,
using the corresponding fields from the other window.

The references in the two windows may be of different reference types. For
example, if the present reference is a Chapter and the other a Book, then Papyrus
understands that the Book’s “authors” correspond to the Chapter’s “editors”.

Paste Symbol
Use this command to quickly insert a character from the Symbol font.

Check Text Spelling
Checks the spelling of the currently-selected text. If no text is selected, then
checks the spelling of the current field.

Papyrus performs spellchecking in conjunction with a third-party spelling
checker, such as Spellswell Plus.

Launch URL
If the currently-selected text includes an Internet URL, then Launch URL will
instruct your Web browser to go to the indicated address. Papyrus handles this
via the Internet Config extension.
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Reference menu

The items in the Reference menu that pertain to the Reference Entry
window are:

New
Opens a fresh Reference Entry window for you to enter a new refer-
ence.

Delete
Permanently deletes the current reference from your database.

Add Notecards
Opens a new Reference Entry window where you can enter one or more new
notecards. These notecards will be linked to the current reference.

Cite...
Places the current reference into the clipboard, so that you can paste it into
another application, such as a word processor. The Cite dialog lets you decide
whether the reference will be pasted as a formatted citation or as a placeholder
for a subsequent Process Manuscript operation.

Group menu

None of the items in the Group menu pertain to the Reference Entry
window.
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Font menu

Use this menu to set the font of text you enter.

Almost all of the time you will stick to the first item in the menu,
BASE FONT. You can choose which screen font will be used to dis-
play this base font in the Reference Entry window, via the Preferences
button.

When you later print or export your references, you will be able to set the font to be used for all
“base font” text.

In rare cases you will need to specify a particular font as you type. For example, you might need
to quote some Japanese or Hebrew or Greek text.

When you pick a font other than BASE FONT, that text will always be displayed in that specific
font, even if you later export the reference to your word processor.

Style menu

Use this menu to set the style of text you enter.

You cannot adjust the size of text here, because that will be set later when you
print or export your references.

Windows menu

Use this menu to open one of Papyrus’s special windows (Keywords, Jour-
nals, Glossary, etc.), or to switch to a different Reference Entry or Group
window.
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Introduction

This window displays all the references and notecards in your Papyrus database.

You can switch the window’s arrangement between alphabetic order by Authors and numeric
order by Reference Number. The former might be convenient if you are looking for a paper
whose first author you know, while the latter can come in handy if you want to review your
most-recently entered batch of references.

In many respects, the All References window behaves just like a Group window. But since a
Group contains only a subset of your full database, and can be sorted in any arbitrary order,
there are some significant differences between the two types of window.

See also:

WORKBOOK

Modifying References

REFERENCE

Group Window

SHORTCUTS

All References Window
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Elements of the All References window

You can switch the All References window back and forth between two views:

• Table view shows all of the references in your database, in an abbreviated
form.

• Individual items view shows you a single reference at a time, in detail.

All References window in Table  view:

You can switch between alphabetic 
and numeric views of your database

These two references 
are currently selected

Click this button 
for help; 
option-click  for 
shortcuts

Click this button for 
information about 
the database

Click this button to turn 
balloon help on or off; 
double-click  for a “tour” of 
the window
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All References window in Individual items  view:

Click this button to view 
the previous reference in 
the database

Click this button to view 
the next reference in the 
database



Chapter 14: All References Window R117

C
O

N
C

E
P

T
S

R
E

F
E

R
E

N
C

E

Display Formats

You may choose the format that the All References window uses in each of its two views.

In the Table view you will probably prefer to use a tabular format, so that the various fields line
up in neat columns. Papyrus is initially set to use its built-in BRIEF format, which is a one-line
tabular format.

Depending on your needs and desires, you might decide to use a tabular format that includes
two or more lines of information. Or you might choose a non-tabular format. Of course, if you
pick a format that requires more than one line per reference, fewer references will be simulta-
neously visible in the All References window.

In the Individual items view you will probably want to use a format that shows most or all of
the information associated with each reference. Since this would include fields such as Com-
ments and Keywords, the format you pick will probably not be one of the formats you would
use when printing a bibliography for publication.

Papyrus is initially set to use its built-in STANDARD format for the Individual items view.
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There are two ways to change the All References window’s display formats.

Clicking the Preferences button brings up the following dialog box:

Clicking either of the Change format buttons will yield a list of available output formats from
which you can choose. You can also change the number of lines that will be shown for each
reference, in case you are using a format that is not a one-line tabular format.

If Use as default settings for new Group windows is checked, then these settings will apply to all
future Group windows as well as the All References window. If it is not checked, then these
changes will only apply to the All References window.

The other way to change the display formats is to open the Formats window and select the
format you desire. Then you can either press the Formats window’s Select button, or else you
can drag the format onto the All References window. Either way, you will be greeted by the
following dialog box:

Select either choice and click OK.
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Links window button

When one or more references are selected, clicking this button
will open a new window for each of them. This Links window
allows you to view or modify connections between the chosen
reference and other references or notecards in your database.

This is how the button appears if none of the
selected references currently have any links.

This is how the button appears if at least one of the selected references already
has links.

Preferences button

Clicking this button brings up the following dialog box:

Here you can set each of the display formats for the window, by clicking the corresponding
Change format button. Doing so will bring up a list of available output formats from which
you can choose.

You can also pick the base font and font size for each view, as well as the number of lines
reserved for each reference in the Table view.

If Use as default settings for new Group windows is checked, then these settings will apply to all
future Group windows as well as the All References window. If it is not checked, then these
changes will only apply to the All References window.
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Selecting references

In the Table view you can select references using standard
Macintosh techniques:

Click a reference to select it.

�  -click a reference to add it to the selection.

Shift-click a reference to add it, and all intervening references, to the selection.

↑↑↑↑↑ or ↓↓↓↓↓ selects the reference above or below the current selection.

�  -↑↑↑↑↑ or �  -↓↓↓↓↓ selects the first or last reference in the window.

Shift-↑↑↑↑↑ or Shift-↓↓↓↓↓ enlarges the current selection to include the reference above or below.

�  -Shift-↑↑↑↑↑ or �  -Shift-↓↓↓↓↓ enlarges the current selection to include all preceding or all follow-
ing references.

Select All from the Edit menu selects all references in the database.

Selecting by typing

In either the Table view or the Individual items view, you can jump directly to a particular
reference by typing the first few numbers or letters corresponding to the reference.

If the All References window is in alphabetic order, then typing a few letters will take you to
the first reference whose first author’s surname starts with those letters.

If the All References window is in numeric order, then typing a number will take you to the
reference bearing that Reference #.
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Drag and Drop

To a Group window

Dragging references from the All References window to a Group window will add those refer-
ences to the Group.

To a Reference Entry window

Dragging a reference to a Reference Entry window will set the empty fields in the entry window
to the values present in the dragged reference.

From the Keywords window

Dragging one or more keywords to the All References window will add those keywords to the
references of your database. If one or more references are currently selected, Papyrus will ask
you whether you wish to add the keywords to just the selected references or to every reference
in the database.

From the Formats window

You can change either of the window’s display formats by dragging a format onto the All
References window.
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File menu

The items in the File menu that pertain to the All References window
are:

Close
Closes the All References window.

Get Info
Lets you change your database’s description and allowable
range for reference numbers.

The same Database ID dialog will come up if you click the
 in the lower left corner of the All References window.

Page Setup...
Brings up the standard Macintosh dialog about paper size, orientation, etc.

Print/Export...
Use this item either to print some or all of your database, or else to export some
or all of the database to your word processor. The resulting Print/Export dia-
log contains many options that you can adjust.

List with Index...
Use this item to print or export some or all of your database, followed by an
index to the printed/exported entries by the field of your choice. For example,
you might print a list of references, followed by a keyword index or an author
index. The Indexed List dialog contains several options that you can adjust.

Papyrus-Papyrus transfer...
Use this item to export some or all of your database to a file that can then be
imported into a different Papyrus database. The Papyrus-Papyrus Transfer
dialog allows you to work with either Version 7 or Version 8 of Papyrus.



Chapter 14: All References Window R123

C
O

N
C

E
P

T
S

R
E

F
E

R
E

N
C

E

Edit menu

The items in the Edit menu that pertain to the All References window
are:

Copy
Copies the currently-selected references to the clipboard.

Select All
Selects all the references in the database.

Find & Replace Text...
Lets you search a specified field for some text, and replace
that text with different text. You can search all references in
the database, or only the currently-selected references. The
Find & Replace Text dialog offers you several options that
you can adjust.

Change Field...
Lets you replace or add text to a specified field, or move or copy the contents of
one field to another. You can do this for all references in the database, or for
only the currently-selected references. The Change Field dialog offers you sev-
eral options that you can adjust.

Check Reference Spelling...
Checks the spelling of either the currently-selected references, or else all the
references in the database. Papyrus performs spellchecking in conjunction with
a third-party spelling checker, such as Spellswell Plus.

Launch URL
If the currently-selected reference includes an Internet URL, then Launch URL
will instruct your Web browser to go to the indicated address. Papyrus handles
this via the Internet Config extension.
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Reference menu

The items in the Reference menu that pertain to the All References window
are:

Edit
Opens a Reference Entry window for each of the currently-selected
reference.

Delete
Permanently deletes the currently-selected reference from your database.

Merge
Combines the currently-selected references into a single reference. You will use
this when you discover duplicate entries corresponding to the same publica-
tion. When some fields differ between the entries, such as keywords or
comments, Papyrus will ask you whether you wish to keep one version or the
other, or combine the two.

Add Notecards
Opens a new Reference Entry window where you can enter one or more new
notecards. These notecards will be linked to each of the currently-selected ref-
erences.

Cite...
Places the currently-selected reference into the clipboard, so that you can paste
them into another application, such as a word processor. The Cite dialog lets
you decide whether the references will be pasted as formatted citations or as
placeholders for a subsequent Process Manuscript operation.

Group menu

None of the items in the Group menu pertain to the All References
window.
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Font menu

Choosing a font from the Font menu will make that the default font
for the All References window. You can set different fonts for the Table
view and the Individual items view.

These changes will only affect the All References window. To change your default fonts for
future Group windows, use the Preferences button.

Style menu

Choosing a font size from the Style menu will make that the default font size
for the All References window. You can set different sizes for the Table view
and the Individual items view.

These changes will only affect the All References window. To change your
default font size for future Group windows, use the Preferences button.

Windows menu

Use this menu to open one of Papyrus’s special windows (Keywords, Jour-
nals, Glossary, etc.), or to switch to a Group or Reference Entry window.
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Introduction

Groups are central to the use of Papyrus. When you ask Papyrus to perform a search, the
results form a new Group. When you assemble a collection of your references to publish a
bibliography, you do so by making a Group that contains just those references. When you have
Papyrus process a manuscript to automatically generate the in-text citations and the final bib-
liography, the relevant references will be placed into a Group.

The references in a Group can be sorted however you wish. For example, a very common ar-
rangement is alphabetically by authors, then chronologically by year, and then alphabetically
by title. Or you might choose a strictly chronological sort, by year only. Or you could sort the
Group by journal and volume, so that you can print out the list and efficiently find the articles
at your library.

In some cases you will need to sort the references of the Group in an arbitrary order. For example,
many journals demand that the bibliography be arranged in citation order.

The sorting method used for a Group is related to a Papyrus format. For example, if you tell
Papyrus that this Group is going to be used to print a bibliography using, say, Vancouver for-
mat—a common biomedical journal style—then that implies that the Group will be sorted in
citation order. A different format might imply author-year-title order. In the latter case, the
format would also contain rules for using et al., which in turn will affect the sorting of the
references.

Although the format chosen for the Group thus implies a default method of sorting, you can
override that default and tell Papyrus to sort the Group in any way you desire.

Note that the format designated for printing and sorting is independent of the formats used to
display the references in the Group window.
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See also:

WORKBOOK

Groups
Finding References
Preparing a Manuscript and its Bibliography Together
Specific Pages
Citing references together

CONCEPTS

Output Formats
Groups

REFERENCE

All references Window
Sort
Refine Search
Process Manuscript

SHORTCUTS

Group Window
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Elements of the Group window

You can switch a Group window back and forth between two views:

• Table view shows all of the references contained in the Group, in an abbrevi-
ated form.

• Individual items view shows you a single reference at a time, in detail.

Group window in Table  view:

This item refers to 
specific pages of 
its reference

The Group’s description
The format used for 
sorting and printing 
this Group

These two references are 
currently selected

Click this button 
for help; 
option-click  for 
shortcuts

Click this button for 
information about 
the Group

Click this button to turn 
balloon help on or off; 
double-click  for a “tour” 
of the window

These three 
items will be 
cited together as 
a single entry in 
the bibliography

This reference is 
incomplete
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Group window in Individual items  view:

Click this button to view 
the previous reference in 
the Group

Click this button to view the 
next reference in the Group
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Group Description

The description provides a reminder of what this particular
collection of references represents.

When you create a new Group, Papyrus provides a somewhat
generic description:

You can type a useful description here

To change the description to something a bit more helpful, choose Edit
Description from the Group menu.

Or you can simply click or double-click anywhere in the description itself
to start editing.
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Sorting/Printing format

As we discussed in the Introduction to the Group window, a
Papyrus format controls the sorting and printing of a Group.
When you create a new Group, its format is initially set to STAN-
DARD. There are three ways you can change this.

From the Group menu, pick Set Format... This will bring up a
list of available output formats from which you can choose.

As a shortcut, you can click the format name in the upper-right corner of
the Group window. This will also bring up the list of available formats.

The final way to change the sorting/printing format is to open the For-
mats window and select the format you desire. Then you can either press
the Formats window’s Select button, or else you can drag the format onto
the Group window. Either way, you will be greeted by the following dia-
log box:

Select the third choice and click OK.

After you have changed the Group’s sorting/printing format, using any of the above methods,
Papyrus will then ask you how you wish to sort the Group.
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Sorting

When you change a Group’s sorting/printing format, or when you choose
Sort... from the Group menu, the following dialog comes up:

Fields by which 
you can sort the 
Group

Current 
sorting 
scheme

Script menu
(only present if more than one 
writing system has been 
installed on your computer)

Language 
menu

Current sorting scheme

You can use your mouse, arrow keys, Delete key, etc. to erase or rearrange the fields.

List of available fields for sorting

To copy a field to the current sorting scheme, double-click it. Or you can select a field with your
arrow keys or mouse, and then press Return to copy it to the current sorting scheme.

Shortcut: To jump directly to a particular field, type the first few letters of its name. For example,
to select Year you can simply type y.

Pressing Tab switches you back and forth between the current sorting scheme and the available
fields list.

Default button

Click this button to set the sorting scheme based on the Group’s current sorting/printing for-
mat.
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Citation/Manual order

Click this button if the references are to be sorted according to the order in which they are cited
in a manuscript, or if you will arrange them yourself in some arbitrary order.

Sort automatically:

Click this button to have Papyrus automatically sort the references according to the scheme
shown.

Script menu

This pop-up menu will only appear if your computer includes more than one writing system.
For example, in addition to the default Roman system, your computer might also be aware of
the Japanese or Arabic system.

If this menu appears, you can pick each available writing system in turn. For each one, you can
then use the Language menu to set the corresponding language rules for sorting.

Language menu

The rules for alphabetizing vary from one language to another. If, for example, you are going to
submit a bibliography to an English-language journal, then alphabetization should be accord-
ing to English rules, regardless of the languages used in the authors and titles of the various
references.

Use this pop-up menu to set the language whose rules should govern alphabetization for this
Group.

Sort umlauts as in German (ö=oe, etc.)

The German rule for alphabetizing a letter bearing an umlaut (e.g., “ä”, “ë”, etc.) is to treat it as
if the plain letter were followed by the letter “e”. Click this checkbox if the Group is to follow
this German rule.

You will need to check this box even if you have already specified German in the lan-
guage menu. Apparently Apple overlooked this alphabetizing rule when they created
their German system software.

Years in descending order

Usually you will want to list an author’s work in chronologic order, oldest references first. But
sometimes you would prefer to see the most recent citations first, as in a curriculum vitae. In
such a case, you should check this box.
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Display Formats

You may choose the format that the Group window uses in each of its two views.

In the Table view, you will probably prefer to use a tabular format, so that the various fields line
up in neat columns. Papyrus is initially set to use its built-in BRIEF format, which is a one-line
tabular format.

Depending on your needs and desires, you might decide to use a tabular format that includes
two or more lines of information. Or you might choose a non-tabular format. Of course, if you
pick a format that requires more than one line per reference, fewer references will be simulta-
neously visible in the Group window.

In the Individual items view, you will probably want to use a format that shows most or all of
the information associated with each reference. Since this would include fields such as Com-
ments and Keywords, the format you pick will probably not be one of the formats you would
use when printing a bibliography for publication.

Papyrus is initially set to use its built-in STANDARD format for the Individual items view.
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There are two ways to change the Group window’s display formats.

Clicking the Preferences button brings up the following dialog box:

Clicking either of the Change format buttons will yield a list of available output formats from
which you can choose. You can also change the number of lines that will be shown for each
reference, in case you are using a format that is not a one-line tabular format.

If Use as default settings for new Group windows is checked, then these settings will apply to all
future Group windows as well as the present window. If it is not checked, then these changes
will only apply to the current window.

The other way to change the display formats is to open the Formats window and select the
format you desire. Then you can either press the Formats window’s Select button, or else you
can drag the format to the Group window. Either way, you will be greeted by the following
dialog box:

Select either of the first two choices and click OK.
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Links window button

When one or more of the Group’s references are selected, click-
ing this button will open a new window for each of them. This
Links window allows you to view or modify connections be-
tween the chosen reference and other references or notecards in
your database.

This is how the button appears if none of the selected references currently have
any links.

This is how the button appears if at least one of the selected references already
has links.

Preferences button

Clicking this button brings up the following dialog box:

Here you can set each of the display formats for the Group, by clicking the corresponding
Change format button. Doing so will bring up a list of available output formats from which
you can choose.

You can also pick the base font and font size for each view, as well as the number of lines
reserved for each reference in the Table view.

If Use as default settings for new Group windows is checked, then these settings will apply to all
future Group windows as well as the present window. If it is not checked, then these changes
will only apply to the current window.
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Selecting references

In the Table view you can select references using standard
Macintosh techniques:

Click a reference to select it.

�  -click a reference to add it to the selection.

Shift-click a reference to add it, and all intervening references, to the selection.

↑↑↑↑↑ or ↓↓↓↓↓ selects the reference above or below the current selection.

�  -↑↑↑↑↑ or �  -↓↓↓↓↓ selects the first or last reference in the Group.

Shift-↑↑↑↑↑ or Shift-↓↓↓↓↓ enlarges the current selection to include the reference above or below.

�  -Shift-↑↑↑↑↑ or �  -Shift-↓↓↓↓↓ enlarges the current selection to include all preceding or all follow-
ing references.

Select All from the Edit menu selects all references in the Group.

Selecting by typing

In either the Table view or the Individual items view, you can jump directly to a particular
reference by typing the first few numbers or letters corresponding to the reference.

For example, if your Group is sorted first by Authors, then typing a few letters will take you to
the first reference whose first author’s surname starts with those letters.

Or if your Group is sorted by Reference #, then typing a number will take you to the reference
bearing that number.

This “type-select” feature works according to the first field by which your Group is sorted. If it
is sorted first by Journal, then typing the first few letters of a journal name will take you to the
first article from that journal. If the references are arranged first by Year, then typing 1994 will
take you to the first reference from that year.
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Drag and Drop

Within the Group window

If the Group is sorted in Citation/Manual order, then you can rearrange its references simply
by clicking a reference and dragging it to a different position in the Group window.

To a different Group window

Dragging references from one Group window to another will add those references to the sec-
ond Group.

To a Reference Entry window

Dragging a reference to a Reference Entry window will set the empty fields in the entry window
to the values present in the dragged reference.

From a Reference Entry window

Dragging a reference to a Group window will add that reference to the Group.

From the Keywords window

Dragging one or more keywords to a Group window will add those keywords to the references
of the Group. If one or more references are currently selected, Papyrus will ask you whether
you wish to add the keywords to just the selected references or to every reference in the Group.

From the Formats window

You can change either of the Group’s display formats or its sorting/printing format by drag-
ging a format onto the Group window.
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File menu

The items in the File menu that pertain to Groups are:

Close
Closes the window.

Hold down the Option key to close and discard an untitled
Group.

Save
Saves the current Group.

Get Info
Provides information about the current Group, including the
Group’s name, description, sorting scheme, sorting/print-
ing format, and details regarding the most recent search performed, manuscript
processed, etc.

The same information is available by clicking the  in the lower left corner of
the Group window.

Page Setup...
Brings up the standard Macintosh dialog about paper size, orientation, etc.

Print/Export...
Use this item either to print some or all of the current Group, or else to export
some or all of the current Group to your word processor. The resulting Print/
Export dialog contains many options that you can adjust.

List with Index...
Use this item to print or export some or all of the current Group, followed by
an index to the printed/exported entries by the field of your choice. For example,
you might print a list of references, followed by a keyword index or an author
index. The Indexed List dialog contains several options that you can adjust.

Papyrus-Papyrus transfer...
Use this item to export some or all of the current Group to a file that can then be
imported into a different Papyrus database. The Papyrus-Papyrus Transfer
dialog allows you to work with either Version 7 or Version 8 of Papyrus.
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Edit menu

The items in the Edit menu that pertain to Groups are:

Cut
Copies the currently-selected references from the current
Group to the clipboard, and then removes those references
from the Group.

Copy
Copies the currently-selected references from the current
Group to the clipboard.

Paste
Adds to the Group whatever references are currently in the
clipboard.

Clear
Removes the currently-selected references from the current Group.

Select All
Selects all the references in the current Group.

Find & Replace Text...
Lets you search a specified field for some text, and replace that text with differ-
ent text. You can search all references in the current Group, or only the
currently-selected references. The Find & Replace Text dialog offers you sev-
eral options that you can adjust.

Change Field...
Lets you replace or add text to a specified field, or move or copy the contents of
one field to another. You can do this for all references in the current Group, or
for only the currently-selected references. The Change Field dialog offers you
several options that you can adjust.

Check Reference Spelling...
Checks the spelling of either the currently-selected references, or else all the
references in the current Group. Papyrus performs spellchecking in conjunc-
tion with a third-party spelling checker, such as Spellswell Plus.

Launch URL
If the currently-selected reference includes an Internet URL, then Launch URL
will instruct your Web browser to go to the indicated address. Papyrus handles
this via the Internet Config extension.
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Reference menu

The items in the Reference menu that pertain to Groups are:

Edit
Opens a Reference Entry window for each of the currently-selected
references.

Delete

Permanently deletes the currently-selected references from your database.

Merge

Combines the currently-selected references into a single reference. You will use this
when you discover duplicate entries corresponding to the same publication. When some
fields differ between the entries, such as keywords or comments, Papyrus will ask you
whether you wish to keep one version or the other, or combine the two.

Add Notecards

Opens a new Reference Entry window where you can enter one or more new note-
cards. These notecards will be linked to each of the currently-selected references.

Cite...

Places the currently-selected reference into the clipboard, so that you can paste them
into another application, such as a word processor. The Cite dialog  lets you decide
whether the references will be pasted as formatted citations or as placeholders for a
subsequent Process Manuscript  operation.
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Group menu

The items in the Group menu that pertain to Groups are:

New Group
Creates a new, empty Group window.

Open Group...
Opens an existing Group.

Edit Description
Allows you to edit the current Group’s description line.

Set Format...
Lets you change the format used for sorting and printing the current Group.

Sort...
Lets you change the scheme used for sorting the current Group, via the Sorting
dialog.

Refine Search...
The Refine Search dialog allows you to perform new searches, modify and re-
run old searches, or combine searches for the current Group.

Process Manuscript...
After you have inserted Papyrus reference placeholders throughout your word
processor manuscript, the Process Manuscript function will read through the
manuscript and automatically generate your finished manuscript. The Process
Manuscript dialog provides several options for you to adjust.

Specific Pages...
Occasionally a bibliography will indicate the exact pages cited within a cited
work. “Specific Pages...” allows you to indicate such pages for the currently-
selected reference. (See Specific Pages in the WORKBOOK.)

Cite Together
Tells Papyrus that when it prints or exports this Group as a bibliography, the
selected references are to be combined into a single citation within the bibliog-
raphy. (See Citing references together in the WORKBOOK.)

Cite Separately
Cancels the effect of a previous Cite Together.
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Font menu

Choosing a font from the Font menu will make that the default font
for the current Group’s display. You can set different fonts for the Table
view and the Individual items view.

These changes will only affect the current Group window. To change your default fonts for
future Group windows, use the Preferences button.

Style menu

Choosing a font size from the Style menu will make that the default font size
for the current Group’s display. You can set different sizes for the Table view
and the Individual items view.

These changes will only affect the current Group window. To change your
default font size for future Group windows, use the Preferences button.

Windows menu

Use this menu to open one of Papyrus’s special windows (Keywords, Jour-
nals, Glossary, etc.), or to switch to a different Group or Reference Entry
window.
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Introduction

This window helps you in managing the keywords of your Papyrus database. You can modify,
merge, or delete incorrect or obsolete keywords, as well as create new ones. You can also im-
port a list of keywords.

You can copy or drag keywords from this window to another, to add them to a reference—or to
an entire Group of references.

If you take advantage of Papyrus’s keyword linking abilities, you can have the Keywords
window automatically display these links as you review your collection of keywords.

See also:

WORKBOOK

Modifying References
Keyword Links
Exchanging Data With Another Papyrus Version 8 Database

CONCEPTS

Keywords

REFERENCE

Keyword Links Window

SHORTCUTS

Keywords Window
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Elements of the Keywords window

Create new 
keywords

Click this button 
for help; 
option-click  for 
shortcuts

Click this button to turn 
balloon help on or off; 
double-click  for a “tour” 
of the window

Modify the 
selected keyword
Permanently 
erase the selected 
keywords
Combine the 
selected keywords

Import a list of 
keywords

Find all references 
that cite the selected 
keyword

Show the links panel 
in this window

Open a links window for 
the selected keywords

The numbers indicate how many 
references currently cite each 
keyword

Apply the selected 
keywords to the 
current target window

If you click the Show Links button, a links panel will open:

Note that Show Links now becomes Hide Links.
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As you select a keyword in the main keyword list panel, the links panel will automatically
display the links belonging to that keyword. The links panel is not just a display, though—it
includes nearly all of the functionality present in a Keyword Links window.

Selecting keywords

In either the main keyword panel or the keyword links panel, you can select keywords using
standard Macintosh techniques:

Click a keyword to select it.

�  -click a keyword to add it to the selection.

Shift-click a keyword to add it, and all intervening keywords, to the selection.

↑↑↑↑↑ or ↓↓↓↓↓ selects the keyword above or below the current selection.

�  -↑↑↑↑↑ or �  -↓↓↓↓↓ selects the first or last keyword in the list.

Shift-↑↑↑↑↑ or Shift-↓↓↓↓↓ enlarges the current selection to include the keyword above or below.

Select All from the Edit menu selects all the keywords in the list.

Selecting by typing

In the main keyword panel, you can jump directly to a particular keyword by typing the first
few letters of the keyword.
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Creating new keywords

When you click the Keywords window’s New... button, this dialog appears:

After you type your new keyword, click Done to save it. Or if you wish to enter several new
keywords, click New. This will save your new keyword and then reset the New Keyword dia-
log for your next entry.

Editing keywords

To modify a keyword, select it in either panel of the Keywords window and then click the Edit...
button. This dialog appears:

The existing version of the keyword is shown at the top of the dialog. After you have made your
changes to the keyword, click Change to save the modified keyword.

Any reference that cites this keyword will henceforth display the new version.
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Deleting keywords

To erase a keyword from your database, select it in either panel of the Keywords window and
then click the Delete button. This confirmation dialog appears:

When you click Delete the keyword will be irretrievably removed from your database, and
from any reference that had cited it.

You can also select multiple keywords and delete them all at once:
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Merging keywords

When you have accidentally created two or more versions of a single keyword, select them all
and use the Merge... button to combine them:

Select the version you prefer (via mouse, arrow keys, or by typing the first few letters) and click
Merge. All references that formerly cited the unwanted version(s) of the keyword will hence-
forth cite the remaining version.

Loading keywords

Papyrus can import a list of keywords from any plain text document. This document should
consist simply of a series of keywords, one per line.

You can create this list with a word processor or any other application that can create a text-only
document. You can also have Papyrus export some or all of the keywords from one database to
a text document, ready to be imported into another Papyrus database.

In the Keywords window, click the Load... button. Papyrus will ask you to identify the text
document to be read, and then proceed to load the keywords from that document. If it recog-
nizes an incoming keyword as one already in your database, Papyrus will not duplicate it.
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Exporting keywords

The File menu’s Print/Export... command not only allows you to send your keyword list to
your printer or word processor, but also to a text document suitable for loading into another
Papyrus database.

When you choose Print/Export... this dialog appears:

Click the Layout... button and set Skipped lines between items to 0. Also make sure that Fixed
line length is not checked.

For complete information about the other choices here, see the REFERENCE chapter on the Print/
Export dialog.

Usually when exporting a list of keywords, Papyrus will include the citation counts:

Keywords

Attitudes  1
Dousing  1
ESP  1
Exploitation  1
Fiction  1
Fungi  0

But if you choose Plain text as your destination, as shown above, then Papyrus will suppress
the citation counts, as well as the list’s title:

Attitudes
Dousing
ESP
Exploitation
Fiction
Fungi

The resulting document is ready to be loaded into another Papyrus database.



Chapter 16: Keywords Window R155

C
O

N
C

E
P

T
S

R
E

F
E

R
E

N
C

E

Links window button

When one or more of the window’s keywords are selected, clicking this button will open a new
window for each of them. This Keyword Links window allows you to view or modify connec-
tions between the chosen keyword and other keywords in your database.

This is how the button appears if none of the selected keywords currently have
any links.

This is how the button appears if at least one of the selected keywords already
has links.

Drag and Drop

Within the Keyword window

In the links panel, dragging a keyword onto another keyword, or onto a link type, will create a
new link. (See Creating a Link in the Keyword Links Window chapter.)

To a Keyword Links window

Dragging a keyword to a Keyword Links window will create a new link. (See Creating a Link in
the Keyword Links Window chapter.)

To a Reference Entry window

Dragging one or more keywords to a Reference Entry window will add those keywords to that
reference.

To a Group window

Dragging one or more keywords to a Group window will add those keywords to each of the
references contained in the Group.

From a Keyword Links window

Dragging one or more keywords to the links panel will create new links for those keywords.
(See Creating a Link in the Keyword Links Window chapter.)
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File menu

The items in the File menu that pertain to the Keywords window
are:

Close
Closes the window.

Page Setup...
Brings up the standard Macintosh dialog about paper size,
orientation, etc.

Print/Export...
Use this item to print some or all of your keywords, or to
export them to another Papyrus database.

Edit menu

The items in the Edit menu that pertain to the Keywords window
are:

Copy
Copies the currently-selected keywords to the clipboard.

Clear
Equivalent to clicking the Keywords window’s Delete but-
ton.

Select All
Selects all the keywords in the window.



Chapter 16: Keywords Window R157

C
O

N
C

E
P

T
S

R
E

F
E

R
E

N
C

E

Reference menu

None of the items in the Reference menu pertain to the Keywords window.

Group menu

None of the items in the Group menu pertain to the Keywords window.

Font menu

Choosing a font from the Font menu will make that the font used in
the Keywords window.

You can choose different fonts for the main keyword panel and the
links panel. Your choice from the Font menu will affect whichever
panel is currently active.
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Style menu

Choosing a font size from the Style menu will make that the font size used in
the Keywords window.

You can choose different font sizes for the main keyword panel and the links
panel. Your choice from the Style menu will affect whichever panel is cur-
rently active.

Windows menu

Use this menu to open one of Papyrus’s special windows (Journals, Glos-
sary, etc.), or to switch to an already-open Group or Reference Entry window.
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Introduction

This window helps you in managing the journals of your Papyrus database. You can modify,
merge, or delete incorrect or obsolete journals, as well as create new ones. You can also import
a list of journals.

You can copy or drag a journal from this window to a Reference Entry window, to add it to the
reference.

See also:

WORKBOOK

Inputting References, Part 1
Working with the Web
Exchanging Data With Another Papyrus Version 8 Database

CONCEPTS

Journals

SHORTCUTS

Journals Window
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Elements of the Journals window

Click this button 
for help; 
option-click  for 
shortcuts

Click this button to turn 
balloon help on or off; 
double-click  for a “tour” 
of the window

Create new journals

Modify the selected 
journal

Permanently erase 
the selected journals

Combine the selected 
journals

Import a list of journals

Find all references that 
cite the selected journal

Show or hide the 
abbreviation for each 
journal

The numbers indicate how 
many references currently 
cite each journal

Apply the selected 
journals to the target 
window

While most of these journals include both a name and an abbreviation, note that only one or
the other of these have been provided for some of the journals.

Unchecking the Show abbrevs. checkbox results in a more compact display:
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Selecting journals

You can select journals using standard Macintosh techniques:

Click a journal to select it.

�  -click a journal to add it to the selection.

Shift-click a journal to add it, and all intervening journals, to the selection.

↑↑↑↑↑ or ↓↓↓↓↓ selects the journal above or below the current selection.

�  -↑↑↑↑↑ or �  -↓↓↓↓↓ selects the first or last journal in the list.

Shift-↑↑↑↑↑ or Shift-↓↓↓↓↓ enlarges the current selection to include the journal above or below.

Select All from the Edit menu selects all the journals in the list.

Selecting by typing

You can jump directly to a particular journal by typing the first few letters of its name or (if no
name has been entered) its abbreviation.
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Creating new journals

When you click the Journals window’s New... button, this dialog appears:

You must enter either the Full Journal Name, the Abbreviation, or both. Everything else here is
optional.

If you have created additional journal abbreviation styles  for your database, then in
the above dialog there will be additional fields where you can provide each abbreviation.

The Call Number field provides a place for you to indicate your library’s cataloging number
for this journal. If you provide this now, then later when you print out a list of articles to hunt
down you can sort that list by Call Number.

ISSN is the journal’s International Standard Serial Number. Some Papyrus users like to enter
this information to help in ordering reprints.

If you fill in the URL field for a journal, then Papyrus can tell use your Web browser to visit this
site. (See Working with the Web in the WORKBOOK for more details.)

Use the Comments field for any information you like. You could, for example, indicate which
volumes of this journal are held by the various libraries at your university.

The three checkboxes at the bottom of the dialog let you indicate that these items are to be
required whenever you enter an Article from this journal. This concern is described in more
detail in the Journals chapter of the CONCEPTS section.

After you have filled in the information for your new journal, click Done to save it. Or if you
wish to enter several new journals, click New. This will save your new journal and then reset
the New Journal dialog for your next entry.
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Editing journals

To modify a journal, select it in the Journals window and then click the Edit... button. Papyrus
will open the same dialog you’ve already encountered:

After you have made your changes to the journal, click Change to save the modified journal.

Any reference that cites this journal will henceforth display the new version.

Deleting journals

To erase a journal from your database, select it in the Journals window and then click the Delete
button. This confirmation dialog appears:

When you click Delete the journal will be irretrievably removed from your database.

You can also select multiple journals and delete them all at once:
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Papyrus will only let you delete journals that are not currently being cited by any references.

Merging journals

When you have accidentally created two or more versions of a single journal, select them all
and use the Merge... button to combine them:

Select the version you prefer (via mouse, arrow keys, or by typing the first few letters) and click
Merge. All references that formerly cited the unwanted version(s) of the journal will henceforth
cite the remaining version.
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Loading journals

Papyrus can import a list of journals from any plain text document. This document should
consist simply of a series of journal entries, one per line, in a form described below.

You can create this list with a word processor or any other application that can create a text-only
document. You can also have Papyrus export some or all of the journals from your database to
a text document, ready to be imported into another Papyrus database.

Once your document is ready, in the Journals window click the Load... button. Papyrus will ask
you to identify the text document to be read, and then proceed to load the journals from that
document. If it recognizes an incoming journal as one already in your database, Papyrus will
not duplicate it. If the incoming journal contains information not already present in your data-
base (abbreviation, ISSN, etc.) that information will be added to the existing journal entry.

• • •

There are two acceptable forms for each line of the document to be loaded:

Journal Name \ Abbreviation \ DIS

Journal Name \ ISSN \ URL \ Comments \ Call Number \ Abbreviation \ DIS

The first form is consistent with that used in Version 7 of Papyrus. The second form
includes the journal fields newly available in Version 8.

In both forms, the DIS piece consists of zero or more of the letters D, I, and S. These correspond
to the journal entry checkboxes indicating that Day/Month, Issue, or Series is required when
citing this particular journal.

In both forms, it makes no difference whether or not you include a space on either side of each
backslash character.

If a given journal lacks some information then you should still include the backslashes. For
example:

New England Journal of Medicine\\http://www.nejm.com/\\\New Engl. J. Med.\

In the first form only, if an entry has no DIS information you can drop the second backslash. If
it also has no abbreviation you can drop the first backslash as well. This can be convenient if
you have a list of journal names, without abbreviations, to load into Papyrus.

• • •
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After you click the Load... button and identify the document to be loaded, Papyrus will ask into
which field it should place the incoming abbreviations:

This is where you handle the situation of the two databases using different systems for their
journal abbreviations.

For incoming documents in which the first form of entry has been used, you might occasionally
find some additional choices here to be helpful:

Imagine, for example, that you have a list of journal names available to you with their library
call numbers. You can load this information into Papyrus by setting up your text document
with lines like this:

Journal Name \ Call Number

and then picking Call Number as the “Abbreviation style” when you load the document.
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Exporting journals

The File menu’s Print/Export... command not only allows you to send your journal list to your
printer or word processor, but also to a text document suitable for loading into another Papyrus
database.

When you choose Print/Export... this dialog appears:

For complete information about the various choices here, see the REFERENCE chapter on the Print/
Export Dialog.

Usually when exporting a list of journals, Papyrus will include the citation counts:

Journal list

Journal of the American Medical Association  3
     JAMA
New England Journal of Medicine  2
     New Engl. J. Med.

But if you choose Plain text as your destination, as shown above, then Papyrus will suppress
the citation counts, as well as the list’s title, and format each line appropriately for a subsequent
load:

Journal of the American Medical Association\JAMA\I
New England Journal of Medicine\New Engl. J. Med.\

Selecting For Version 8 journal load will yield the more complete form for each entry, as I’ve
described previously:

Journal of the American Medical Association\123456-7\www.jama.org\Our library col-
lection starts in 1913.\QT123.45\JAMA\I

New England Journal of Medicine\\http://www.nejm.com/\\\New Engl. J. Med.\
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When creating a list for loading into another Papyrus database, you should click the Layout...
button and set Skipped lines between items to 0. Also make sure that Fixed line length is not
checked.

Drag and Drop

To a Reference Entry window

Dragging a journal to a Reference Entry window will set that reference’s Journal field accord-
ingly. (Assuming that the reference is an Article, or some other reference type that has a Journal
field.)
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File menu

The items in the File menu that pertain to the Journals window are:

Close
Closes the window.

Page Setup...
Brings up the standard Macintosh dialog about paper size,
orientation, etc.

Print/Export...
Use this item to print some or all of your journals, or to ex-
port them to another Papyrus database.

Edit menu

The items in the Edit menu that pertain to the Journals window are:

Copy
Copies the currently-selected journals to the clipboard.

Clear
Equivalent to clicking the Journals window’s Delete button.

Select All
Selects all the journals in the window.

Launch URL

If the currently-selected journal includes an Internet URL, then Launch
URL will instruct your Web browser to go to the indicated address. Papyrus handles this via the
Internet Config extension.
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Reference menu

None of the items in the Reference menu pertain to the Journals window.

Group menu

None of the items in the Group menu pertain to the Journals window.

Font menu

Choosing a font from the Font menu will make that the font used in
the Journals window.

Style menu

Choosing a font size from the Style menu will make that the font size used in
the Journals window.
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Windows menu

Use this menu to open one of Papyrus’s special windows (Keywords, Glos-
sary, etc.), or to switch to an already-open Group or Reference Entry window.
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Introduction

This window helps you in managing the formats of your Papyrus database. You can modify or
delete incorrect or obsolete formats, as well as create new ones from scratch or starting as du-
plicates of existing formats. You can also preview formats, or exchange formats with other
Papyrus databases.

You can copy or drag a format from this window to a Group window, Reference Entry window,
Reference Links window, etc., to set that window’s format accordingly.
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See also:

WORKBOOK

Printing and Exporting Your References
Formats, Format Libraries and Predefined Formats
Preparing a Manuscript and its Bibliography Together
Creating New Output Formats
Importing—Overview
Importing—Predefined, Straightforward
Importing—Predefined, Complicated
Importing—Word Processor Bibliography
Importing—Other Structured Databases
Exchanging Data With Another Papyrus Version 8 Database

CONCEPTS

Bibliographies vs. Footnote Lists
Output Formats
Bibliographic Conventions

REFERENCE

Format Entry
Sorting & Citing
Numbering & Layout
Authors/Editors Format
Template Entry

SHORTCUTS

Formats Window
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Elements of the Formats window

Click this button 
for help; 
option-click  for 
shortcuts

Click this button to turn 
balloon help on or off; 
double-click  for a “tour” 
of the window

Create new 
format

Modify the 
selected format

Permanently erase 
the selected formats

Make a copy of 
the selected format

Apply the selected 
format to the target 
window

Create a new 
Format Library

Open an existing 
Format Library

The type of format
(Output, Import, or Tabular)

Display sample 
references using the 
selected format(s)
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Selecting formats

You can select formats using standard Macintosh techniques:

Click a format to select it.

�  -click a format to add it to the selection.

Shift-click a format to add it, and all intervening formats, to the selection.

↑↑↑↑↑ or ↓↓↓↓↓ selects the format above or below the current selection.

�  -↑↑↑↑↑ or �  -↓↓↓↓↓ selects the first or last format in the list.

Shift-↑↑↑↑↑ or Shift-↓↓↓↓↓ enlarges the current selection to include the format above or below.

Select All from the Edit menu selects all the formats in the list.

Selecting by typing

You can jump directly to a particular format by typing the first few letters of its name.

Creating new formats

When you click the Formats window’s New... button, this dialog appears:

For extensive discussion of using this dialog, see the WORKBOOK chapter on Creating New Output
Formats. A more brief summary appears in the REFERENCE chapter on the Format Entry dialog.
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Editing formats

To modify a format, select it in the Formats window and then click the Edit... button. This
dialog will appear:

For extensive discussion of using this dialog, see the WORKBOOK chapter on Creating New Output
Formats. A more brief summary appears in the REFERENCE chapter on the Format Entry dialog.

After you have made your changes to the format, click Done to save the modified format.

Any window that uses this format will update itself to use the new version.

Deleting formats

To erase one or more formats from your database, select them in the Formats window and then
click the Delete button. Papyrus will ask you to confirm your request, and then the formats will
be irretrievably removed from your database.

Duplicating formats

Often when you wish to create a new format, there is already an existing format that has many
similar characteristics. Rather than starting your new format from scratch, you can make a copy
of the existing format and then modify that.

To do so, select the existing format in the Formats window, and then click the Duplicate button.
Papyrus will create a new format with all the same characteristics as the old one, and then open
a Format Entry dialog for the new format.

You can then assign a fresh name to your new format, and proceed to make any changes you
desire.
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Previewing formats

You can examine a preview of how your references will look when displayed with a given
format. Select the format in the Formats window and then click the Preview button:

Initially the Preview window displays a sample Article. You can use the pop-up menu at the
bottom of the window to examine other types of reference.

The Preview window will be blank if you pick a reference type for which no template has
been set up in this particular format.

If you like, you can use the same Preview window to examine a different format. Either click the
Formats window’s Select button to set the new format, or else drag a format from the Formats
window to the Preview window.
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Format Libraries

As I’ve explained in the WORKBOOK chapter Formats, Format Libraries and Predefined Formats, you
use a Format Library to carry formats from one Papyrus database to another.

To open an existing Format Library, click the Open... button in the Formats window, under
Library. When you pick the relevant Library a window will open for it:

You can select formats in this window using your mouse or keyboard in exactly the same way
as in the Formats window. The Preview button also works just as the one in the Formats window
does.

You can select and edit the description at the top of the Format Library window by pressing
Tab, or by clicking directly in the description itself.

You can move formats between the Format Library window and your Formats window either
by dragging them or via copy and paste.

• • •
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To create a new Format Library, click the Formats window’s New button, under Library. Papyrus
will open a new Formats Library window, with the description already selected so that you can
easily type in an appropriate summary:

Then you can drag or paste any of your formats into the Library.
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Drag and Drop

To a Reference Entry window

Dragging a format to a Reference Entry window will set that window’s Preview display format
accordingly.

To the All References window

Dragging a format to a Group window will result in this dialog:

To a Group window

Dragging a format to a Group window will result in this dialog:

To a Format Library window

Dragging one or more formats to a Format Library window will add those formats to that
Library.

From a Format Library window

Dragging one or more formats to the Formats window will add those formats to your database.
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File menu

The items in the File menu that pertain to the Formats window are:

Close
Closes the window.

Page Setup...
Brings up the standard Macintosh dialog about paper size,
orientation, etc.

Print/Export...
Use this item to produce a list of the names and descriptions
of some or all of your formats.

Edit menu

The items in the Edit menu that pertain to the Formats window are:

Cut
Copies the currently-selected formats to the clipboard, and
then deletes them from your database.

Copy
Copies the currently-selected formats to the clipboard.

Paste
Adds the format(s) from the clipboard to your database.

Clear
Equivalent to clicking the Formats window’s Delete button.

Select All
Selects all the formats in the window.
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Reference menu

None of the items in the Reference menu pertain to the Formats window.

Group menu

None of the items in the Group menu pertain to the Formats window.

Font menu

Choosing a font from the Font menu will make that the font used in
the Formats window.
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Style menu

Choosing a font size from the Style menu will make that the font size used in
the Formats window.

Windows menu

Use this menu to open one of Papyrus’s special windows (Journals, Glos-
sary, etc.), or to switch to an already-open Group or Reference Entry window.
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Introduction

This window helps you in managing the names of authors and editors. You can modify and
merge incorrectly-entered names, and tell Papyrus to sort them differently from how they are
spelled. You can also import a list of names.

You can copy or drag a name from this window to a Reference Entry window, to add it to the
reference.

Unlike the Keywords, Journals, and Glossary windows, the Names window only includes en-
tries for authors or editors that are actually currently being cited by at least one reference. So
you cannot use the Names window to create new names, nor to delete a name.

The Names window also keeps track of names that are sorted differently from their spelling.
For example, you might have some papers citing an author of Sloop,JB and others with the
author Sloop,John. If you know that these both refer to the same person, you can tell Papyrus to
sort both of these as Sloop,John B. Then in a bibliography the two references will appear to-
gether in the alphabetical listing, without an article by, say, Smith,JC coming between them.

See also:

WORKBOOK

Inputting References, Part 2
Globally Changing Information
Exchanging Data With Another Papyrus Version 8 Database

CONCEPTS

Bibliographic Conventions
Names

REFERENCE

Reference Types and Their Fields

SHORTCUTS

Names Window
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Elements of the Names window

Click this button 
for help; 
option-click  for 
shortcuts

Click this button to turn 
balloon help on or off; 
double-click  for a “tour” 
of the window

Modify the 
selected name

Import a list 
of names

Find all references 
that cite the 
selected name

The numbers indicate how 
many references currently 
cite each name

Apply the selected 
names to the target 
window

A bullet (•) after the citation number indicates that the name’s sorting differs from its display.

For example, in the above example Papyrus has been told that LaFièvre,H is to be alphabetized
as if it were Fièvre,H.

Selecting names

You can select names using standard Macintosh techniques:

Click a name to select it.

�  -click a name to add it to the selection.

Shift-click a name to add it, and all intervening names, to the selection.

↑↑↑↑↑ or ↓↓↓↓↓ selects the name above or below the current selection.

�  -↑↑↑↑↑ or �  -↓↓↓↓↓ selects the first or last name in the list.

Shift-↑↑↑↑↑ or Shift-↓↓↓↓↓ enlarges the current selection to include the name above or below.

Select All from the Edit menu selects all the names in the list.
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Selecting by typing

You can jump directly to a particular name by typing its first few letters.

Editing names

To modify a name or its sorting, select it in the Names window and then click the Edit... button.
This dialog will appear:

In most cases the two versions of the name—the display version and the “Sort as” version—
will be identical. But in some cases a name should be alphabetized in a different way than it is
displayed:

There are also authors whose names appear differently in different publications. You can tell
Papyrus to sort each of these variations in a common fashion, so that in a bibliography all the
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works by the same author will be listed together, even if his or her name was originally cited in
various guises:

When you make a change in this name-editing window, all references that cite the affected
author will be updated accordingly.
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Merging names

There is no Merge button in the Names window. If you find that you have multiple entries for
one person, due perhaps to a typographical error, then you should use Edit... to correct the
mistaken entry:

As with any time you make a change to a name, any references that previously cited the incor-
rect form of the name will automatically be updated.

Loading names

Papyrus can import a list of names from any plain text document. This document should con-
sist simply of a series of names, one per line.

The Names window keeps track only of names that are being cited by references in your data-
base, so there is no point in trying to load a batch of ordinary names—Papyrus will ignore these
if you try. However, if you have a list of names that are to be sorted differently from how they
are displayed, then it does make sense to use the Load function to bring these into Papyrus.

Each line in the text file should indicate both the display name and the sorting name, separated
by a backslash:

von Helmholtz,HLF\Helmholtz,HLF
Smith,J\Smith,Jill
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You can create this list with a word processor or any other application that can create a text-only
document. You can also have Papyrus export some or all of the names from one database to a
text document, ready to be imported into another Papyrus database.

In the Names window, click the Load... button. Papyrus will ask you to identify the text docu-
ment to be read, and then proceed to load the names from that document. If it recognizes an
incoming name as one already in your database, Papyrus will not duplicate it.

Exporting names

The File menu’s Print/Export... command not only allows you to send your list of names to
your printer or word processor, but also to a text document suitable for loading into another
Papyrus database.

When you choose Print/Export... this dialog appears:

Click the Layout... button and set Skipped lines between items to 0. Also make sure that Fixed
line length is not checked.

For complete information about the other choices here, see the REFERENCE chapter on the Print/
Export dialog.

Usually when exporting a list of names, Papyrus will include the citation counts:

Names

Jung,C G  1
LaFièvre,H  1
Laszlo,J A  1
Martin,S  2
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But if you choose Plain text as your destination, as shown above, then Papyrus will suppress
the citation counts, as well as the list’s title. It will also include the sorting version of any names
that are sorted differently from how they are displayed:

Jung,C G
LaFièvre,H\Fièvre,H
Laszlo,J A
Martin,S

The resulting document is ready to be loaded into another Papyrus database.

Drag and Drop

You can drag a name from the Names window to any other window that accepts text entries.
For example, you can drag a name to an Author or Editor field in a Reference Entry window.
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File menu

The items in the File menu that pertain to the Names window are:

Close
Closes the window.

Page Setup...
Brings up the standard Macintosh dialog about paper size,
orientation, etc.

Print/Export...
Use this item to print some or all of your names, or to export
them to another Papyrus database.

Edit menu

The items in the Edit menu that pertain to the Names window are:

Copy
Copies the currently-selected name to the clipboard.

Select All
Selects all the names in the window.
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Reference menu

None of the items in the Reference menu pertain to the Names window.

Group menu

None of the items in the Group menu pertain to the Names window.

Font menu

Choosing a font from the Font menu will make that the font used in
the Names window.
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Style menu

Choosing a font size from the Style menu will make that the font size used in
the Names window.

Windows menu

Use this menu to open one of Papyrus’s special windows (Journals, Glos-
sary, etc.), or to switch to an already-open Group or Reference Entry window.
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Glossary Window
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Elements of the Glossary window ....................R201
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Editing Glossary entries ......................................R202
Deleting Glossary entries ...................................R203
Loading Glossary entries ...................................R203
Exporting Glossary entries .................................R204
Drag and Drop ...................................................R205
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Introduction

The Glossary is a collection of words and phrases that you expect to use frequently. Putting a
phrase into the Glossary allows you to avoid typing it over and over in the future.

The Glossary window helps you in managing your database’s Glossary. You can modify or
delete incorrect or obsolete Glossary entries, as well as create new ones. You can also import a
list of Glossary entries.

You can copy or drag entries from this window to other windows.

See also:

WORKBOOK

Inputting References, Part 2
Exchanging Data With Another Papyrus Version 8 Database

REFERENCE

Look Up

SHORTCUTS

Glossary Window
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Elements of the Glossary window

Click this button 
for help; 
option-click  for 
shortcuts

Click this button to turn 
balloon help on or off; 
double-click  for a “tour” 
of the window

Create new entries

Modify the 
selected entry

Permanently erase 
the selected entries

Import a list of 
glossary entries

Insert the selected entry 
into the target window

Selecting Glossary entries

You can select entries using standard Macintosh techniques:

Click a entry to select it.

�  -click an entry to add it to the selection.

Shift-click an entry to add it, and all intervening entries, to the selection.

↑↑↑↑↑ or ↓↓↓↓↓ selects the entry above or below the current selection.

�  -↑↑↑↑↑ or �  -↓↓↓↓↓ selects the first or last entry in the list.

Shift-↑↑↑↑↑ or Shift-↓↓↓↓↓ enlarges the current selection to include the entry above or below.

Select All from the Edit menu selects all the entries in the list.

Selecting by typing

You can jump directly to a particular entry by typing its first few letters.
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Creating new Glossary entries

When you click the Glossary window’s New... button, this dialog appears:

After you have entered your new entry, click Done to save it. Or if you wish to enter several
new Glossary entries, click New. This will save your new entry and then reset the New Glos-
sary Entry dialog for your next entry.

Editing Glossary entries

To modify a Glossary entry, select it in the Glossary window and then click the Edit... button.
Papyrus will open the same dialog you’ve already encountered:

After you have made your changes to the Glossary entry, click Change to save the modified
entry.

Note that changing an entry in the Glossary window will not have any effect elsewhere in your
database. In other words, the Glossary is merely a source of words and phrases—unlike Jour-
nals or Keywords, there is no connection between an entry in the Glossary and the references
that use that word or phrase.
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Deleting Glossary entries

To erase a Glossary entry from your database, select it in the Glossary window and then click
the Delete button. This confirmation dialog appears:

When you click Delete the entry will be irretrievably removed from your Glossary.

You can also select multiple entries and delete them all at once:

Loading Glossary entries

Papyrus can import a list of Glossary entries from any plain text document. This document
should consist simply of a series of words or phrases, one per line.

You can create this list with a word processor or any other application that can create a text-only
document. You can also have Papyrus export some or all of the Glossary entries from one data-
base to a text document, ready to be imported into another Papyrus database.

In the Glossary window, click the Load... button. Papyrus will ask you to identify the text docu-
ment to be read, and then proceed to load the entries from that document. If it recognizes an
incoming Glossary entry as one already in your database, Papyrus will not duplicate it.
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Exporting Glossary entries

The File menu’s Print/Export... command not only allows you to send your Glossary list to
your printer or word processor, but also to a text document suitable for loading into another
Papyrus database.

When you choose Print/Export... this dialog appears:

Click the Layout... button and set Skipped lines between items to 0. Also make sure that Fixed
line length is not checked.

For complete information about the other choices here, see the REFERENCE chapter on the Print/
Export dialog.

Usually when exporting a list of Glossary entries, Papyrus will include a title:

Glossary

corticothalamic
Eclectic neurosurgery
histofluorescence
humor-impaired
nystagmus
spinocerebellar
spinothalamic
vestibulocochlear nerve

But if you choose Plain text as your destination, as shown above, then Papyrus will suppress
the title.

The resulting document is ready to be loaded into another Papyrus database.
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Drag and Drop

From the Glossary window

You can drag an entry from the Glossary window to any other window that accepts text (in-
cluding windows belonging to other applications).

To the Glossary window

Dragging a word or phrase from another window (including windows belonging to other appli-
cations) to the Glossary window adds that word or phrase as a new Glossary entry.



R206 Windows

File menu

The items in the File menu that pertain to the Glossary window are:

Close
Closes the window.

Page Setup...
Brings up the standard Macintosh dialog about paper size,
orientation, etc.

Print/Export...
Use this item to print some or all of your Glossary entries, or
to export them to another Papyrus database.

Edit menu

The items in the Edit menu that pertain to the Glossary window are:

Copy
Copies the currently-selected entry to the clipboard.

Paste
Makes a new Glossary entry from the current contents of the
clipboard.

Clear
Equivalent to clicking the Glossary window’s Delete button.

Select All
Selects all the entries in the window.

Reference menu

None of the items in the Reference menu pertain to the Glossary window.
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Group menu

None of the items in the Group menu pertain to the Glossary window.

Font menu

Choosing a font from the Font menu will make that the font used in
the Glossary window.

Style menu

Choosing a font size from the Style menu will make that the font size used in
the Glossary window.

Windows menu

Use this menu to open one of Papyrus’s special windows (Keywords, Jour-
nals, etc.), or to switch to an already-open Group or Reference Entry window.
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Introduction

As I’ve discussed in the Keyword Links chapter of the WORKBOOK, Papyrus lets you establish
links between your keywords. You can set up a hierarchy of super-categories and sub-catego-
ries, indicate that two keywords are synonyms or antonyms, or establish any web of connections
you desire.

The Keyword Links window is where you create these links. To open a Keyword Links window
for a particular keyword, select that keyword in the Keywords window and click the Links
window button.

You can also open a Keywords Links window by Shift-Option-Double-clicking  the
keyword in any window it appears—the Keywords window, a Reference Entry window,
or another Keyword Links window.

See also:

WORKBOOK

Keyword Links
Concepts
Keywords

REFERENCE

Keywords Window
Find

SHORTCUTS

Keyword Links Window
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Elements of the Keyword Links window

Click this button for help; 
option-click  for shortcuts

Click this button to turn 
balloon help on or off; 
double-click  for a “tour” 
of the window

Click this button to 
show or hide the links 
for this keyword

Click this button to 
show or hide the links 
of this link type

Click this button to 
find all references 
citing the selected 
keyword

Click this button to open 
a Links window for the 
selected keyword

Click this button to set your 
preferred font and size for 
the Links window

This keyword is 
currently selected

The number appearing in brackets after each keyword is the same number that appears in the
Keywords window—a count of how many references currently cite that keyword.
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Selecting keywords

You can select keywords using standard Macintosh techniques:

Click a keyword to select it.

�  -click a keyword to add it to the selection.

Shift-click a keyword to add it, and all intervening keywords, to the selection.

↑↑↑↑↑ or ↓↓↓↓↓ selects the keyword above or below the current selection.

Shift-↑↑↑↑↑ or Shift-↓↓↓↓↓ enlarges the current selection to include the keyword above or below.

Select All from the Edit menu selects all keywords in the window.

Creating a Link

To create a link between two keywords, you drag one of them to a Keyword Links window
where the other appears.

You can drag the incoming keyword from  any window where it appears. This could be
the Keywords window, or it could be another Keyword Links window. It could even be
from within the same Keyword Links window to which you’re going to drop the keyword.

There are three places onto which you can drop the incoming keyword:

1

2

3
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1  You can drop the incoming keyword onto a keyword appearing in the Keyword Links
window. Papyrus will then ask you what sort of link to create between these two keywords.

In the above illustration, the incoming keyword would be linked to General surgery.

2  You can drop the incoming keyword onto a link type appearing in the Keyword Links
window. This will create a new link between the dragged keyword and that link type’s parent.
The new link will be of the same type.

In the above illustration, the incoming keyword would be made a Super-category of Paranor-
mal phenomenon.

3  You can drop the incoming keyword elsewhere in the window. This will create a link between
the incoming keyword and the keyword to which the window belongs. Papyrus will ask you
what sort of link to create.

In the above illustration, the incoming keyword would be linked to Surgery.

• • •

When you create a new link, you must tell Papyrus what sort of link to make. There are four
link types built into Papyrus, as shown in the Link dialog:

Note that Super-category/Sub-category  and Sub-category/Super-category  are really
the same link type, viewed from two different directions.

The incoming keyword (Urology) and the target keyword (Surgery) are shown at the top of the
dialog. The selected link type indicates that Urology is to be considered a Sub-category of Sur-
gery.

To establish the link, click the Link button.
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If none of the available link types serves your needs, clicking the New link type... button allows
you to define a new one:

There’s no need to agonize over which description you use as the Forward link  and
which as the Reverse link . We just wanted to use shorter names here than “The link as
viewed from one end” and “The link as viewed from the other end.”

For symmetrical link types, such as Synonym or Closely related, simply type exactly the same
description for Forward link and Reverse link.

After you click OK your new link type will appear in the Link dialog:

The Edit link type... button allows you to change the descriptions you’ve used.

The four built-in link types cannot be edited.

You cannot delete a link type. If you wish to discontinue using one of your personally-created
link types, use Edit link type... to change it something innocuous:
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At a future date you can change this link type to something useful.

Deleting a Link

To unlink two keywords, open a Keyword Links window for one of them. Then select the key-
word you wish to unlink and choose Cut or Clear from the Edit menu.

You can also use your keyboard’s Delete or Clear key to accomplish the same thing.

Drag and Drop

Within the Keyword Links window

Dragging a keyword onto another keyword, or onto a link type, will create a new link. (See
Creating a Link.)

To a different Keyword Links window

Dragging a keyword to another Keyword Links window will create a new link. (See Creating a
Link.)

To a Reference Entry window

Dragging one or more keywords to a Reference Entry window will add those keywords to that
reference.

To a Group window

Dragging one or more keywords to a Group window will add those keywords to each of the
references contained in the Group.

From the Keywords window

Dragging one or more keywords to the Keyword Links window will create new links for those
keywords. (See Creating a Link.)
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File menu

The items in the File menu that pertain to Keyword Links windows
are:

Close
Closes the window.

Page Setup...
Brings up the standard Macintosh dialog about paper size,
orientation, etc.

Print/Export...
Use this item to print the contents of the Keyword Links
window.

Edit menu

The items in the Edit menu that pertain to Keyword Links windows
are:

Cut
Removes the link to the currently-selected keyword or key-
words, and puts those keywords onto the clipboard.

Copy
Copies the currently-selected keywords to the clipboard.

Clear
Removes the link to the currently-selected keyword or key-
words.

Select All
Selects all the keywords in the window.

Reference menu

None of the items in the Reference menu pertain to Keyword Links win-
dows.
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Group menu

None of the items in the Group menu pertain to Keyword Links win-
dows.

Font menu

Choosing a font from the Font menu will make that the default font
for the current Keyword Links window.

This change will affect only the current window. To change your default
fonts for future Keyword Links windows, use the Preferences button.

Style menu

Choosing a font size from the Style menu will make that the default font size
for the current Keyword Links window.

This change will affect only the current window. To change your default font
size for future Keyword Links windows, use the Preferences button.

Windows menu

Use this menu to open one of Papyrus’s special windows (Keywords,
Journals, Glossary, etc.), or to switch to an already-open Group or
Reference Entry window.
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Introduction

As I’ve discussed in the Reference Links chapter of the WORKBOOK, Papyrus lets you establish
links between your references. You can link a notecard to the reference that it describes or
quotes. You might indicate that one reference is reviewed by another, or that a recent article
refutes an earlier work.

The Reference Links window is where you create these links. To open a Reference Links window
for a particular reference, select that reference in the All References window, a Group window,
or a Reference Entry window and click the Links window button.

You can also open a Reference Links window by Shift-Option-Double-clicking  the
reference in any window it appears.

See also:

WORKBOOK

Reference Links

CONCEPTS

Notecards and Linked References

REFERENCE

Print/Export
Find

SHORTCUTS

Reference Links Window
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Elements of the Reference Links window

Click this button for help; 
option-click  for shortcuts

Click this button to turn 
balloon help on or off; 
double-click  for a “tour” 
of the window

Click this button to 
show or hide the links 
for this reference

Click this button to 
show or hide the links 
of this link type

Click this button to open 
a Links window for the 
selected item

Click this button to set your preferred 
display formats, font and size for the 
Links window

This item is 
currently selected
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Display formats

Within a References Link window each reference may be displayed in a compact or expanded
format. By default these are, respectively, the built-in COMPACT and STANDARD formats.

Initially all items are shown in the compact format. You can switch between the compact format
and the expanded format by double-clicking a reference:

You can also switch between the two formats by selecting one or more references and pressing
your Return or Enter key.

To change the window’s display formats, use the Preferences button.
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Preferences button

Clicking this button brings up the following dialog box:

Here you can set each of the display formats for the window, by clicking the corresponding
Change format button. Doing so will bring up a list of available output formats from which you
can choose.

You can also pick the font and font size used in the window.

If Use as default settings for new Reference Links windows is checked, then these settings will
apply to all future Reference Links windows as well as the present window. If it is not checked,
then these changes will only apply to the current window.

Selecting references

You can select references using standard Macintosh techniques:

Click a reference to select it.

�  -click a reference to add it to the selection.

Shift-click a reference to add it, and all intervening references, to the selection.

↑↑↑↑↑ or ↓↓↓↓↓ selects the reference above or below the current selection.

Shift-↑↑↑↑↑ or Shift-↓↓↓↓↓ enlarges the current selection to include the reference above or below.

Select All from the Edit menu selects all references in the window.
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Creating a Link

To create a link between two references, you drag one of them to a Reference Links window
where the other appears.

You can drag the incoming reference from  any window where it appears. This could be
the All References window, a Group window, a Reference Entry window, or it could be
another Reference Links window. It could even be from within the same Reference
Links window to which you’re going to drop the reference.

There are three places onto which you can drop the incoming reference:

1

2

3

1  You can drop the incoming reference onto a reference appearing in the Reference Links
window. Papyrus will then ask you what sort of link to create between these two references.

In the above illustration, the incoming reference would be linked to Reference #7.

2  You can drop the incoming reference onto a link type appearing in the Reference Links
window. This will create a new link between the dragged reference and that link type’s parent.
The new link will be of the same type.

In the above illustration, the incoming reference would be made a Work reviewed of Reference
#3.

3  You can drop the incoming reference elsewhere in the window. This will create a link between
the incoming reference and the reference to which the window belongs. Papyrus will ask you
what sort of link to create.

In the above illustration, the incoming reference would be linked to Reference #3.
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• • •

When you create a new link, you must tell Papyrus what sort of link to make. There are two link
types built into Papyrus, as shown in the Link dialog:

Note that the dialog shows only two link types, each viewed from two different direc-
tions.

The incoming reference (#13) and the target reference (#2) are shown at the top of the dialog.
The selected link type indicates that #13 is to be considered a Notecard of #2.

To establish the link, click the Link button.

If none of the available link types serves your needs, clicking the New link type... button allows
you to define a new one:

There’s no need to agonize over which description you use as the Forward link  and
which as the Reverse link . We just wanted to use shorter names here than “The link as
viewed from one end” and “The link as viewed from the other end.”

For symmetrical link types, such as Same research group or Ongoing feud, simply type exactly
the same description for Forward link and Reverse link.

After you click OK your new link type will appear in the Link dialog:
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The Edit link type... button allows you to change the descriptions you’ve used.

The two built-in link types cannot be edited.

You cannot delete a link type. If you wish to discontinue using one of your personally-created
link types, use Edit link type... to change it something innocuous:

At a future date you can change this link type to something useful.

Deleting a Link

To unlink two references, open a Reference Links window for one of them. Then select the
reference you wish to unlink and choose Cut or Clear from the Edit menu.

You can also use your keyboard’s Delete or Clear key to accomplish the same thing.
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Drag and Drop

Within the Reference Links window

Dragging a reference onto another reference, or onto a link type, will create a new link. (See
Creating a Link.)

To a different Reference Links window

Dragging a reference to another Reference Links window will create a new link. (See Creating a
Link.)

To a Group window

Dragging references to a Group window will add those references to the Group.

To a Reference Entry window

Dragging a reference to a Reference Entry window will set the empty fields in the entry window
to the values present in the dragged reference.

From a Group window

Dragging a reference to a Reference Links window will create a new link. (See Creating a Link.)

From a Reference Entry window

Dragging a reference to a Reference Links window will create a new link. (See Creating a Link.)

From the Formats window

You can change either of the window’s display formats by dragging a format onto the Reference
Links window.
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File menu

The items in the File menu that pertain to Reference Links windows
are:

Close
Closes the window.

Page Setup...
Brings up the standard Macintosh dialog about paper size,
orientation, etc.

Print/Export...
Use this item to print the contents of the Reference Links
window.

Edit menu

The items in the Edit menu that pertain to Reference Links windows
are:

Cut
Removes the link to the currently-selected reference or refer-
ences, and puts those references onto the clipboard.

Copy
Copies the currently-selected references to the clipboard.

Clear
Removes the link to the currently-selected references or ref-
erences.

Select All
Selects all the references in the window.

Launch URL
If the currently-selected reference includes an Internet URL, then Launch URL
will instruct your Web browser to go to the indicated address. Papyrus handles
this via the Internet Config extension.
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Reference menu

The items in the Reference menu that pertain to Reference Links win-
dows are:

Edit
Opens a Reference Entry window for each of the currently-selected
references.

Delete
Permanently deletes the currently-selected references from your database.

Merge
Combines the currently-selected references into a single reference. You will use
this when you discover duplicate entries corresponding to the same publica-
tion. When some fields differ between the entries, such as keywords or
comments, Papyrus will ask you whether you wish to keep one version or the
other, or combine the two.

Add Notecards
Opens a new Reference Entry window where you can enter one or more new
notecards. These notecards will be linked to each of the currently-selected ref-
erences.

Cite...
Places the currently-selected reference into the clipboard, so that you can paste
them into another application, such as a word processor. The Cite dialog lets
you decide whether the references will be pasted as formatted citations or as
placeholders for a subsequent Process Manuscript operation.

Group menu

None of the items in the Group menu pertain to Reference Links win-
dows.
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Font menu

Choosing a font from the Font menu will make that the default font
for the current Reference Links window.

This change will affect only the current window. To change your default
fonts for future Reference Links windows, use the Preferences button.

Style menu

Choosing a font size from the Style menu will make that the default font size
for the current Reference Links window.

This change will affect only the current window. To change your default font
size for future Reference Links windows, use the Preferences button.

Windows menu

Use this menu to open one of Papyrus’s special windows (Keywords, Jour-
nals, Glossary, etc.), or to switch to an already-open Group or Reference
Entry window.
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CHAPTER 23

Database Info Dialog
This dialog appears when you create a new database. For an existing database you can bring up
this dialog by clicking the  button in either the Status window or All References window. Or
with either of those windows selected you can choose Get Info from the File menu.

Database description

You can enter whatever description you like. The description is displayed in the database’s
Status window, so if you work with more than one database you can always tell which one you
currently have open.

When you transfer references to another Papyrus database, their original database description
is transferred along with them. Thus you can always tell from whose database a particular
reference originated.

Allowable Reference Numbers

Papyrus allows Reference Numbers of up to 8 million. But if you will be sharing your work
with another Papyrus user, it will usually be helpful to restrict each database to a different
range of Reference Numbers. That way you can exchange references without running into num-
bering conflicts.

After you fill in the limits in this dialog, Papyrus will ensure that any new entries to your
database are numbered accordingly.
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See also:

WORKBOOK

Creating a fresh Papyrus database

REFERENCE

Status Window
All References Window
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Database Settings Dialog
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New keywords ....................................................R238
Journal abbreviation styles ...............................R239
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TeX conversion ...................................................R242
Miscellaneous settings .......................................R243
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Introduction

To open this dialog, choose Database Settings... from the File menu.

From here you can control many fundamental aspects of your Papyrus database.

See also:

WORKBOOK

Working with the Web
Spellchecking
Fields & Reference Types
Alphabetizing Rules

CONCEPTS

Journals
Access Codes

REFERENCE

Using Papyrus with TeX, LaTeX, and BibTeX
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Fields & Reference Types

When you click the Fields & Reference Types button, this dialog will appear:

This is a rather complex dialog. It allows you to create new fields or new reference types, and to
change the nature and order of the fields for each reference type.

For a complete exploration of this dialog see the Fields & Reference Types chapter in the WORK-
BOOK section.
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Alphabetizing

When you click the Alphabetizing button, this dialog will appear:

This dialog controls the way that authors, title words, etc. are sorted in your database. For each
script system installed on your computer—Roman, Japanese, Chinese, Arabic, Hebrew, and so
on—you can specify the language or dialect whose rules should be used for sorting entries in
that script system.

For the Roman script Papyrus provides an additional choice, Sort umlauts as in German. Even
if you are sorting according to the rules of, say, English, you might still prefer to sort umlauted
letters according to the German method (ö sorted as oe) rather than the English method (ö
sorted as o).
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Moreover, our experiments with some versions of Apple’s system software have shown that
even when set to use German rules, the system software continues to sort ö as o. If you check
Sort umlauts as in German then Papyrus will ensure the correct sorting of umlauted letters.

Access Codes

When you click the Access Codes button, this dialog will appear:

You can enter up to two access codes, a medium-level code and a high-level code. You can then
indicate which code, if any, is necessary for the three categories of action shown.

Typically, knowledge of the high-level access code would be restricted to the one or two people
most responsible for the care of your database. These are the only people who will be able to
access the Database Settings dialog.

Slightly less trusted individuals may be granted knowledge of the medium-level code so that
they can make routine additions and changes to the database.

Those remaining members of the hoi polloi who know neither code will still be able to do
searches, compile bibliographies, and otherwise access your database, but they will be unable
to alter its contents.
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New keywords

When you click the New keywords button, this dialog will appear:

The first choice is most applicable for databases maintained by just one or two people. It allows
you to create a new keyword simply by typing it as you enter or edit a reference. This is very
convenient if you wish to invent your keywords as you encounter a need for them.

The second choice ensures that new keywords will be added to your database only from the
Keywords window, where all your existing keywords are readily apparent. This will help you
avoid accidental synonyms or misspellings. If you want to plan out your system of keywords in
advance, or if you need to protect the integrity of your database against the ravages of under-
paid undergraduate drones, then select this second choice.
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Journal abbreviation styles

When you click the Journal abbreviation styles button, this dialog will appear:

Here is where you can establish more than one style of journal abbreviation, as explained in the
Journals chapter of the CONCEPTS section.

Use the Edit... button to change the name of a style:

Use the New... button to create additional styles:

Until you click the OK button you can remove your newly-created styles via the Delete button.
However, once you have OKed this dialog you will not henceforth be able to delete the new
style. The best you can do at that point is rename the style to Unused or Reserved for future use
or some such.
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Once you’ve created additional abbreviation styles, spaces for each of them will automatically
be provided in the Journal Entry dialog:

When you print a list of journals from the Journals window, Papyrus will ask you which abbre-
viation style to display in the list:

You will also be given your choice of abbreviation styles when you create or edit output and
import formats.
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Helper applications

When you click the Helper applications button, this dialog will appear:

Here is where you tell Papyrus what application on your computer to use as a Web browser,
and what application will serve as your spellchecker.

To set or change either of these, click the corresponding Change button. Papyrus will present a
standard Macintosh file-opening dialog where you can indicate the relevant application.

Papyrus uses your Web browser for presenting its online help.

For all the interesting details regarding spellcheckers, see the Spellchecking chapter in the WORK-
BOOK section.
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TeX conversion

When you click the TeX conversion button, this dialog will appear:

There is a lot going on here. For a complete discussion, see the REFERENCE chapter Using Papyrus
with TeX, LaTeX, and BibTeX.
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Miscellaneous settings

When you click the Miscellaneous settings button, this dialog will appear:

These questions are self-explanatory.
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Introduction

To open this dialog, choose Database Repair... from the File menu.

You will not need to use this dialog often at all. However, if a computer crash or other problem
has resulted in damage to your Papyrus database, these functions will usually allow Papyrus to
correct that damage.

All three functions display the same sort of progress dialog:

Total time indicates the elapsed time, in hours and minutes, that the function has so far been
running. Current pass indicates the time spent thus far on the current pass of repairs. The progress
bar at the bottom of the dialog indicates the work done so far in the current pass.

If for some reason you wish to abort the repair, click Stop. If Papyrus had been in the final pass
of Repair database integrity or either of the final two passes of Rebuild index file then your
database will be unusable until you subsequently run the repair function to completion.

As with all time-consuming operations, Papyrus monitors other activity on your computer as it
proceeds. If you are working in other applications then Papyrus will take control of your com-
puter for a smaller slice of each second. Still, in some situations you might be inconvenienced
by Papyrus slowing your work; if this occurs click Pause—Papyrus will suspend its repair
function until you tell it to resume.
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See also:

WORKBOOK

Creating a fresh Papyrus database

CONCEPTS

Indexes
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Check database integrity

This function scans your main database document (e.g., My References) for inconsistencies. It
does not examine your index file (My References.idx).

This function will never make any changes to a database, so it is always safe to run.

Each record in a Papyrus main database document includes extra information to help Papyrus
detect and repair file damage. There are many ways that Papyrus can use this information to
examine the database for damage. In addition, Papyrus can check that records refer to each
other correctly—for example, if a reference claims to cite a particular keyword, then Papyrus
can confirm that this keyword does indeed exist.

However, at this time (late 1998), despite a great deal of Papyrus use by many people we have
not yet encountered a main database document with any sort of internal damage. On the one
hand this means that we seem to have done a very good job of engineering Papyrus to prevent
such damage in the first place. On the other hand, it also means that we do not know which of
the many possible integrity checks would be worth implementing in Papyrus.

Therefore at this time the Check database integrity function actually does nothing at all. If in
the future we find inconsistencies in anyone’s main database document then we will begin to
beef up the work done by this option.

Repair database integrity

If the Check database integrity function finds any problems in your main database document,
then this function will attempt to repair the document.

As with Check database integrity, though, since so far no Papyrus database has shown any
signs of internal damage, we don’t have any basis for knowing which sorts of theoretically-
possible repairs to implement here.

So at present the Repair database integrity function only performs a few very basic operations.
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Rebuild index file

As discussed at length in the CONCEPTS chapter on Indexes, Papyrus maintains many indexes of
your database to speed its searches and to perform other housekeeping chores. All of the in-
dexes are physically stored in your Papyrus index file (e.g., My References.idx).

Should your computer crash for some reason while Papyrus is in the middle of storing new
information, the most-recently entered data may not yet be fully indexed. This could cause bad
things to happen the next time you use Papyrus.

If this situation arises, you will find that when you next try to launch Papyrus it will insist that
you perform a Rebuild index file. (If it does not so insist then you can rest easy—all indexing
had, in fact, been completed prior to your crash.) This function rebuilds all of the indexes in
your index file based on the information in your main database document.

Thus, Rebuild index file can be a savior in recovering crashed data. Its main drawback is that it
can be rather time-consuming. The longer your Titles, Comments and Abstracts, in particular,
the more indexing Papyrus must do. So if you have tens of thousands of references and a not
particularly fast hard disk, you may be looking at several hours for this option to run.

One way to avoid such time-consuming scenarios is to make frequent back-ups of your two
Papyrus database documents (the main document and the index file). In the event of a poorly-
timed crash that would require a Rebuild index file, you will then have the option of instead
restoring your most recent back-up and simply picking up from where you had left off.

Rebuild index file has a second use. As I’ve mentioned elsewhere, if you have only the main
database document for a particular database, then this function can create a fresh index file for
that database. This might occur if your back-up disks or tapes contain a copy of only the main
database document. Or a colleague might wish to give you a copy of her Papyrus database, in
which case she can save e-mail time or disk space by providing you with just the main docu-
ment.
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Introduction

We have designed Papyrus Version 8 so that it is extremely easy to transfer information from
one Version 8 database to another. We have also put considerable effort into making exchanges
with Papyrus Version 7 databases as convenient as possible.

Choosing Papyrus-Papyrus Transfer... from the File menu results in this dialog:

The functions available from this dialog allow you to import or export an entire Papyrus data-
base. They also let you import or export just selected references along with their associated
journals and keywords.

There are other techniques for transferring just keywords, journals, formats, names, or glossary
entries between databases. See the WORKBOOK chapters indicated below for details.

See also:

WORKBOOK

Exchanging Data With Papyrus Version 7
Exchanging Data With Another Papyrus Version 8 Database
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Import from Version 8

You can import into your database the entire contents of another Papyrus Version 8 database.
Clicking Import from Version 8 produces this dialog:

This dialog is quite similar to the Import dialog.

Database file

Clicking the  button lets you indicate the document to be imported. This must be a Papyrus
main database document—either someone’s Papyrus database, or else a document created by
the Export for Version 8 function.

Starting number for incoming references

As Papyrus imports each incoming reference, it must assign the reference a Papyrus Reference
#. You can indicate here the starting point for these numbers.

Retain incoming reference numbers

Here you can indicate that the incoming references should keep their existing reference num-
bers as they are added to your database, rather than being assigned fresh numbers.
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Duplicate references

If Papyrus suspects that an incoming reference is a duplicate of a reference already in your
database, then your choice here will control what Papyrus does about the situation:

Automatically skip
Papyrus will copy the incoming reference to the reject file. The reference will
not be added to your database.

Pause to decide
Papyrus will pause its import process, and present you with a dialog window
that shows both the incoming reference and the existing reference, so that you
can decide how Papyrus should proceed.

Save anyhow

Papyrus will add the incoming reference to your database, in addition to the existing
reference.

Merge incoming reference with existing reference
Papyrus will combine the two references, adding any new incoming informa-
tion to the reference already in your database.

Save incoming reference, delete existing reference
Papyrus will add the incoming reference to your database, while deleting the
existing reference from your database. This might come in handy if you know
that your current import source is more reliable or accurate than a different
source you have used in the past.

Any references previously linked to the existing reference will be re-linked to
the new incoming reference.

If you select this choice, then an additional checkbox will appear:

Clicking this checkbox tells Papyrus to reassign the Reference # of the existing
reference to the incoming reference.

Keywords to add

If you would like to add one or more keywords to each of the incoming references, click the
 button. Papyrus will then present you with its Keywords window, where you can pick

the relevant keywords.
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• • •

If the incoming database document includes any user-defined reference types, fields, journal
abbreviation styles, or link types, then Papyrus will ask you how you wish to “map” the incom-
ing categories to those in your own database. See Import—Advanced concerns later in this chapter
for the details.

As the import proceeds, you can follow its progress in this dialog:

As with all time-consuming operations, Papyrus monitors other activity on your computer as it
proceeds. If you are doing other work in Papyrus or elsewhere, then this import will take con-
trol of your computer for a smaller slice of each second. Still, in some situations you might be
inconvenienced by Papyrus slowing your other work; if this occurs click Pause—Papyrus will
suspend its importing until you tell it to resume.

• • •

After you have imported references from another Papyrus database, if you do a Get Info on
any of them you will still see the database description for the database into which the reference
was originally entered or imported, rather than your own database’s description:

If you routinely share references with other Papyrus users, this means that you will always be
able to determine who originally provided a given reference.
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Import from Version 7—PAPX file

Version 7 of Papyrus comes with a predefined import/output format, PAPX, for transferring
references between databases. You can use this same format to transfer selected Version 7 refer-
ences to a Version 8 database.

First you must transfer the PAPX text file to your Macintosh. Then from the Papyrus-Papyrus
Transfer dialog click Import from Version 7 - PAPX file:

This dialog is quite similar to Papyrus’s usual Import dialog. The sections regarding the Log
and other files, Duplicate references, Keywords, and Reference numbering behave identi-
cally.

For some considerations regarding reference numbering and notecard numbering, see the
WORKBOOK chapter on Exchanging Data With Papyrus Version 7.

After you click Proceed Papyrus will ask you what you wish done with the three user-defined
fields from Version 7:
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For more details about this dialog, see Import—Advanced concerns, later in this chapter. For some
considerations specifically related to imports from Papyrus Version 7, see the WORKBOOK chap-
ter on Exchanging Data With Papyrus Version 7.

Finally, Papyrus will open its usual Import window, and proceed exactly as for any other im-
port.

During the import, Papyrus will automatically convert the incoming refer-
ences from their DOS ASCII character set used by Version 7 to the Macintosh
character set.
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Import from Version 7—*.BB files

Papyrus Version 7 includes a back-up function that writes out an entire database to a set of files
whose names all end in .BB. If you transfer this complete set of files to your Macintosh, you can
then import their contents into Papyrus Version 8.

From the Papyrus-Papyrus Transfer dialog, click Import from Version 7 - *.BB Files:

This dialog is quite similar to Papyrus’s usual Import dialog. The sections regarding Duplicate
references, Keywords, and Reference numbering behave identically.

For some considerations regarding reference numbering and notecard numbering, see the
WORKBOOK chapter on Exchanging Data With Papyrus Version 7.

After you click Proceed, the Transfer progress window will appear:

Papyrus will begin by importing all of the Version 7 keywords, and then all of the journals. The
biggest job is importing the “main” file, which includes the references and notecards (and also
glossary entries). Hooking everything up correctly involves three passes through the main files,
as indicated by the three divisions of the progress bar for Main. Finally the Version 7 formats
will be converted into Version 8 formats and transferred.



Chapter 26: Papyrus-Papyrus Transfer Dialog R259

C
O

N
C

E
P

T
S

R
E

F
E

R
E

N
C

E

During the import, Papyrus will automatically convert the incoming data
from their DOS ASCII character set to the Macintosh character set.

Once transferred, the Version 7 keywords, journals, references, etc. will be full-fledged Version
8 records. The only way to see that any of these originated in Version 7 is by doing a Get Info on
one of the transferred references or notecards:
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Import—Advanced concerns

Papyrus users can customize much of the structure of their databases, including adding new
fields and reference types, creating new systems of journal abbreviation, and new link types
for both references and keywords.

When you transfer data from one Papyrus database to another, the transfer document includes
all of this structure information. If the incoming database employs user-defined fields, for
example, not present in the recipient database, then Papyrus will offer to create corresponding
fields in the recipient database. Or you can choose to “map” the incoming data into your own
existing fields.

Here are the dialogs that will appear when the incoming data includes user customizations.

Reference Link Types

The first two link types, Reference/Notecard and Work reviewed/Review are built into Papyrus.
So these incoming link types will always be mapped to the same types in the recipient database.

In this case the incoming database includes a user-defined link type for references, Original
work/Follow-up work. Papyrus is suggesting that a new link type with the same names be cre-
ated in the recipient database. The only reason to change this would be if your database already
had your own user-defined link type that was equivalent to the incoming link type.
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Keyword Link Types

This dialog behaves just like the previous one. For keywords, there are four built-in link types.
The fifth incoming link type here has been defined by the user, and Papyrus is offering to create
a matching keyword link type in your recipient database.

Journal Abbreviation Styles

Apparently the creator of the incoming database has changed the name of the Standard abbre-
viation style to Index Medicus, and added a second style named Chem Abstracts.

Suppose that in your database you have never customized the journal abbreviation styles. There-
fore you have only a single style, named Standard. Furthermore, suppose that you have actually
been entering the journal abbreviations used by Chem Abstracts. You would now tell Papyrus
to map the incoming Chem Abstracts abbreviations to your Standard ones, and to make a new
abbreviation style to store the incoming Index Medicus abbreviations:



R262 Dialogs: Database Management

User-Defined Fields

Here the incoming database includes two user-defined fields. The first, Difficulty, is a Number
field. Since your database apparently does not yet contain any Number fields, Papyrus will
create a new Difficulty field in your database.

The second incoming field, Type of binding is a Free Text field. Since your database already
includes quite a few fields of this type, Papyrus gives you the option of moving the incoming
Type of binding information into any existing Free Text field:

So if you did not wish to create a new Type of binding field in your own database, you could tell
Papyrus to move that information to, say, your Comments field.
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User-Defined Reference Types

Here we see that the incoming database includes two user-defined reference types. Papyrus can
map these to any user-defined reference types in your own database:

If you do instruct Papyrus to map an incoming reference type to one of your own user-defined
reference types, then Papyrus will automatically add any necessary fields to your existing type
to accommodate the fields associated with the incoming reference type.

Papyrus remembers the mappings you have established for this transfer. If
at a future date you again import data from this same database, Papyrus’s
default mapping suggestions will be the mappings you used this time.
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Export for Version 7

Version 7 of Papyrus comes with a predefined import/output format, PAPX, for transferring
references between databases. You can use this same format to transfer Version 8 references to a
Version 7 database.

If you wish to export only selected references from your database, open the All References
window or a Group window and select the relevant references.

From the Papyrus-Papyrus Transfer dialog, click Export for Version 7. This dialog will result:

As you see, you can now export every reference in your database, just those contained in the
indicated Group, or just those selected in the indicated Group (or in the All References window).

When you click Proceed Papyrus will ask you to name the text document it is about to create.
Then it will write out your chosen references to this document, using the PAPX format. You can
then take the resulting document to the computer with Papyrus Version 7 and import its con-
tents into the Version 7 database there.

If your Version 8 references include information in fields that did not exist in Version 7, this
information will be moved to the Comments field.

If any of your Version 8 references are of a reference type that did not exist in Version 7, they will
be exported as type Other.

In creating the PAPX document, Papyrus will automatically convert your ref-
erences from the Macintosh character set to the DOS ASCII character set
used by Version 7.
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Export for Version 8

To export your entire database for importing into another Version 8 database, you need do
nothing. Your main database document can serve as the source for importing into the other
database. (See Import from Version 8 earlier in this chapter.)

If you wish to export only part of your database, including some or all of your references, and/
or your collections of keywords, journals, formats or glossary entries, then you will use the
function described here to create a new main database document that includes only these items.

For a complete summary of approaches to transferring information between Version 8
databases, see Exchanging Data With Another Papyrus Version 8 Database in the
WORKBOOK.

If you wish to export only selected references from your database, open the All References
window or a Group window and select the relevant references.

From the Papyrus-Papyrus Transfer dialog, click Export for Version 8. This dialog will result:

As you see, you can now export every reference in your database, just those contained in the
indicated Group, just those selected in the indicated Group (or in the All References window),
or none at all.

If you have links connecting these references to other references, you have the option of auto-
matically including all such linked items in your export. And, as usual with links, you can click
the Links... button to specify that only certain types of links should be followed.

Whether or not you include any references in your export, you also have the option of export-
ing your database’s entire collection of keywords, journals, formats, and/or glossary entries. If
you do not select these, Papyrus will still export any journals or keywords that are cited by the
references that are exported.
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When you export references, Papyrus automatically includes in the new database docu-
ment the definitions of any new fields or reference types  you have created. This will
allow the recipient database to correctly “understand” all of the incoming data.

When you click Proceed Papyrus will ask you to name the main database document it is about
to create. It will then proceed to export the relevant information to this document.

Since the result of this function is the creation of a new main database docu-
ment, you can also use this procedure to create a subset of your database as a
starting point for a colleague who doesn’t already have his or her own Papyrus
database.
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Introduction

The File menu’s Print/Export... function allows you to send lists of references, keywords, etc. to
your printer, your word processor, or your Web site.

The Print/Export dialog looks a bit different for outputting references vs. outputting other items,
so I’ll start by reviewing the differences, and subsequently describe the common elements.

See also:

WORKBOOK

Printing and Exporting Your References
Exchanging Data With Another Papyrus Version 7 Database
Exchanging Data With Another Papyrus Version 8 Database

CONCEPTS

Bibliographies vs. Footnote Lists

REFERENCE

Cross-reference List
Indexed List
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Printing References

When you choose Print/Export for the All References window or a Group window, here is the
resulting dialog:

You can also use Print/Export  with a Reference Entry window. In this case, of course,
there will be no questions about which references you wish to print.

You can choose to output all the references in the current Group (or the All References window),
or only the currently-selected ones.

In addition to the references you have just chosen to output, you can also include references
that are linked to those. For example, you might wish to include all Notecards linked to your
chosen references.

Clicking the Links... button allows you to restrict the additional references to only certain sorts
of links.
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When creating a bibliography for a manuscript in which the references are cited by author and
year, you will usually want Papyrus to add a letter after the year to distinguish two references
that share the same authors and year:

Flack,J (1998a) “My Deep Belief in More Taxes” - Political advertisement, June 4.

Flack,J (1998b) “My Deep Belief in Fewer Taxes” - Political advertisement, October 14.

On the other hand, if your reference list will not accompany a manuscript using author-year
citations, then you will probably prefer to omit these letters.

The same considerations apply when using a format that cites via the ID Field:

[Freud37a]  Freud,S. Sometimes a tapered ellipsoid is just a tapered ellipsoid. J. Psych.
Topology 9:23-9 (1937).

[Freud37b]  Freud,S. Influence of the id in mathematical proofs. Symbolic Illogic 25:192-
213 (1937).

When outputting references from a Group, you may or may not wish to include a heading with
information about the Group:

Important references
Recently-entered essential references
Sorted by Author, Year, Title, Page(s)
Using Format STANDARD
Last modified Monday, November 2, 1998, 3:40 PM
Contains 8 items

Usually you will want to omit this heading for actual bibliographies. But if, for example, you
perform several searches and wish to print the results, then including the heading will provide
a useful label for each reference list:

untitled 2
Author=Stein AND Year>97
Citation order
Using Format STANDARD
Currently loaded Search: Author=Stein AND Year>97
- run Monday, November 2, 1998, 3:42 PM
Last modified Monday, November 2, 1998, 3:42 PM
Contains 2 items
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To change the format that Papyrus will use for this print/export, click the Format... button.
Papyrus will then present a list of available output formats from which you can choose.

If your chosen format includes the Keywords, Comments, and/or Abstract fields, then these
checkboxes control whether Papyrus will output the entire contents of the field, or only its first
line or so. Specifically, if you choose to truncate one of these fields then only its first 70 charac-
ters will be displayed.

So if you wish to see all available information for your references, do not truncate any of these
fields. But if you only really care about the usual bibliographic details, then you can save space
by hiding all but the start of each of these often-lengthy fields.
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Printing Other Lists

When you choose Print/Export for the Keywords, Journals, Formats, Names, or Glossary
window, here is the resulting dialog:

You can choose to output all the items in the window, or only the currently-selected ones.

When outputting Journals, if your database includes more than one Journal Abbreviation Style
then this pop-up menu allows you to choose which style to use for the current list.
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Destination

There are four categories of available output destinations, some of them with subcategories:

This choice sends the list to your printer. You will usually want to use the Layout... button to set
the list’s font, margins, title, etc. before clicking OK.

This choice creates a text document, which can be opened by any word processor, e-mail pro-
gram, or other application that understands plain text.

Selecting Plain text results in a straightforward text file.

If you select HTML the resulting document will be a full-fledged Web page, ready to be viewed
with your Web browser or posted to your Web site. See Working with the Web in the WORKBOOK

section for more details.

If you select TeX then the document will use the control sequences of the TeX typesetting sys-
tem for italics, boldface, etc. See Using Papyrus with TeX, LaTeX, and BibTeX for more details.

This is the normal choice when you wish to send your list to your word processor. Papyrus will
create a new document, in either MacWrite or RTF format.

MacWrite was a word processor provided by Apple with the original Macintosh. For many
years, all other Macintosh word processors were expected to be able to read and write the
MacWrite file format. Most current word processors—but not all—can still open documents
created with the MacWrite format.

RTF stands for Rich Text Format, and was created many years ago by Microsoft as a would-be
standard format for exchanging data between word processors. For quite a few years no one
much cared about RTF. But now that Microsoft nearly owns the word processor market, its
competitors have been forced to acknowledge RTF. Just about all current word processors can
open documents created with the RTF format.



R274 Dialogs: Printing and Exporting

When you tell Papyrus to create a word processor document, you must also specify your usual
word processor:

Papyrus will make this application the “creator” of the new document. This means that if you
double-click the document, it will automatically be opened by your usual word processor.

We have included this more modern option for interactions between Papyrus and your word
processor. AppleScript is the Macintosh’s system of integrating all of your applications and
system components, allowing them to pass information back and forth in completely flexible
ways. For example, Papyrus can use the Apple-defined “word processor suite” of AppleScript
commands to communicate with any properly-designed word processor.

Unfortunately, there are no properly-designed word processors.

As I’ve explained in the WORKBOOK section’s Printing and Exporting chapter, Papyrus has built-in
AppleScripts for Microsoft Word (Version 6.0 or newer) and Nisus Writer (Version 5.0 or newer).
As of this writing, however, WordPerfect’s AppleScript interface contains too many bugs to
use, and AppleWorks (formerly ClarisWorks) has shockingly inadequate AppleScript support
for a product bearing the Apple trademark.

If the makers of word processors for the Macintosh ever correctly implement a generic word
processor AppleScript interface, then Papyrus will be ready to take advantage of it. In the mean-
time this option provides an alternative way to work with Microsoft Word and Nisus Writer.

As with the previous option, you must indicate your usual word processor to Papyrus:
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Layout

When you click the  button, this additional dialog appears:

You can set the title of your list to whatever you wish, such as References Cited, Bibliography,
etc.

For lists of keywords, journals, etc. you might use a title such as Papyrus Keywords or My Jour-
nals.

Most data entered into Papyrus uses a “font” called Base font. Here is where you pick the
actual font to substitute for Base font when creating this current list.

You can also set the font size for the list.
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Single-spacing (1) and double-spacing (2) are the most common choices.

If you wish to skip one or more extra lines between each item and the next, set this pop-up
menu to 1 or larger.

You can set the list’s margins in either inches or centimeters.

If you specify a header or a footer, these will be governed by your Left and Right margins, but
not the Top and Bottom margins. In other words, the header and footer will appear as near the
top and bottom of each page as your printer allows.

The three boxes across allow you to enter three parts of the header or footer: a left-justified
section, a centered section, and a right-justified section. The three buttons below the boxes
allow you to insert the indicated information: Current date, Current time, and Page #.

For example, entering this:

would result in a header like this:
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2nd draft - 1 - Tue, Nov 3, 1998

Headers and footers can include more than one line. As elsewhere in Papyrus, type Option-
Return to insert a line break within a field:

Tue, Nov 3, 1998
Susan’s article PAGE 1

If you include Page # within your header or footer, then here is where you set the number that
will be displayed for the first page of your list. If you are going to attach your list to an existing
manuscript, for example, you can use this feature to match the page numbers appropriately.

This checkbox lets you set things up so that you can print to index cards, for example, one
reference per card.

If your list is being sent to a plain text file, then selecting this option tells Papyrus to insert
“return” characters to break the file into lines no longer than indicated here.

One situation where you might use this feature is when you intend to copy and paste the list
into an e-mail message.

Be careful to turn this option off if you are using Print/Export to create a list of keywords,
journals, etc. that will subsequently be loaded into another Papyrus database. You don’t want
Papyrus to insert extraneous returns within a long keyword or journal name!
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CHAPTER 28

Cross-Reference List Dialog
Choosing Cross-Reference List... from the File menu lets you produce a list of references sorted
by Author, Year, Keyword, or any other indexed field in your database.

For some sample cross-reference lists, and how to create them, see Cross-Reference List in the
WORKBOOK section.

The Field pop-up menu is where you indicate which of Papyrus’s fields is to be cross-refer-
enced. The From and Through settings default to starting with the (alphabetically) first
occurrence of this field and proceeding through the final occurrence. If you wish to limit the list
to a more restricted alphabetic range of values, you may enter the limits here.

The Item sorting section controls the arrangement of each batch of references.

When you click OK, the usual Papyrus Print/Export dialog will open, allowing you to specify
the list destination and layout as usual.

See also:

WORKBOOK

Printing and Exporting Your References
Cross-Reference List

REFERENCE

Print/Export
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CHAPTER 29

List with Index Dialog
Selecting some references in a Group window or the All References window and then choosing
List with Index... from the File menu lets you output a list of those references, followed by an
index according to a chosen field.

For a sample indexed list, and how to create it, see List with Index in the WORKBOOK section.

The Field pop-up menu is where you indicate which of Papyrus’s fields is to be indexed. You
may select any Papyrus field.

The choice between Entire field and Individual words applies to free text and title fields.

The Index style lets you choose from three common arrangements of index items. The sample
display to the right will change to reflect your selection.

The buttons for Headings and Items allow you to specify font, font size, and character style
independently for the index headings and their values. You can also indicate the Punctuation
between each heading and its indexed items, and between each item and the next.

When you click OK, the usual Papyrus Print/Export dialog will open, allowing you to specify
the list destination and layout as usual.

• • •
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The final details of how the index items will appear is controlled by the format you specify for
the list. The index will refer to references by either Reference #, ID Field, or Name & Year, as
specified in the Sorting & Citing section of the format.

See also:

WORKBOOK

Printing and Exporting Your References
List with Index

REFERENCE

Print/Export
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CHAPTER 30

Find & Replace Text Dialog

Introduction ........................................................R284
Details ..................................................................R285
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Introduction

This function allows you to search some or all of your references for particular text occurring in
a specific field, and replace that text with something else.

Because you can limit this operation to a Group of references, you can easily restrict your re-
placements to a carefully chosen subset of your database.

For examples of the use of this function, see Globally Changing Information in the WORKBOOK

section.

See also:

WORKBOOK

Globally Changing Information

REFERENCE

Change Field



Chapter 30: Find & Replace Text Dialog R285

C
O

N
C

E
P

T
S

R
E

F
E

R
E

N
C

E

Details

If you wish to restrict this operation to a subset of your references, then either select these in the
All References window or in a Group window, or else create a Group containing the relevant
references.

When you choose Find & Replace Text... from the Edit menu, this dialog will appear:

Here you indicate which references are to be examined and possibly modified.

Use this pop-up menu to select any field in your database. This is the field in each reference that
Papyrus will examine and modify as needed.

Because Find & Replace Text  works on only one field at a time, if you need to find and
replace some text that might appear in any of several fields you will have to perform
several of these operations, one for each field.
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Here is where you type the text to be found.

Whole field—Selecting this box will restrict the search to only those references in which the
entire field is equal to the search text. For example, if you are looking for surgery, then this field
would not be affected:

A life without surgery is like a day without a poke from a sharp stick.

Whole word—Selecting this box will restrict the search to only those references in which the
search text appears as an entire word. For example, if you are looking for surgery, then the
above field would be affected, but the following field would not:

A novel form of neurosurgery.

Case sensitive—Selecting this box restricts the search to only those references in which the
search text appears in exactly the same case as you’ve typed. For example, if you are looking
for Surgery, then neither of the above fields would be considered a match.

Here is where you type the text that will replace the search text. If you enter nothing here, then
the search text will simply be deleted.
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Confirm each replacement—Selecting this box tells Papyrus to stop and show you each pro-
posed change before it is made. You can then elect to make the change, not make the change, or
abandon the entire operation:

Adopt target’s case—If you do not select this box, then Papyrus will simply insert the replace-
ment text exactly as you have typed it. But if you do select this option, then Papyrus will modify
the replacement text as it is inserted, to take on the same style of capitalization as the original
text.

Papyrus automatically recognizes and adopts these varieties of case:

• ALL UPPERCASE

• Headline Style Capitalization

• Sentence style capitalization

• all lowercase

• OtHer
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CHAPTER 31

Change Field Dialog

Introduction ........................................................R290
Details ..................................................................R291
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Introduction

This powerful function allows you to make several kinds of global changes to some or all of
your references. You can replace the entire contents of a specified field with some text, insert
that text at the start or end of the current contents of the field, or even erase the field. Or you can
move or copy the contents of one field to another field.

Because you can limit this operation to a Group of references, you can easily restrict your re-
placements to a carefully chosen subset of your database.

For examples of the use of this function, see Globally Changing Information in the WORKBOOK

section.

See also:

WORKBOOK

Globally Changing Information

REFERENCE

Find & Replace Text
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Details

If you wish to restrict this operation to a subset of your references, then either select these in the
All References window or in a Group window, or else create a Group containing the relevant
references.

When you choose Change Field... from the Edit menu, this dialog will appear:

Here you indicate which references are to be examined and possibly modified.

The text you enter here will be sent to the target field. If you leave this blank and then choose
Replace entire target field, the effect would be to erase the target field.
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To move the contents of one field to another, select this option. Use the pop-up menu to select
any of the fields in your database.

If you wish to move the field contents, then select Erase surce field to erase the original field.
But if you actually want to copy the field contents, without disturbing the original field, then do
not select this option.

Use the pop-up menu to select the target field. The three choices determine where the incoming
text is to be placed in the target field.
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Confirm each replacement—Selecting this box tells Papyrus to stop and show you each pro-
posed change before it is made. You can then elect to make the change, not make the change, or
abandon the entire operation:
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CHAPTER 32

Check Spelling Dialog
You can use certain third-party spellcheckers to check the spelling of selected fields in some or
all of your references.

Use Database Settings  to indicate to Papyrus your spellchecker (via Helper applica-
tions ) and which fields are to be spellchecked (via Fields & Reference Types ).

If you wish to restrict this operation to a subset of your references, then either select these in the
All References window or in a Group window, or else create a Group containing the relevant
references.

When you choose Change Reference Spelling... from the Edit menu, this dialog will appear:

After you make your selection and click Check, Papyrus will work with your spellchecker to
review the relevant references.

For examples of the use of this function, plus a discussion of other aspects of spellchecking in
Papyrus, see Spellchecking in the WORKBOOK section.

See also:

WORKBOOK

Spellchecking

Reference

Reference Entry Window
Database Settings
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CHAPTER 33

Find Dialog

Introduction ........................................................R298
Elements of the Find dialog ..............................R301
Entering your criteria ..........................................R303
Keyword Links .....................................................R305
Record Links ........................................................R307
Refining a search ...............................................R309
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Introduction

You use the Find dialog to search your Papyrus database for records meeting specific criteria.

Simple Searches

Often you will want to perform a search on only a single criterion. For example, you can find all
references by a particular author. Or you might wish to examine all recently entered references,
by searching for those with a Reference # greater than a particular value.

Complicated Searches

Papyrus also allows you to combine several criteria when you perform a search. For example,
you might have a vague memory of reading a particular article a few years ago, probably in one
of two particular journals. In this situation you could ask Papyrus to find all references in which
Type of Reference = Article AND Year > 1996 AND (Journal = New England Journal of Medicine
OR Journal = JAMA).

If your search includes one or more keywords in its criteria, then you can tell Papyrus to also
include any linked keywords. This way you can be sure to catch, for example, all relevant
synonyms or subcategories.

You can also instruct Papyrus to include any references linked to the references meeting your
criteria. For example, you might wish to review all notecards that are linked to the references
found.

Loading Your Search Results

When you tell Papyrus to proceed with your search, it will create a new, empty Group window
to hold the results. You can have Papyrus run the search in one of two ways:

Load results while searching—Each time Papyrus encounters a relevant record
it adds the successful match to the Group. This can be very convenient because
you can then examine the references found so far, even as Papyrus continues to
search for additional matches. However, it does take a few seconds to add each
reference to the Group, so your search will run a bit more slowly.

Do not load results while searching—Papyrus will not pause each time it finds
a relevant reference. The search will run to completion, and then Papyrus will
display a dialog showing how many successful matches have been found. From
this dialog you can tell Papyrus to go ahead and load all of those matches into
the Group—loading them all at once in this way is much quicker than loading
them one by one. Or if there are more matches than you expected, instead of
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loading them all you can have Papyrus refine your search with additional
criteria.

Refining Your Search

Sometimes your search results will differ from what you were hoping for. Perhaps you were
looking for a particular reference, but apparently you had misremembered the author. Or per-
haps you wanted to find a few key articles to review, but Papyrus has found several hundred
matches for your criteria.

You can refine your search in a couple of different ways. First, you can simply edit the criteria
you had entered and try again. Second, you can perform new searches based on different crite-
ria, and then combine the results of the various searches.

For example, suppose you wish to review the latest research on a particular vegetable. You ask
Papyrus to find all references with the keyword RUTABAGA. To your surprise, you discover
that you have five hundred references on this topic! So you next perform a search for references
with Year > 1995 AND Keyword = REVIEW. This search locates two hundred recent review
articles. Finally, you tell Papyrus to combine the two searches, resulting in just three recent
rutabaga reviews. Now you can have Papyrus load these three references into the Group and
proceed with your studies.
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See also:

WORKBOOK

Groups
Finding References

CONCEPTS

Keywords
Notecards and Linked References
Groups

REFERENCE

Group Window
Keyword Links Window
Reference Links Window

SHORTCUTS

Find Dialog
Refine Search Dialog
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Elements of the Find dialog

Field list

All of the fields available in your Papyrus database are listed here, including any custom fields
that you have defined.

The fields whose names are shown in bold are indexed, the others are not. Searches that involve
indexed fields will usually run much more rapidly, since Papyrus will be able to just scan through
the relevant part of its indexes rather than read through every record in the entire database.

Specifying Term tells Papyrus to simultaneously search the Title, Keywords, Abstract and Com-
ments fields. Since all of these fields are usually indexed, this will usually be a rapid search.
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Specifying General tells Papyrus to examine every field within a record. This will be relatively
time-consuming unless you narrow the search by also including an indexed field in your search
specification.

To quickly select a field you can simply type the first few letters of its name. For example,
typing ke will select Keyword.

Once the correct field has been selected, pressing Tab will move you to the Comparison list.

Comparison list

You will usually pick “=“. The other comparison types come in handy, for example, when you
wish to limit your search to references after a certain Year or Reference #.

Once the correct comparison has been selected, pressing Tab will move you to the search speci-
fication box.

Search Specification

This is where you build your search criteria. After you pick the field and comparison from their
respective lists, here you type in the corresponding value.

AND OR NOT ( )

You can use these buttons to combine multiple search conditions into a complicated search.

Follow keyword links

Check this box if you wish to search for not only the keywords you have typed in the search
specification, but also other keywords that are linked to those, such as synonyms or subcatego-
ries.

Include linked items

Check this box if you would like Papyrus to report not only those references that meet your
search criteria, but also other records that are linked to those, such as notecards.

Load results while searching

Check this box if you would like to examine the successful matches while Papyrus is still con-
tinuing to look for additional matching records.
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Entering your criteria

You build your search criteria in the search specification box. After you pick the field and
comparison from their respective lists, here you type in the relevant value.

For example, if you wished to find all records with the keyword wombat you would pick Key-
word from the field list, = from the comparison list, and then type wombat in the search
specification box.

These three pieces—field, comparison and value—together form a search condition. The sim-
plest (and most common) searches consist simply of a single search condition.

More complicated searches

Although in most cases you will find yourself performing simple searches, Papyrus also allows
you to set out more complex criteria.

Wildcards
You may include an asterisk (“*“) in a value as a “wildcard”. The asterisk will
match zero or more characters.

For example, if some of your references have the keyword wombat while oth-
ers use wombats, then you could type wombat* in your search specification to
find both of these simultaneously.

NOT
You can precede a search condition with NOT by moving the insertion point in
the search specification box to just in front of the condition’s field, and clicking
the NOT button. This tells Papyrus to look for all records that fail to match the
condition.

For example, the search NOT Term = thumb tells Papyrus to locate all refer-
ences that have nothing to do with opposable digits.

Recall that Term  will examine the Title , Keywords , Abstract  and Comments  fields. So
this search will exclude references with the word thumb  in any of these fields.

AND, OR
You can combine multiple search conditions with AND or OR by clicking either
of those buttons when the insertion point is positioned immediately after a
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value. It is important that you understand the difference between AND and
OR:

AND means that a successful match must satisfy both of the search conditions.
For example, Author=Smith AND Author=Jones will find only those references
that include both of these authors.

OR means that a successful match must satisfy either of the search conditions.
For example, Author=Smith OR Author=Jones will find any reference contain-
ing either one of these authors. (A reference with both authors will also be
considered a successful match.)

Parentheses
As you might imagine, if you start stringing together a lot of ANDs, ORs and
NOTs, things can get a tad confusing. For example, consider this search specifi-
cation:

NOT Author = Smith AND Year = 1997 OR Year = 1998

Is this supposed to mean “every reference from 1997 or 1998 that is not by
Smith”? Or “all references except those that Smith wrote in 1997 or 1998”? Or,
for that matter, “all 1997 references not by Smith, plus all 1998 references”?

To clarify, you should insert parentheses, using the ( and ) buttons.
In our example, to clearly indicate “every reference from 1997 or 1998 that is
not by Smith” we would specify:

( NOT Author = Smith ) AND ( Year = 1997 OR Year = 1998 )

In other words, a successful match must meet both of two conditions. First,
Smith is not one of its authors. Second, it is from either 1997 or 1998.
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Keyword Links

If you are doing a keyword search, you can tell Papyrus to also look for any keywords that are
linked to the keywords you have specified. When you select this option, Papyrus then asks a
few more questions:

How many levels:

Suppose that you have some keywords linked like this:

If your search specification is Keyword = MI, then without following any keyword links Papyrus
would find only the 35 references that bear that exact keyword.

If you set How many levels: to 1, then Papyrus will also search for any keyword that is directly
linked to MI. In this case that would be Myocardial infarction. (Note that Heart attack is not
directly linked to MI—even though it probably should be!) So in addition to the 35 references
bearing the keyword you have specified, Papyrus will also find the 71 other references that use
Myocardial infarction.

If you set How many levels: to 2, then Papyrus will also look for any keywords that are linked to
the directly-linked keywords. In this case that means the keywords linked to Myocardial infarc-
tion, namely Cardiac and Heart attack.

As you will see in a moment, you can restrict the types of links that Papyrus is to follow. For
example, you can limit the search to just Synonym links. In this case that would allow you to tell
Papyrus to follow 2 levels of links so that you catch all of MI‘s synonyms, without also includ-
ing the super-category Cardiac.
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Now suppose you wished to find all references having anything to do with cardiac disease. To
ensure that all relevant subcategories and synonyms are included you could set How many
levels: to, say, 100, and tell Papyrus to follow all links regardless of link type.

Links...

When you click this button, the following dialog appears:

If you wish to restrict the types of links to follow, click the Only these: button and then select the
desired types:
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Record Links

You can tell Papyrus to report not only those references that match your search criteria, but also
any records that are linked to those. When you select this option, Papyrus then asks a few more
questions:

How many levels:

Suppose that your database contains a review paper linked to three articles, like this:

In turn, the article by LaFièvre has its own links:

If your search specification were Author = LaFièvre AND Year = 1995, then without including
any linked items Papyrus would find only reference #3017.

If you set How many levels: to 1, then Papyrus will also include any reference that is directly
linked to reference #3017. In this case that would be #3018 and #3020.

If you set How many levels: to 2, then Papyrus will also include any references that are linked to
the directly-linked references. In this case that means the references linked to #3018 and #3020,
namely #3019, #2728 and #3021.

As you will see in a moment, you can restrict the types of links that Papyrus is to follow. For
example, you could limit the search to just Comment links. In this case that would allow you to
tell Papyrus to follow 2 levels of links so that you catch the entire high-minded scholarly ex-
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change between LaFièvre and Douser, without also including the review paper by Ralston or
the other articles that Ralston reviewed.

Now suppose you wished to find all references having anything to do with Ralston’s work. To
ensure that all relevant articles and critiques are included you could set How many levels: to,
say, 100, and tell Papyrus to include all linked references regardless of link type.

Links...

When you click this button, the following dialog appears:

If you wish to restrict the types of links to follow, click the Only these: button, and then select
the desired types:
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Refining a search

You can use this feature to narrow an overly-successful search, or to broaden an insufficiently-
successful one.

If you have just run a search in which you’ve told Papyrus to not load the results while search-
ing, then when the search is complete the Refine Search dialog will appear.

Otherwise you can bring up this dialog by choosing Refine Search... from the Group menu.

The search you have already run is labelled S1 (standing for “Search 1”). As you perform addi-
tional searches within this Group they will be listed as S2, S3, etc.

The simplest way to refine your search is to just make a change to the original search specifica-
tion and run it again. Click the Edit button to do this. The usual Find dialog will appear, allowing
you to amend your original search as you wish.

Alternatively, if you click the New button, the Find dialog will appear so that you can enter a
new search specification. After you run this new search, it will also appear in the Refine Search
dialog:
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You can then click New again to combine these searches:

You can repeat this process as many times as you wish:

When you are ready, you can then select any of these searches and click Load to bring its results
into the Group.
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Interrupting a Search

If you interrupt a search before it has run to completion, Papyrus will indicate this with a ques-
tion mark:

Should you wish to run that search again, select it and then click the Re-run button.

You can also use Re-run if changes have been made to your database since the last time you ran
a particular search.
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CHAPTER 34

Citing References

Introduction ........................................................R314
Placeholders .......................................................R315
Modifying placeholders ....................................R317
Cite dialog ..........................................................R321
Cite Settings dialog............................................R323
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Introduction

Papyrus provides a few different ways for you to insert a reference into your word processor
manuscript.

The basic approach is for you to insert a placeholder into the text of your manuscript at the
point you wish to refer to a particular reference. The placeholder indicates the reference’s
Reference # or ID Field. When your manuscript is ready, you will then use Papyrus’s Process
Manuscript function to convert these placeholders into the appropriate in-text citations, and
also to add a complete reference list to the end of your manuscript.

If you already know a reference’s Reference # or ID Field, you can simply type the placeholder
directly in your word processor. But in most cases you will first need to use Papyrus to locate
the reference. Once you have found the right reference, you then use Cite... from the Edit menu
to put the corresponding placeholder into the clipboard. Then you can hop back to your word
processor and do a paste to insert the placeholder into your text.

In most cases you can bypass Cite... by simply copying the reference in Papyrus. When you
switch to your word processor, Papyrus will automatically convert the contents of the clip-
board to the appropriate placeholder, ready to be pasted. And for those word processors that
support drag and drop, you can also drag a reference from Papyrus to your word processor.

Sometimes you may simply wish to place a formatted reference directly into your manuscript.
You can also use Cite... (or copy/paste, or drag/drop) to accomplish this.

The Cite Settings dialog controls whether it is a placeholder or a formatted reference that gets
inserted when you use copy/paste or drag/drop. This dialog is also where you indicate which
formats to use for formatted references, and some other citing details.

See also:

WORKBOOK

Preparing a Manuscript and its Bibliography Together
Specific Pages
Citing references together

REFERENCE

Process Manuscript

SHORTCUTS

Cite Dialog



Chapter 34: Citing References R315

C
O

N
C

E
P

T
S

R
E

F
E

R
E

N
C

E

Placeholders

A Papyrus placeholder indicates one or more Papyrus references by their Reference #s or ID
Fields. Some delimiter characters surround the placeholder so that Papyrus can find it later.

For example, the default settings for Cite... are to use [[ and ]] as delimiters, and to use Reference
# as the indicator, like this:

[[4342 (Pouch & Kang 1996)]]

In this example, the reference being cited is #4342, a 1996 article by Pouch and Kang.

This same placeholder could instead have been typed as:

[[4342]]

The information inside the parentheses (Pouch & Kang 1996) is of no concern to Papyrus. It is
only there to help you recall which reference #4342 was.

Multiple items within a single placeholder can be separated by any sort of punctuation—spaces,
commas, semicolons, etc. For example:

[[4342 (Pouch & Kang 1996); 4341 (Sawhney & Srivastava 1976)]]

or simply:

[[4342, 4341]]

You can also indicate a range of references:

[[4342-4347]]

ID Field vs. Reference #

Most Papyrus users will stick to using Reference #s in their placeholders. However, if you
routinely fill in your references’ ID Fields, then you might prefer to use that information in your
placeholders:

[[Pouch96 (Pouch & Kang 1996)]]

or simply:

[[Pouch96]]

As you can see, if you use a consistent method of assigning ID Fields to your references you will
later be able to directly type your placeholders without having to refer back to Papyrus each
time. (Of course, this approach does demand a certain level of compulsiveness on your part...)
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Additional text

In many cases you will need to include some additional text within a citation. For example:

...as we have seen (especially in Pouch and Kang 1996, but also in Sawhney and
Srivastava 1976)...

You can specify such text within your placeholder by using curly braces ({...}):

...as we have seen [[{especially in }4342{, but also in }4341]]...

Page numbers—Method 1

Usually you can use this same technique for citing particular pages within a work. For example,
to end up with:

...although there is some disagreement on this point (Rosarch 1993, p. 17)...

you would begin with:

...although there is some disagreement on this point [[2512{, p. 17}]]...

Page numbers—Method 2

Rarely, a particularly nasty bibliography style will demand that you include such specific pages
not within each citation, but instead in the final bibliography itself. With such styles, if else-
where in your manuscript you cite different pages from the same work, then there will be two
separate entries in the bibliography.

For example, such a style might result in your manuscript looking like this:

...although there is some disagreement on this point (Rosarch 1993a)...
Nevertheless, it has also been observed (Rosarch 1993b)...

In your bibliography there would then be two separate entries:

Rosarch, Roger. Life as We Know It. New York: Basic Books, 1993a, page 17.

Rosarch, Roger. Life as We Know It. New York: Basic Books, 1993b, pages 32-5.

To accomplish all this, you insert the letter P after the reference in your placeholder, followed
by the specific page numbers:

...although there is some disagreement on this point [2512p17]...
Nevertheless, it has also been observed [2512p32-5]...

or:

...although there is some disagreement on this point [2512 (Rosarch 1993) p17]...
Nevertheless, it has also been observed [2512 (Rosarch 1993) p32-5]...



Chapter 34: Citing References R317

C
O

N
C

E
P

T
S

R
E

F
E

R
E

N
C

E

Of course, the Papyrus output format you use for the bibliography must include the Specific
pages field in each of its templates so that these page numbers will actually appear in your
bibliography.

See also the WORKBOOK chapter Specific Pages.

Modifying placeholders

When you run the Papyrus Process Manuscript function, your placeholders will be converted
to whatever form is specified by the Papyrus output format you pick. For example, consider
this fragment from a manuscript:

While there is some controversy on this point [[263, 198]], most authors feel that the
traditional methods are still valid [[35, 514, 198]].

If the output format indicates that sequential citation numbers are to be used, this might be-
come:

While there is some controversy on this point,12,13 most authors feel that the traditional
methods are still valid.13-15

Many formats instead use the Name & Year style of citation:

While there is some controversy on this point (Jones 1989; Smith et al. 1986a), most
authors feel that the traditional methods are still valid (Rodgers and Hammerstein 1966;
Smith et al. 1986a, 1987).

Finally, fields such as mathematics and computer science often use the ID Field as the in-text
identifier:

While there is some controversy on this point [Jones89, Smith86a], most authors feel
that the traditional methods are still valid [Rodgers66, Smith86a, Smith87].

The overall form used, as well as details such as punctuation, are controlled by the Papyrus
output format you choose when you run Process Manuscript. However, you will sometimes
want to modify the appearance of an individual citation, particularly when using the Name &
Year form of citation. You can accomplish this by modifying the placeholder in any of a number
of ways.
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Citing only the year

Often you will wish to display only the citation’s year, because its authors have already been
mentioned in the text. For example:

...as Smith has pointed out (1982)...

To accomplish this, insert the letter y (or Y, if you prefer) immediately after the starting delim-
iter. This stands for year only. Thus, to generate the preceding line you would include in your
manuscript:

...as Smith has pointed out [[y 267]]...

This also works for multiple citations. This:

...as Smith has pointed out [[y 267, 14]]...

becomes:

...as Smith has pointed out (1975, 1982)...

Suppressing within-citation sorting

This is a modification that you will use much less often.

Within your output format you specify whether in-text citations are to be alphabetical (Jones
1985, Smith 1980, Zieve 1982) or chronological (Smith 1980, Zieve 1982, Jones 1985). Alter-
natively you can tell the format to suppress such automatic sorting, so that the citations will
always be left in whatever order they originally appeared within each placeholder in the manu-
script.

I imagine that there may be situations in which you mostly want alphabetic or chronologic
sorting, but for one particular citation you need some special order. (I can imagine such situa-
tions, but I can’t say that I’ve actually ever run into one.) Insert an S after the starting delimiter
to tell Papyrus to suppress sorting:

...as Smith has pointed out [[s 267, 14]]...

Note: You can even combine suppress sorting  with cite only the year :

[[ys 267, 14]]

But if you ever actually have reason to do this, please let me know. My imagination
doesn’t extend this far!
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Hiding the citation

Here’s a frill for which I can conceive no practical use. But you folks are always a step ahead of
me, so perhaps you’ll find it helpful someday. Let me know.

In addition to Y and S, you can insert a hyphen (-) after the starting delimiter. This means don’t
display this citation at all. For example, this:

...as Smith has pointed out [[- 267, 14]]...

would end up as:

...as Smith has pointed out...

Even though the citation has disappeared, the cited references will still appear in the final refer-
ence list.

And yes, for those of you who have a compulsion to take things to their limits, you can
combine - with Y or S, or even use all three at once. A moment’s reflection will demon-
strate the pointlessness of such an exercise, but Papyrus will humor you anyway.

Inserting a formatted reference

In some cases you will need to insert an actual reference into your manuscript, rather than just
a number or a name & year citation. This might arise, for example, within a footnote:

* For additional information on this topic, see S. Weaver, Wombats in the Mist (Los
Angeles: UCLA Press, 1987).

Of course, you could simply type or paste this reference into your manuscript in the first place.
But if you wish to remain flexible and not worry about the stylistic details until later, you can
insert a placeholder with an F, for formatted reference:

* For additional information on this topic, see [[f 382]].

When later you run Process Manuscript, you will tell Papyrus what format to use for such
entries. In fact, you will be able to specify two formats, one for the first time a particular refer-
ence is encountered, the other a shortened style for subsequent occurrences of the reference.

Note that Process Manuscript understands that the inserted formatted reference is not sup-
posed to be superscripted, or to be surrounded by parentheses or brackets, even though all
other citations are inserted using such a form.
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Inserting a plain citation

The output format you specify when you run Process Manuscript controls the overall appear-
ance of each citation—whether it should be superscripted or enclosed in parentheses or brackets.
Just as Papyrus will automatically ignore this overall style when inserting a formatted refer-
ence, you can tell Papyrus to ignore it for any individual citation. The magic letter is P, for plain
citation.

For example, while this:

...as others have pointed out [[4342]]...

results in:

...as others have pointed out (Pouch & Kang 1996)...

this:

...as others have pointed out, including the often-cited [[p 4342]]...

would result in:

...as others have pointed out, including the often-cited Pouch & Kang 1996...

This is another one of those frills that I can’t imagine many uses for, but which I’m sure some of
you will be able to use to your advantage someday.
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Cite dialog

When you have selected one or more references—whether in the All References window, a
Group window, a Reference Entry window, or a Links window—you can pick Cite... from the
Edit menu. This dialog will appear:

If you click OK, then the placeholder shown will become the contents of the Macintosh clip-
board, ready to be pasted into your word processor manuscript.

If you have already cited one reference and are now citing a second one, then you can choose to
append the new reference to the placeholder already in the clipboard:

You may repeat this process to cite as many references as you need within the placeholder.

Papyrus will automatically guess whether you wish to append  the new reference to the
placeholder already in the clipboard, or to replace  the old placeholder with a fresh one.
Its guess is based on whether you have left Papyrus to visit another program, such as
your word processor, since you last used Cite.

• • •
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Rather than a placeholder, you can tell Papyrus to place a formatted reference into the clip-
board. You have your choice of two formats, which you specify in the Cite Settings dialog.

Usually the first format will be one that includes all bibliographic information, as you would
use the first time you cite a particular reference:

The second format will typically be intended for subsequent citations to a work, and will there-
fore be relatively abbreviated:
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Cite Settings dialog

When you press the Settings... button in the Cite dialog, the following dialog will appear:

Placeholders

Here you indicate whether placeholders are to contain Reference #s or ID Fields. You can also
set the starting and ending delimiters to whatever character(s) you like.

Format 1 and Format 2

These are the two output formats that will be offered in the Cite dialog. Click the relevant
Change button to choose from any of the formats in your database.

Base font and size

When you insert a formatted reference into the clipboard, Papyrus will use these font settings.
They have no effect, however, on placeholders.

Some word processors, including Microsoft Word 5.x, will ignore this information when
you paste the formatted reference into a document. Still, I don’t imagine you need to
hear my personal opinions regarding Microsoft here...

Default form for Copy or Drag

Your choice here determines two things. First, when you bring up the Cite dialog, this will be
the preselected choice there. Second, when you bypass the Cite dialog by copying or dragging
a reference to your word processor, this setting will determine what arrives in the word proces-
sor.
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Convert copied references to Cite form on exit, even if more than 3

This setting comes into play after you have copied one or more references. It is irrelevant if you
have used the Cite dialog to cite one or more references as placeholders or formatted citations.

When you switch from Papyrus to another application, Papyrus will automatically convert any
references currently in the clipboard to their equivalent placeholders or formatted forms, as
determined by the Default form for Copy or Drag setting. But sometimes there will be many
references in the clipboard, because you have recently copied a batch of references from one
Papyrus window and pasted them to another. You don’t actually want to paste these into your
word processor, but in its helpful ignorance Papyrus will still spend several annoying seconds
converting them all when you try to switch applications.

Clicking this box tells Papyrus to not bother with its automatic conversion when the clipboard
holds more than three references.
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Introduction

You use the Import dialog to have Papyrus read in references from a text file. The text file might
have come from an online or CD-ROM database, such as Medline, Silver Platter, or Ovid, or it
might have been produced by another personal bibliographic program. Or the file might repre-
sent a bibliography that you had previously typed in your word processor.

Papyrus uses an import format to decipher the incoming references. Papyrus comes with nu-
merous predefined import formats for many popular sources. You can also set up your own
import formats at any time.

Papyrus produces a few new files when you perform an import:

Log file:
As the import runs, Papyrus will keep a record in the log file of any concerns
that arise. For example, warnings about possible duplicate references, possible
mis-capitalized names, etc. The log file will be displayed in its own window as
the import proceeds. You can also examine this file later, either in Papyrus or in
your word processor.

Reject file:
Any references that Papyrus cannot decipher will be copied to the reject file.
You can later examine this file, using either Papyrus or your word processor, to
review these rejected references.

If you are developing your own import format, then after reviewing the reject
file you can make appropriate improvements to your format and try re-im-
porting the reject file.

Downloads from many online or CD-ROM databases will include extraneous
information such as heading information, search strategies, and so on. Papyrus
will consider these things to be uninterpretable references, and therefore send
them to the reject file.

Duplicates file:
Papyrus will compare incoming references to those already in your database.
If you so chose, those references that Papyrus considers duplicates will be cop-
ied to the duplicates file. Later you can review this file, using Papyrus or your
word processor, to double-check Papyrus’s accuracy.
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See also:

WORKBOOK

Importing—Overview
Importing—Predefined, Straightforward
Importing—Predefined, Complicated
Importing—Word Processor Bibliography
Importing—Other Structured Databases

REFERENCE

Formats Window
Format Entry
Sorting & Citing
Numbering & Layout
Authors/Editors Format
Template Entry
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Set-up dialog

Click any of these buttons...

...to set the import format...to set the corresponding file

Click this button...

Click this 
button...

...to specify 
keywords
to add to each 
incoming 
reference

File to import

Click the  button to indicate a different file than the one shown here.

Log file
Reject file
Duplicates file

Papyrus will automatically suggest a name for each of these files based on the name of the file
being imported. If you’d like to set a different name, click the corresponding  button.

Using Format

Click the  button to indicate which import format Papyrus is to use for this import. You
can choose from any of the import formats currently in your database.
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Mac - DOS - TeX

Text files prepared on or for a Macintosh differ from those prepared on or for a DOS/Windows
computer. In addition to different encodings for accented letters and other “extended” charac-
ters, different codes are even used to indicate the end of a line. (Nevertheless, both types of file
are often referred to as “ASCII” files.)

Use these buttons to indicate whether the incoming file is a Macintosh text file or a DOS text
file.

The TeX option applies to incoming files prepared for the TeX typesetting system . If
you don’t know what that is, then don’t worry about this button.

Duplicate references

If Papyrus suspects that an incoming reference is a duplicate of a reference already in your
database, then your choice here will control what Papyrus does about the situation:

Automatically skip
Papyrus will copy the incoming reference o the reject file. The reference will
not be added to your database.

Pause to decide
Papyrus will pause its import process, and present you with a dialog window
that shows both the incoming reference and the existing reference, so that you
can decide how Papyrus should proceed.

Save anyhow
Papyrus will add the incoming reference to your database, in addition to the
existing reference.

Merge incoming reference with existing reference
Papyrus will combine the two references, adding any new incoming informa-
tion to the reference already in your database.

Save incoming reference, delete existing reference
Papyrus will add the incoming reference to your database, while deleting the
existing reference from your database. This might come in handy if you know
that your current import source is more reliable or accurate than a different
source you have used in the past.

Any references previously linked  to the existing reference will be re-linked to the new
incoming reference.

If you select this choice, then an additional checkbox will appear:
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Clicking this checkbox tells Papyrus to reassign the Reference # of the existing reference to the
incoming reference.

Fussiness Level

Papyrus has a few dozen built-in “rules” that it uses to help interpret the incoming information.
For example, one rule states that a Year should be a four-digit number. Another rule states that
a City should not contain any digits.

At the Finicky setting, Papyrus applies all of its rules. At Tolerant some of the more picky rules
are ignored. And at Oblivious Papyrus will accept almost anything in any field.

For most imports from online or CD-ROM bibliographic sources, Tolerant is the best setting.
Finicky is often best when importing a word-processed bibliography, in which the separation of
one field from the next is not always obvious or unambiguous.

Each import format specifies a default Fussiness Level. When you select the format for your
import, that format’s default Fussiness Level will automatically be suggested.

Keywords to add

If you would like to add one or more keywords to each of the incoming references, click the
 button. Papyrus will then present you with its Keywords window, where you can pick

the relevant keywords.

Retain incoming keywords

If the incoming references include keywords or subject headings, you can indicate here whether
you wish to keep these keywords as the references are imported.

De-capitalize incoming keywords

If the keywords in the incoming file are presented in ALL UPPERCASE LETTERS, then clicking
this box tells Papyrus to convert all but the initial letter to lowercase.

Starting number for incoming references

As Papyrus imports each incoming reference, it must assign the reference a Papyrus Reference
#. You can indicate here the starting point for these numbers.
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Retain incoming reference numbers

If the incoming references are already numbered, and if your chosen import format defines
where these numbers appear in each reference, then you can use this checkbox to tell Papyrus
to keep the incoming number as the Papyrus Reference #.

Create a Group of the imported items

If you check this box, then as the import proceeds Papyrus will add each imported reference to
a Group window. You can then examine or otherwise use the new references even as the import
is still under way.
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Import window

You can switch the Import window back and forth between two views: collapsed and expanded.

Collapsed view:

Your import will run faster if you stick to the collapsed view. The improvement comes from
avoiding the time your computer needs to format and display the text of the incoming refer-
ence. (To see the maximum speed increase you must also close the Import Log window.)

Click this button to 
toggle the window 
between its collapsed 
and expanded views

Expanded view:

The expanded view displays the incoming reference that Papyrus is currently examining. In
this view you can also intervene in the import, or watch the details of Papyrus’s “thought”
process.

Click this button to 
abort the import

This progress bar 
indicates how much of 
the incoming file has 
been read so far

Check this box 
to watch 
Papyrus “think”

The incoming 
reference that 
Papyrus is 
currently 
pondering

Click this button to 
ignore the reference 
shown, and proceed 
to the next

The reference type 
menu indicates which 
type Papyrus is 
currently considering

Click this button to 
temporarily freeze 
the import
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Import status

Processed
This number indicates how many “references” Papyrus thinks it has encoun-
tered so far. Note that any text separated by one or more blank lines from the
next bit of next counts as a “reference” here, even if it was really only a heading
or other effluvium.

Successful
This is the number of references that Papyrus has succeeded in matching to the
import format.

Skipped/Merged duplicates
This number indicates those successfully-matched references that turned out
to be duplicates of existing entries, and were therefore not saved in your data-
base as new references.

Warnings
This number refers to the warning messages sent to the log file. Usually most
of these warnings are quite benign. For example, each time Papyrus encoun-
ters a journal or keyword that it does not recognize, it warns you that that
entry is being added to the Journal or Keyword dictionary.

Show cogitation
Checking this box takes you into “debugging” mode, where you can watch in
great detail as Papyrus tries to match the incoming reference to your import
format. This comes in handy when you are trying to get a new import format
to work correctly.

Reference type menu
In attempting to understand the incoming reference, Papyrus applies in turn
each of the reference type templates defined in your import format, until it
finds a match. This menu indicates the template with which Papyrus is cur-
rently working.

If you can see that Papyrus is wasting its time on the wrong template, you can
use this menu to move Papyrus along to the correct template. For example, if
you recognize the incoming reference as a book chapter, but Papyrus is spend-
ing a lot of time trying to match it to the Article in journal template, then you
can set this menu to Chapter in book to help Papyrus get to the correct tem-
plate.

In practice you will seldom need to touch this menu, since for most import
formats Papyrus will quickly disqualify irrelevant templates.
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Debugging

When you check the Show cogitation box, the Import window switches into “debugging” mode.
The top part of the window shows the format template that Papyrus is currently trying to match
to the incoming reference. As it proceeds through the template, Papyrus highlights the part of
the template and the matching part of the incoming reference that it is evaluating. When there
is a tentative match, Papyrus colors the corresponding parts of the template and incoming
reference to so indicate.

Fields in the format 
are colored the same 
as the part of the 
incoming reference 
that Papyrus 
currently thinks they 
match

The highlight 
indicates which parts 
of the format and 
incoming reference 
Papyrus is currently 
trying to match

Papyrus describes its 
progress as it studies 
the incoming reference

Delay factor

When the Import window is in this debugging mode, Papyrus pauses briefly after each step
through the template. The higher you set the delay factor, the longer these pauses will be,
giving you time to watch the details of the import process.

You may increase or decrease the delay factor by clicking the little arrows. Or you can use the ↑
and ↓ keys on your keyboard.

Pause button

If you click  the import will halt and the button will change to . Pressing

 will restart the import.

This comes in handy when you want to compare the format template and the incoming refer-
ence at your leisure.
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Progress indicator

As Papyrus examines the incoming reference, it moves through five phases:

Scanning for required text...
Papyrus checks that any required literal text is present. For example, if the
template includes the text Journal Article, and this text does not appear within
brackets to indicate that it is optional, then the incoming reference must in-
clude the same text.

Parsing...
The Parsing phase is the heart of the import process. Papyrus moves back and
forth through the template, matching each field to a section of the incoming
reference.

Previewing field contents...
This is the phase during which Papyrus applies many of its built-in rules to
check each field for reasonableness. If it finds a problem, you will see a mes-
sage such as:

Field starts with unusual punctuation

Unbalanced quotes

Year is non-numeric

Volume contains “Num.”, “Part”, or “Suppl.”

Upon encountering a problem, Papyrus will return to the Parsing phase to at-
tempt to find a different way of matching the incoming reference to the template.

Checking Names...
Once all of the other fields have been checked, Papyrus spends a considerable
amount of effort in reviewing author and editor names. It applies several built-
in rules to do the best possible job of correctly interpreting variations such as
Jr., Anonymous, etc.

Checking field contents...
Now that the individual fields have all been checked, Papyrus applies a final
set of rules to groups of fields and to the reference as a whole. If everything
looks okay during this phase then Papyrus considers the incoming reference
successfully matched.
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CHAPTER 36

Duplicates

Introduction ........................................................R338
Setup Dialog .......................................................R338
Progress window ................................................R339
Possible Duplicate Dialog .................................R340
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Introduction

This function hunts for and eliminates duplicate references in your database. You can have
Papyrus do this completely automatically, but you will usually want to supervise the process
yourself.

Setup Dialog

When you choose Duplicates... from the Reference menu, this dialog appears:

Criteria

The TIGHT criteria are usually best. Even with this setting, Papyrus is relatively intelligent
about noticing possible variations in author names—such as Smith,J.P. vs. Smith,John, or such
as one reference with et al. and another without.

Action

Automatically merge
If you do decide to run this function without supervision, this is the safest
choice. When Papyrus encounters two references that it suspects are dupli-
cates, it will combine the two references into one.

Pause to decide
When Papyrus finds two references suspiciously similar, it will pause and dis-
play them both in a special window (see below). Then you can compare them
for yourself and decide to merge them together, delete one, or leave both as is.
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Automatically delete newer item
Automatically delete older item

In some cases you will know that references entered into your database earlier
are more reliable—or less reliable—than more recently entered references. For
example, you may have recently imported a batch of references from a col-
league. If any of these represents the same citation as one already in your
database, you might wish to automatically throw away the new one, since you
have already proofread your older entries.

On the other hand, perhaps you previously imported a batch of references from
one online database, but have now located a better source—one with fewer
typographical errors, say, or with more complete abstracts. In this situation
you might ask Papyrus to automatically discard the old references in favor of
the newer ones.

Start checking at surname

When you click Proceed, Papyrus will check through your database in alphabetic order. If you
leave this box empty, Papyrus will start with the very first entry. But if you have recently run
this function part way through your database, you can now restart it midway by specifying the
starting point here.

Progress window

As the duplicate-checking proceeds, this dialog shows your progress:

The Action and Criteria are both indicated, as well as a numeric summary of how many refer-
ences have been examined so far, how many Papyrus suspected of being duplicates of other
references, and how many have been deleted or merged.

If you wish to halt the operation before it is finished, click Stop.

As with all time-consuming operations, Papyrus monitors other activity on your computer as it
proceeds. If you are working in other windows or applications, then this operation will take
control of your computer for a smaller slice of each second. Still, in some situations you might
be inconvenienced by the duplicate-checking slowing your work; if this occurs click Pause—
Papyrus will suspend its checking until you tell it to resume.
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Possible Duplicate Dialog

When Papyrus finds a pair of possible duplicates, if you have chosen Pause to decide then this
window will appear:

Here you can compare the two references for yourself. In this case we see that they do indeed
both represent the same book, though the Author has been entered differently. The first refer-
ence indicates a second Publisher and City. Finally, the two reference include different Comments.

Clicking Stop would abort the entire duplicate-checking operation. The two Delete buttons
allow you to discard either entry from your database, retaining the other without change. Keep
both retains both references without change.

If you click Merge, then Papyrus will combine the two references. Some fields—such as the
Author, Publisher, and City—it can handle automatically. For other fields it will ask you your
preference:
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can ask Papyrus to combine both.

In this case the result of combining the Comments and allowing Papyrus to automatically merge
the other fields would result in:

4. Dichter,Stanley N (1968): Valid and Invalid Generalizations in Psychiatry. 2nd. ed.
Persimmon Press, New York; Acerbic Press, Inc., London.
<<More of a coffee-table book than a serious academic study. One of my favorite
books.>>
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CHAPTER 37

Process Manuscript

Introduction ........................................................R344
Preparing your manuscript ...............................R345
Elements of the Process Manuscript dialog ....R345
Details of operation ...........................................R349
Including informational notes...........................R351
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Introduction

As you prepare a manuscript in your word processor, you can sprinkle throughout it Papyrus
placeholders corresponding to the references you wish to cite. Papyrus’s Cite... dialog offers
several options to help you insert these placeholders.

Once your manuscript is ready, you use Process Manuscript... from the Group menu to tell
Papyrus to scan your manuscript. Papyrus will automatically create a fresh copy of your manu-
script in which each of the placeholders has been replaced by the in-text citation form appropriate
to your needs—superscripted number, parenthesized author and year, etc.

In accomplishing this, Papyrus will simultaneously fill in a Group with the references you have
cited. This can be a brand-new Group, or you can re-use an existing Group.

If you like, Papyrus can automatically generate the corresponding bibliography and append it
to the end of your manuscript as part of the Process Manuscript operation. Or, since you will
now have a Group of the relevant references, you can print out the bibliography at any time.

If you need to make changes to your manuscript, you will do so in the original copy with the
placeholders. Then you will run Process Manuscript again to generate an up-to-date final docu-
ment. While you go through this revision process you can keep re-using the same Group—the
Group remembers all of your Process Manuscript settings from one run to the next.

When you are faced with the occasional oddball journal that expects you to include informa-
tional notes in your bibliography along with your references (Science comes to mind here), you
can use notecards to automate the process. See Including informational notes.

See also:

WORKBOOK

Printing and Exporting Your References
Preparing a Manuscript and its Bibliography Together
Specific Pages
Citing references together

CONCEPTS

Bibliographies vs. Footnote Lists
Output Formats
Bibliographic Conventions

REFERENCE

Citing references
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Preparing your manuscript

At each spot in your manuscript where you wish to cite a reference you will insert a place-
holder. For example:

...Although most marsupials radiate only small amounts of ultraviolet energy
[[4342 (Pouch & Kang 1996)]], the so-called “day-glo wombat” is a horse of a different
color...

In this example, the reference being cited is #4342, a 1996 article by Pouch and Kang.

Papyrus provides several ways for you to insert these placeholders, including the ability to
simply drag the relevant reference from any Papyrus window directly to your word processor.

There also several ways in which you can modify a placeholder to cope with special situations.

For all of the little details about placeholders, see the discussion of the Cite dialog.

Elements of the Process Manuscript dialog

When you choose Process Manuscript... from the Group menu, this dialog appears:

If the frontmost window was a Group window then the dialog will already be filled in, based
on the last Process Manuscript run for this particular Group.
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Original document

This is your word processor manuscript in which you have scattered reference placeholders.
Click the Change button if you wish to pick a difference document.

New document

This is the name Papyrus will give to the new version of your manuscript that it is about to
create. The default supplied by Papyrus is simply the name of your original document, plus
.new. You can click the Change button if you would prefer a different name.

File type

Papyrus will automatically display the file type of the original document you have specified:

Of course, there are many file types that Papyrus cannot recognize. There are word processors
that Papyrus does not yet support, and of course there are documents from many, many appli-
cations that are not word processors. So this:

means that Papyrus will not be able to process the document you have specified.

Text documents are a special case:

Choosing Plain text tells Papyrus to interpret the file as simply a plain Macintosh ASCII text file.

Choosing RTF tells Papyrus to interpret the file as a Microsoft “Rich Text Format” file. Several
word processors can save their documents using this format, in which special sequences of
characters indicate formatting instructions rather than actual text.

Choosing TeX/LaTeX tells Papyrus to treat the file as one created using the TEX formatting
system. This is another file format in which special character sequences describe the intended
appearance of the text. It tends to be used by mathematicians and scientists who are particu-
larly attentive to the attractiveness of their publications.
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Master format

This is where you choose the output format that is to apply to your new manuscript. The output
format controls not only the appearance of the bibliography itself, but also of all the in-text
citations.

Initial footnote format
Subsequent footnote format

If your manuscript contains any placeholders that are to be converted into formatted citations,
then these are the two formats Papyrus will use for them. The initial format will be used for the
first occurrence of any particular reference, while the subsequent format will be used if the
same reference is cited again later in the manuscript.

Placeholders

As described elsewhere, while most Papyrus users will use Reference # placeholders, a few
might prefer to instead include ID Fields within their placeholders. This is where you tell Papyrus
which to be looking for.

You must also inform Papyrus if you have used placeholder delimiters other than the default [[
and ]].

Multiple references per single citation

This option pertains to certain publications in fields such as chemistry or physics, and for cer-
tain crowded journals such as Science. To save space in these publications, when several references
are cited at a single point in the manuscript they are combined into a single item in the bibliog-
raphy:

...but completely contradictory results have also been shown.12

12. M. A. Spoon, Cancer Res. 31, 4819 (1987); L. U. Wartsburg, Cell 82, 234 (1990); A.
Cramer, CA Cancer J. Clin. 47, 15 (1997).

If one of these same references gets cited at another point in the manuscript, though, things
start to get complicated. Papyrus handles such situations automatically. (See the WORKBOOK

chapter Citing references together.)

Insert bibliography

Here you indicate whether or not Papyrus should automatically insert the final bibliography
into your manuscript. In most cases you will want the bibliography to be appended to the very
end of your document, so the At end choice will be most appropriate.
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But sometimes there are other materials that will come after the bibliography. These might
include illustrations, acknowledgements, or any of the various effluvia required in grant appli-
cations. In such cases you can type a marker in your word processor document at the spot
where you wish the bibliography to be inserted. Then here you pick At marker, and fill in the
marker text so that Papyrus can locate precisely this marker in your manuscript, and replace it
with the bibliography:

Layout...

Clicking this button brings up another dialog:

Here you can set the bibliography’s title, if any, such as References cited or Bibliography or
Recommended Reading. If you wish you can use the Font menu to choose a special font for
the title—although in almost all cases you will want to stick with BASE FONT so that the title
will use the manuscript’s current font. You can also use the Style menu to set the title to bold-
face, italic, etc.

The two pop-up menus control the line spacing of the bibliography (1 = single-spacing, 2 =
double-spacing, etc.) and the number of lines to skip between each reference and the next (0 =
do not skip lines, 1 = skip one line, etc.).
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Details of operation

After you click the Proceed button, Papyrus runs through a series of steps:

Clear the Group?

If your Group already contains any references (perhaps from the last time you ran the Process
Manuscript function), Papyrus will ask:

In general you do wish to start with a cleared Group. Papyrus will then fill in the Group with
precisely the references cited in your manuscript.

Here is one complicated situation where you might choose to retain the current contents
of the Group. Suppose that you have 10 separate word processor documents, each
corresponding to one of the 10 chapters in your upcoming book. You want one master
bibliography at the end of the book, in alphabetic order, and you are going to cite the
references in the text via sequential numbers.

In order to build the master bibliography you can do 10 Process Manuscripts all using
the same Group, not clearing the contents of the Group each time. The Group will thus
accumulate all of the references cited in all of the chapters.

However, at this point the new versions of the individual chapter manuscripts will not
contain the correct sequential numbers for their reference citations, since Papyrus was
working from only a partial list of references at the time each Process Manuscript was
performed. So now you can go back and repeat all 10 Process Manuscripts, still not
clearing the Group. This time Papyrus will be working from the total reference list, so the
sequential numbers inserted into the manuscript documents will now reflect the com-
plete master reference list.

Launching your word processor

For manuscripts from some word processors, Papyrus simply reads the original document and
prepares a new one. But for documents from other word processors—including Nisus Writer
and Microsoft Word 6 or 98—Papyrus actually uses your word processor as a tool to carry out
the necessary replacements.

If your document is from one of these latter word processors, then you will next see:
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Once the word processor has been successfully launched, Papyrus will warn you to keep out of
the way:

Papyrus uses AppleScript to communicate with your word processor. Since absolutely
none of the major word processors correctly supports AppleScript and Apple Events,
the necessary work-arounds will result in a mildly-entertaining show for you as you
watch Papyrus tell your word processor to search and replace one bit of text after an-
other.

Processing your manuscript

As Papyrus proceeds through your manuscript, assembling the Group and replacing your place-
holders in the text, it displays its progress:

If you have instructed Papyrus to insert the final bibliography into your manuscript, then at the
completion of the “Processing” phase Papyrus will proceed to “Printing” the bibliography:

In this case, the term “Printing” really refers to inserting the bibliography into your new word
processor document.
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Including informational notes

Almost all editors expect your bibliography to contain nothing but a list of references. Informa-
tional notes are usually given as footnotes, or in a separate “Notes” listing.

Still, there are a few publications that expect you to mix your notes in with your references. You
can automate this in Papyrus by entering each informational note as a Papyrus notecard. Within
your manuscript, you then insert a placeholder for the notecard just as you would for any other
reference.

For example, your manuscript might include this section:

Although others have arrived at different conclusions [[305 (Slouch et al. 1997), 372
(Messing 1996)]], we believe this discrepancy can largely be explained by our insis-
tence on using only the highest-quality laboratory equipment [[492 (Nothing but the
best)]].

Meanwhile, reference #492 might be:
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The resulting text and bibliography would then include:

Although others have arrived at different conclusions,11,12 we believe this discrepancy
can largely be explained by our insistence on using only the highest-quality laboratory
equipment.13

11. A. Slouch et al., Alien Genet. 13, 175 (1997).

12. H. Messing, Kitch. Chem. 22, 299 (1996).

13. We have consistently achieved the best results by restricting ourselves to beakers
and crucibles by Wedgewood. Recent experiments with flasks made to our specifi-
cations by Chihuly have been inconclusive, though attractive.

There is one additional detail you must ensure for this approach to succeed. The output format
you specify for your bibliography must include a template for notecards. This template should
include simply the Comments field:
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CHAPTER 38

Format Entry Dialog
When you click either the New... or Edit... button in the Formats window, the Format entry
dialog appears:

This dialog is where you provide the format’s name, description and type—Output, Tabular
output, or Import.

For an import format you also indicate the Fussiness Level and any plug-in filters:

For plug-in filters, enter the name of the filter as given in the Papyrus Additions folder. If you
need to specify more than one filter, separate their names with a comma. During an import
using this format, Papyrus will apply the filters in the order you have listed their names.
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To edit any of the several parts of the format, double-click it in the list:

You can also use your arrow keys to select the relevant section, and then press Return to edit it.

The first four choices, Sorting & Citing, Numbering & Layout, Authors, and Editors each
result in a special dialog. The remaining choices define the templates for each reference type in
your database. You will almost always wish to complete all of the first four parts of a format,
but when working on the templates you can ignore any reference type that is not used in your
database.

Sorting & Citing applies only to output formats and—as illustrated above in the Medline for-
mat—is not available for import formats.
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See also:

WORKBOOK

Creating New Output Formats
Formats, Format Libraries and Predefined Formats
Importing—Overview
Importing—Predefined, Straightforward
Importing—Predefined, Complicated
Importing—Word Processor Bibliography
Importing—Other Structured Databases

CONCEPTS

Bibliographies vs. Footnote Lists
Output Formats
Bibliographic Conventions

REFERENCE

Sorting & Citing
Numbering & Layout
Authors/Editors Format
Template Entry
Plug-in Filters
Shortcuts
Format Entry Dialog
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CHAPTER 39

Sorting & Citing Dialog

Introduction ........................................................R358
Main settings .......................................................R360
One or two authors ............................................R363
Several authors ...................................................R364
Multiple citations ................................................R365
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Introduction

When you choose Sorting & Citing in the Format Entry dialog, this dialog appears:

This section of an output format defines how references are to be sorted in the bibliography—in
citation order, in alphabetic order, or by ID Field. It then indicates how references are to be
cited in the body of your manuscripts—by sequential number, name & year, or ID Field. Fi-
nally, there are several settings to define the detailed appearance of the in-text citations.

Different parts of this dialog apply to different sorts of formats. For example, if a format indi-
cates that references are to be listed in citation order then the sections regarding multiple authors
or citations will be irrelevant. On the other hand, only if references are to be cited by sequential
number will the settings for Space after comma and Abbreviate “4,5,6” to “4-6” matter.

In the upper right of the dialog is a dynamic preview showing some in-text citations as defined
by your current settings.

There are four “panels” in this dialog: Main settings, One or two authors, Several authors, and
Multiple citations. You switch among these four panels by clicking the buttons at the top of the
dialog.

Shortcut: Press �  -Tab or Shift- �  -Tab to switch among the panels.
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See also:

WORKBOOK

Creating New Output Formats
Formats, Format Libraries and Predefined Formats
Importing—Overview
Importing—Predefined, Straightforward
Importing—Predefined, Complicated
Importing—Word Processor Bibliography
Importing—Other Structured Databases

CONCEPTS

Bibliographies vs. Footnote Lists
Output Formats
Bibliographic Conventions

REFERENCE

Format Entry
Numbering & Layout
Authors/Editors Format
Template Entry
Plug-in Filters
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Main settings

Method

This section determines how the bibliography is sorted, and how in-text citations should ap-
pear:

Citation order, cite by Number
References will appear in the bibliography in the order they are cited in the
manuscript. The in-text citation for the first reference will be 1, the next 2, etc.

Alphabetic order, cite by Number
References in the bibliography will be alphabetized by their author(s). If two
references share exactly the same authors, they will be further sorted by year. If
both authors and year are identical, then the references will be further sorted
by their titles.

Once alphabetized, the references in the bibliography will be numbered se-
quentially. These numbers will then be used for in-text citations.

Alphabetic order, cite by Name & Year
References in the bibliography will be alphabetized by their author(s). If two
references share exactly the same authors, they will be further sorted by year. If
both authors and year are identical, then the references will be further sorted
by their titles.
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If two references have identical authors and years, Papyrus will automatically
add distinguishing letters to their years; e.g., 1995a and 1995b.

When outputting a reference list you can override this automatic feature, if necessary.

In-text citations will indicate the first few authors and the year, as in (Smith,
1999). There are many details to set, including punctuation and the use of et al.

Sort and cite by ID Field
References in the bibliography will be alphabetized by their ID Fields. These
same ID Fields will be used for in-text citations.

If two references have identical ID Fields, Papyrus will automatically add dis-
tinguishing letters to them; e.g., SMITH98a and SMITH98b.

Overall format

When citing by number, most output formats display the in-text number either as a superscript
or within round or square brackets.

When citing by name & year or ID Field, most output formats display the in-text citation within
round or square brackets.

The Plain option—which will leave the in-text number, name & year, or ID Field as just plain
unbracketted text—comes in handy on occasion for unusual situations.

Space after comma (“1, 2” vs. “1,2”)

When citing by number, whether you wish to include a space between adjacent citations usu-
ally depends on whether or not the citations will be superscripted. With superscripts, omitting
the space is sometimes considered aesthetically superior.

Abbreviate “4,5,6” to “4-6”

Most formats involving citation by number do employ this rule.

Sort umlauts as in German (ö = oe, etc.)

As I’ve explained elsewhere, even if you tell Papyrus to sort according to the rules of German,
your Macintosh will not sort umlauts in this way. So if you are creating a bibliography for a
German-language publication you will probably want to turn on this option.
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Include initials if ambiguous (“Smith,Q. 1984; Smith,H. 1996” vs. “Smith
1984, 1996”)

Sometimes your bibliography will include two authors with the same surname but different
first names. If your citations refer to authors by surname only, then the reader will not immedi-
ately recognize who is whom. For example:

Although one scholar agrees with us (Smith 1997), another vehemently disagrees (Smith
1998).

Turning on the above option causes Papyrus to automatically add the authors’ initials to in-text
citations for those surnames that appear in your bibliography for two or more different people:

Although one scholar agrees with us (Smith, Q. 1997), another vehemently disagrees
(Smith, H. 1998).

Names ALL CAPS

Some bibliographic styles demand that in-text citations display author names entirely in up-
percase, e.g., (SMITH 1996). Turn on this option for such cases.

Style for names

Usually names appearing within in-text citations will not have any special formatting. But some
editors require these to be in small caps—(SMITH 1996)—or perhaps italic—(Smith 1996). For
such formats use the Style menu to select the appropriate style(s).
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One or two authors

This dialog controls the appearance of in-text citations for references with only one or two
authors.

For each case you indicate the punctuation that should appear between the pieces of the cita-
tion. For a one-author citation this is the punctuation between the author and the year. For a
two-author citation you specify both the punctuation between the first author and the second
author, and the punctuation between the second author and the year.

This “punctuation” can consist of a space, as shown above before the years, a comma and
space, the word and, an ampersand (&), or whatever character or characters you desire.
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Several authors

This dialog controls the appearance of in-text citations for references with more than two authors.

The Three-Author citation section works in the same way as do the one-author and two-author
sections. However, if your et al. rules imply that in-text citations will never display more than
two authors, then this section will be disabled (as above).

The et al. section governs the appearance of in-text citations; a different part of your output
format controls whether these same references will or will not use et al. in the bibliography.

To italicize et al., select the text and choose Italic from the Style menu:
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Multiple citations

Often you will cite more than one reference at a given point in your text. When this happens,
there are some details to establish about sorting and displaying the adjacent citations.

First, if two adjacent citations have different authors, then you must specify the punctuation
that will separate the citations. The most common choices are comma-space (Smith 1996, Will-
iams 1989) and semicolon-space (Smith 1996; Williams 1989).

Next, if two adjacent citations have the same authors, then only the year will appear for the
second citation. You need to indicate the punctuation that precedes this second year.

Finally, Papyrus can automatically sort the adjacent in-text citations. Some bibliographic styles
like them alphabetized, while others prefer them to be arranged by year. You can select either of
these automatic sorting methods, or you can tell Papyrus to leave the adjacent citations in what-
ever order you’ve entered their placeholders in your manuscript.
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CHAPTER 40

Numbering & Layout Dialog

Introduction ........................................................R368
Numbering ..........................................................R370
Number appearance........................................R371
Text indents .........................................................R372
Include pictures..................................................R373
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Introduction

When you choose Numbering & Layout in the Format Entry dialog, this dialog appears:

This dialog controls the overall “shape” of each reference, in terms of indentation. It also deter-
mines whether each reference will be preceded by a number, its Reference ID, or no label at all.

As you make changes here, the preview in the upper right of the dialog will display the results
of your settings.
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See also:

WORKBOOK

Creating New Output Formats
Formats, Format Libraries and Predefined Formats
Importing—Overview
Importing—Predefined, Straightforward
Importing—Predefined, Complicated
Importing—Word Processor Bibliography
Importing—Other Structured Databases
Pictures and Graphics

CONCEPTS

Bibliographies vs. Footnote Lists
Output Formats
Bibliographic Conventions

REFERENCE

Format Entry
Sorting & Citing
Authors/Editors Format
Template Entry
Plug-in Filters
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Numbering

Sequence #

Papyrus will sequentially number each reference in your list, regardless of whether the list is
arranged in citation or alphabetic order.

This is the usual setting for bibliographic styles in which the references are to be numbered.

Reference #

Papyrus will display each reference’s Reference # field.

You might select this option when producing a printed index to your holdings.

The three built-in formats—STANDARD , COMPACT, and BRIEF—use this option.

Reference ID field

Papyrus will display each reference’s Reference ID field. You can turn on the All caps option to
automatically convert Reference IDs such as Smith98 to SMITH98.

No number at all

Selecting this option results in a bibliography list in which no numbers or IDs are displayed.

This is the usual setting for bibliographic styles in which references are cited by author and
year. It is also usually the correct choice for import formats.
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Number appearance

In most cases one of the four basic options—123, 123., (123), or [123]—will suffice. If you choose
Other then you can specify whatever characters you wish to see before and after each number.

To specify a character style such as italic or boldface for the number, use the Style menu.

You can tell Papyrus to justify the numbers Left:

8. Runson SK, Rogerstein BT. The judicious use of nitrous oxide in the treatment of
Grave’s disease. New Engl. J. Med. 1990; 182:254-67.

9. Laszlo JA, Snooks BB, Old DH. Unconscious punning among medical researchers.
In: Jung CG, Old DH, editors. Sublimation and Compensation. New York: Perga-
mon Press; 1991:102-29.

10. LaFièvre H. Why Nothing is Funny: A Deconstructionist Analysis. 2nd ed. Cam-
bridge: Harvard University Press; 1992.

11. Ramasubramanian SR, Martin S. Eclectic neurosurgery, Part I: Excision of inhibi-
tions. JAMA 1979; 280:324-30.

or Right:

8. Runson SK, Rogerstein BT. The judicious use of nitrous oxide in the treatment of
Grave’s disease. New Engl. J. Med. 1990; 182:254-67.

9. Laszlo JA, Snooks BB, Old DH. Unconscious punning among medical researchers.
In: Jung CG, Old DH, editors. Sublimation and Compensation. New York: Perga-
mon Press; 1991:102-29.

10. LaFièvre H. Why Nothing is Funny: A Deconstructionist Analysis. 2nd ed. Cam-
bridge: Harvard University Press; 1992.

11. Ramasubramanian SR, Martin S. Eclectic neurosurgery, Part I: Excision of inhibi-
tions. JAMA 1979; 280:324-30.

For left-justified numbers Papyrus lets you specify the number’s indentation. A value of 0 means
that the number will start immediately at the left margin.
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For right-justified numbers Papyrus asks you to specify the right “margin” for the column of
numbers.

The indentation settings are either in inches , centimeters , or characters , as I’ll ex-
plain in a moment.

Text indents

First line—If a number is to be displayed, then the First line indent controls the start of the text
on the first line of each reference, following the number. If no number is to be displayed, then
the First line indent controls the starting line of each reference.

Subsequent lines—When a reference spills over to a second or third line, each of these continu-
ation lines will be indented according to the Subsequent lines setting.

New paragraph—If your templates break references into separate paragraphs—e.g., one para-
graph for the bibliographic information and another paragraph for your Comments—then this
setting controls the starting position of the first line of each new paragraph.

You may select inches, centimeters, or characters as the unit for all of these indent settings.
Characters makes sense if you will use this format to produce plain text files, perhaps for e-
mailing. You would also use characters if this is an import format.

When this format will be used for printed lists, or for bibliographies to be sent to your word
processor, you might want to adjust these indents according to the font size used at the time.
For example, while a 0.5-inch indent might look good with 12-point type, if you print the same
reference list using 9-point type then that same 0.5-inch indent will be too generous. If you turn
on the Scaled to: option, then Papyrus will adjust all indents proportionally to the font size
used for the reference list. The pop-up menu next to the Scaled to: checkbox allows you to
indicate the base font size for which the indicated indents apply.
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• • •

For import formats, these indent settings are critical.

During imports Papyrus will use the indentation, if any, of the incoming data to break up the
records into separate paragraphs. Any line that begins in the Subsequent lines position will be
considered a continuation of the preceding paragraph, while lines beginning in any other posi-
tion (not necessarily the First line or New paragraph position) will be considered the start of a
fresh paragraph.

Include pictures

If you have used the Picture field for any of your references, this option controls whether those
graphics will be displayed when you produce a reference list with this format. If you turn on
this option, then any pictures will be displayed immediately following the reference:

24. Apple Computer, Inc. (1994): World Map [Computer graphic]. Source: Macintosh
System 7.5 Color world map, provided in default scrapbook. PICT, 360 x 178 pixels.
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CHAPTER 41

Authors/Editors Format

Introduction ........................................................R376
Each name .........................................................R378
Multiple names ...................................................R380
Special cases......................................................R381
et al. .....................................................................R382
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Introduction

When you choose Authors or Editors in the Format Entry dialog, this dialog appears:

This dialog controls the display of Authors or Editors in your reference list. You can control the
appearance of each name, how multiple names are combined, the use of et al., and so on.

As you make changes here, the preview in the upper right of the dialog will display the results
of your settings.

There are three “panels” in this dialog: Each name, Multiple names, and et al. For Authors
there is also a fourth panel: Special cases. You switch among these panels by clicking the but-
tons at the top of the dialog.

Shortcut: Press �  -Tab or Shift- �  -Tab to switch among the panels.
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See also:

WORKBOOK

Creating New Output Formats
Formats, Format Libraries and Predefined Formats
Importing—Overview
Importing—Predefined, Straightforward
Importing—Predefined, Complicated
Importing—Word Processor Bibliography
Importing—Other Structured Databases

CONCEPTS

Bibliographies vs. Footnote Lists
Output Formats
Bibliographic Conventions
Names

REFERENCE

Format Entry
Sorting & Citing
Numbering & Layout
Template Entry
Plug-in Filters
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Each name

First name(s)

Here you specify whether Papyrus is to include each author’s full first names (when present in
the database), or whether it should shorten these to just initials. You can also suppress all but
the surname, by choosing None.

First name punctuation

Usually when including full first names you will choose the S. B. option—initials are to be
followed by a period, and a space separates the parts of the first and middle names. For biblio-
graphic styles that include only initials, pick whichever punctuation style is appropriate.

First author and Subsequent authors

Many bibliographic styles specify that the first author be “inverted”—surname followed by
first names—while subsequent authors are to be displayed in their usual form—first names
followed by surname. Other styles invert all authors, or none of them.

Therefore Papyrus lets you define the appearance of the first author independently from that of
subsequent authors. In the above example, the first author is to be displayed as surname then
comma and space then firstname. Subsequent authors will be displayed as firstname space
surname.
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Clicking the  button inserts a paragraph-break between the first names and surname. This
will very occasionally come in handy for import formats.

Now and then a bibliographic style requires that surnames and/or first names be displayed all
in upper case. You can use the Surname ALL CAPS and Firstname ALL CAPS options to accom-
plish this.

Do not  choose either of these options if what you really need are SMALL  CAPS. These
can instead be set for the entire Authors or Editors field when you set up the template
for Article, Book, etc.
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Multiple names

Here you establish the punctuation that separates authors. This can be different for two-author
vs. three-or-more-author references.

It is quite common, for example, that when the final name is preceded by and there will be a
comma inserted before that and only for references with three or more authors, as illustrated
above.

Clicking a  button inserts a paragraph-break into the adjacent punctuation field. This can
come in handy for import formats:



Chapter 41: Authors/Editors Format R381

C
O

N
C

E
P

T
S

R
E

F
E

R
E

N
C

E

Special cases

As explained elsewhere, if a reference has no author then you should either type Anonymous or
Anon. for the reference’s Author #1 field.

If you entered Anonymous, then Papyrus will always display that word in the author position
in bibliographies, regardless of the settings in the above dialog.

If you entered Anon., then the above settings control what happens in a reference list made
using this output format. If you have not selected Suppress author if “Anon.”, then Anon. will
appear in the author position. But if you have turned on this option, then the author position
will be left empty.

For formats where you have chosen to suppress “Anon.”, you have the additional option of
shifting the Title field into the author position. This is the approach taken by the American
Psychological Association style, for example.

For examples of the various Repeated authors options, see the Creating New Output Formats
chapter in the WORKBOOK section.



R382 Dialogs: Format-Related

et al.

If you wish to always display all authors for each reference in your bibliography, then turn off
this Use et al. option.

But some Bibliography Editors would prefer not to see all the authors for overly-collaborative
works. This dialog allows you to set up the appropriate rules.

Note that these rules are independent of those determining the appearance of name &
year citations within the text  of your manuscript.

You can italicize the et al. if you desire. Select the text and choose Italic from the Style menu:
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CHAPTER 42

Template Entry Dialog

Introduction ........................................................R384
Field List ...............................................................R386
Template .............................................................R387
Details ..................................................................R390
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Introduction

When you choose any of the reference types listed in the Format Entry dialog, the template
entry dialog for that reference type appears:

There are many examples and explanations of the use of this dialog given in
the WORKBOOK chapters indicated below. Carefully reviewing those chapters
is the best way to understand all of the possibilities and subtleties here.

The preview in the upper right changes to reflect your current settings. For an output format
this preview gives you an excellent idea of how your references will look when listed using this
format. For an import format it can be less exact, since import formats often include a number
of optional or repeating fields that will not all be present in any single incoming reference.

The Details button switches the dialog between the Template view (shown above) and the
Details view.



Chapter 42: Template Entry Dialog R385

C
O

N
C

E
P

T
S

R
E

F
E

R
E

N
C

E

See also:

WORKBOOK

Creating New Output Formats
Formats, Format Libraries and Predefined Formats
Importing—Overview
Importing—Predefined, Straightforward
Importing—Predefined, Complicated
Importing—Word Processor Bibliography
Importing—Other Structured Databases

CONCEPTS

Bibliographies vs. Footnote Lists
Output Formats
Bibliographic Conventions

REFERENCE

Format Entry
Sorting & Citing
Numbering & Layout
Authors/Editors Format
Plug-in Filters
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Field List

This is a list of all fields available for this particular reference type. To add one of these to your
template, double-click it. You can also select the desired field with your arrow keys or by typ-
ing its first few letters, and then press Return to add it to your template.

The first entry is always Discard. This “field” only applies to import formats, where it means
that the corresponding piece of the incoming reference is not to be retained anywhere in the
resulting Papyrus reference.

The Pages entry reflects Papyrus’s actual Page(s) field. There are also entries for Starting Page
and Ending Page that allow you to break apart the Page(s) field. For output formats this comes
in handy when a bibliographic style wants you to display only the starting page number for
each reference. For import formats these choices allow you to cope with incoming references in
which the starting and ending pages are provided in two separate locations.

In addition to separate entries for the Papyrus Publisher and City of Publication fields, the field
list also includes a composite entry named Publishers & Cities. Choosing this gives you total
control over the order of elements and the punctuation used when a reference includes more
than one publisher and/or city of publication.

For the Dissertation/Thesis  reference type, this entry is called Institution & Location .
For Archival materials  it is Archives & Location .

For journals you can choose from several entries: Journal Name, Journal Abbreviation, Journal
Call Number, Journal ISSN, Journal URL, and Journal Comments. So you can create an output
format, for example, that presents the usual bibliographic information for each reference, in-
cluding journal name or abbreviation, but that then shows the journal call number on a separate
line—such a format might come in handy when you need to look up a list of references in your
library. An import format can use these various choices to deal with incoming references in
which the various bits of journal information appear in separate locations.
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When displaying keywords you will usually want to include all of them, by selecting Keywords
from this list. You can also restrict the display to either Major Keywords or Minor Keywords. In
an import format this allows you to handle incoming references that provide these different
categories of keywords in separate positions.

Template

Here is where you lay out the fields and punctuation for this reference type. You select the fields
from the field list, and then type in any periods, spaces, letters, numbers, or other intervening
punctuation.

Particularly in import formats there can be a lot of intervening punctuation:

As you type, Papyrus will insert line-breaks and add coloring to help make your tem-
plate easy to read. These actions are triggered mainly by the paragraph-break indicator,
and therefore apply mostly to import  formats.
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Use the buttons above the template to insert these special indicators:

This indicates a paragraph-break.

For an output format Papyrus will move to a new line, indenting it as you’ve
indicated in the New paragraph setting in the Numbering & Layout section of
the format.

For an import format this indicator implies that at this point in the incoming
reference there is a line-break, and the next line begins at a position other than
the Subsequent lines indent indicated in Numbering & Layout.

For output formats, all fields and punctuation appearing within a set of If First
brackets will only appear if the first field in the brackets exists.

For import formats If First brackets can be interpreted to mean “this informa-
tion may or may not be present in the incoming data.”

For both output and import formats, If Any brackets behave similarly to If First
brackets. However, If Any brackets are more intelligent when several indepen-
dent fields appear within them. For further discussion, see the Creating New
Output Formats chapter of the WORKBOOK.

Compared to If First brackets, If Any brackets slow Papyrus a little bit, espe-
cially in import formats.

For output formats, for most fields Multiple brackets behave exactly like If First
brackets. But for a field that can appear more than once in a reference—such as
Publisher or Equivalent Patent Country—the contents of a set of Multiple brack-
ets containing this field will be repeated as many times as necessary to display
each occurrence of the field in the reference.

For import formats these brackets mean “this information may or may not be
present in the incoming data; if present, it might be repeated any number of
times.”
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These Capitalize brackets will convert the first letter of all contained major words
to uppercase. This is especially useful for Title fields, where you can enter the
field using sentence-style capitalization, and later let an output format convert
this to headline-style capitalization when needed.

In a tabular output format, this indicator is how you break the template into
columns:
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Details

This is where you specify the details that pertain to whatever fields you have included in your
template.

The detail panels are appear in the dialog in the same order that their corresponding fields
occur in your template. So if a given field appears more than once in your template (as happens
in many import formats), that field’s detail panel will also appear more than once, allowing
you to set different details for each occurrence.

• • •

There are quite a few detail settings that can appear:

These three choices would respectively yield: 1999, 99, and ’99.

The Suppress if non-numeric option tells Papyrus to hide the year when it is
something like In press or Submitted.
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These include the most commonly used methods of abbreviating page num-
bers. Chicago is the method used in the Chicago Manual of Style, MLA is that of
the Modern Language Association, and Oxford is that of the Oxford Univer-
sity Press.

Turn on the Spell “p./pp.” option if you would like Papyrus to add pp. or pages
or the like before the page numbers. While you could instead type those letters
directly into your template, this option enables Papyrus to choose between one
form for single-page references (p. 34) and another form for multiple-page ref-
erences (pp. 34-36). Separate the two forms with a slash, as shown above.

When you include Journal Abbreviation in your template, this panel allows
you to tell Papyrus whether to suppress the periods within the abbreviation.

If your database includes more than one style of journal abbreviation, this pop-
up menu lets you pick the style appropriate to this format.

As explained elsewhere, some bibliographic styles display journal issue num-
bers regardless of the journal, while others do this only for journals that cannot
be identified without this information. With this option turned off, the issue
will only be displayed for those journals whose entry in your database indicate
that Issue should routinely be cited.

As explained elsewhere, some bibliographic styles display the journal series
regardless of the journal, while others do this only for journals that cannot be
identified without this information. With this option turned off, the series will
only be displayed for those journals whose entry in your database indicate that
Series should routinely be cited.
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These choices are self-explanatory. Papyrus obtains month names and abbre-
viations from your Macintosh’s operating system, so they will appear in your
customary language.

As explained elsewhere, some bibliographic styles display journal day and
month regardless of the journal, while others do this only for journals that can-
not be identified without this information. With the Display for ALL journals
option turned off, the day and month will only be displayed for those journals
whose entry in your database indicate that Day & Month should routinely be
cited.

Date fields can be displayed in three different forms. The ISO form is often
used in Patent citations, but otherwise I’ve never encountered it in a bibliogra-
phy.

For the non-ISO forms, Papyrus obtains the month name or abbreviation from
your Macintosh’s operating system, so they will appear in your customary lan-
guage.

Edition numbers, and other ordinal numbering fields, are stored in Papyrus
complete with a suffix (nd, th, etc.). This option allows you to cope with formats
that look either like this:

... 3rd edition ...

or like this:

... Edition 3 ...

Books and some other references may have more than a single Publisher, and/
or more than a single City of Publication. When you use the Publishers &
Cities “field” in your template, this panel lets you control the arrangement of
these various pieces of information.

The above settings would yield results such as:
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Cambridge: Harvard University Press, Oxford: Oxford University Press

Here you indicate the singular and plural forms for each of these roles, sepa-
rated by a slash. These might be spelled out in full (Editor/Editors) or abbreviated
(Ed./Eds.), depending on the bibliographic style.

If a reference includes more than a single keyword, this determines the punc-
tuation between each keyword and the next.

The  button allows you to insert a paragraph-break into the separating punc-
tuation. This can arise sometimes in import formats:

This corresponds to giving each keyword its own paragraph, starting each para-
graph with MH -

For a tabular format, this is where you set the size of the various columns. As
you drag the column sliders, the results will be apparent in the preview at the
top of the template entry dialog.

These column widths are not absolute, but rather are proportional to the total
line width. For example, the above settings will assign approximately 36% of
the line to the Author column, about 10% to the Year column, and the remain-
ing 54% to the Publisher column. So when you use a tabular format in, say, a
Group window, the amount of space available for each field will change when
you resize the window.

If your format includes more than one line with multiple columns, then this
panel will offer a ruler for each such line, with the appropriate number of slid-
ers on each ruler.
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CHAPTER 43

Plug-in Filters
In the Format Entry dialog you can specify one or more plug-in filters that Papyrus is to use
when importing references using this format.

These filters are actually small programs, stored in your Papyrus Additions folder.

Plug-in filters clean up or rearrange incoming references, making them more tractable for Papyrus
to import.

If you are curious about the function of a given filter, simply double-click its icon in the Finder.
Papyrus will provide a brief description:
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Here are the descriptions of the current plug-in filters that ship with Papyrus. We will doubtless
create additional filters in the months to come; the complete set of filters will always be avail-
able from our Web site.

Alphabetize Tags Rearranges the fields of the incoming reference so that the field tags
(AU, TI, etc.) are in alphabetic order.

Helpful, for example, for typed-in references in the Refer/Bib style, where
there was no restriction on field order.

BibTeX For importing BibTeX “bib” files.

Before importing, you must add a blank line between each reference
and the next in the bib file.

After this plug-in, you must invoke the “Alphabetize Tags” plug-in.

Bookends Import data exported from Bookends as a text file.

EndNote Similar to the “Outdent Percents” plug-in filter, for dealing with “Refer”
exports from EndNote.

Outdent Percents For importing files in the Refer or Bib style, in which tags such as “%A”
and “%T” are used.

Any line starting with a “%” will be forced to start at the left margin. All
other lines will be indented exactly one space.

Silver Platter For files downloaded from Silver Platter databases.

See also:

WORKBOOK

Importing—Predefined, Complicated
Importing—Other Structured Databases

REFERENCE

Format Entry
Sorting & Citing
Numbering & Layout
Authors/Editors Format
Template Entry
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CHAPTER 44

File Menu

Open Database...
Opens an existing Papyrus database, or lets you create a fresh
one.

Close Database
Closes the current Papyrus database.

Open Text Document...
Opens any plain text document.

Close
Closes the active window.

Hold down the Option key to close a Reference Entry or Group window with-
out saving any changes

Save
Saves the contents of the active window.

Revert
Restores the current reference to how it appeared in your database prior to the
changes you have so far made in the Reference Entry window.

Get Info
Displays information about the contents of the active window.

Page Setup...
Brings up the standard Macintosh dialog about paper size, orientation, etc.

Print/Export...
Use this item either to print the contents of the active window, or else to export
it to your word processor. The resulting Print/Export dialog contains many
options that you can adjust.

Cross-Reference List...
Use this item to produce a list of references sorted by Author, Year, Keyword,
or any other indexed field in your database, via the Cross-Reference List dia-
log.
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List with Index...
Use this item to print or export some or all of the current Group, followed by
an index to the printed/exported entries by the field of your choice. For example,
you might print a list of references, followed by a keyword index or an author
index. The Indexed List dialog contains several options that you can adjust.

Database Settings...
This item opens the Database Settings dialog, from which you can control
many fundamental aspects of your Papyrus database.

Database Repair...
This item opens the Database Repair dialog. You will occasionally need this
feature if a computer crash or other problem has resulted in damage to your
Papyrus database.

Papyrus-Papyrus Transfer...
Use this item to transfer references from this database to or from another Papyrus
database. The Papyrus-Papyrus Transfer dialog allows you to work with ei-
ther Version 7 or Version 8 of Papyrus.

Quit
Exits Papyrus.
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CHAPTER 45

Edit Menu
Undo

Reverses your last action in the active window.

Cut
Moves the current selection in the active window to the clip-
board.

Copy
Copies the current selection in the active window to the clip-
board.

Paste
Inserts the clipboard contents into the active window.

Clear
Erases the current selection in the active window.

Select All
Selects everything in the active window or field.

Look up
The “Look up” command changes according to the type of field you are cur-
rently entering or editing. For example, if you are working on an Author field,
the menu command will read “Look up Author”. This applies to Authors, Edi-
tors, Journals, Keywords, and any other field that is whole-indexed. For the
remaining fields (such as Title), the command will read “Look up in Glossary”.

If you choose “Look up” for an empty field, the appropriate window will open
from which you can select your intended author, keyword, etc.

If you first type a few letters and then choose “Look up”, one of two things
will happen. If Papyrus knows of only a single item that begins with those
letters, it will insert that item immediately. If Papyrus knows of no such items,
or it knows of two or more matching items, it will take you to the appropriate
window.

You can also use an asterisk as a wildcard. For example, typing neuro*gy and
then choosing “Look up” might open a window containing the choices Neurol-
ogy, Neuropathology, and Neurophysiology.
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Duplicate This Field...
Duplicate Remaining Fields...

If a second Reference Entry window is open, then you can use these commands
to copy information from that window to the present one.

Duplicate This Field will only be available if the present field is still empty.
Choosing it will fill in the present field with the value used in the other window.

Duplicate Remaining Fields will fill in all empty fields in the present window,
using the corresponding fields from the other window.

The references in the two windows may be of different reference types. For
example, if the present reference is a Chapter and the other a Book, then Papyrus
understands that the Book’s “authors” correspond to the Chapter’s “editors”.

Paste Symbol
Use this command to quickly insert a character from the Symbol font.

Find & Replace Text...
Lets you search a specified field for some text, and replace that text with differ-
ent text. You can search all references in the current Group, or only the
currently-selected references. The Find & Replace Text dialog offers you sev-
eral options that you can adjust.

Change Field...
Lets you replace or add text to a specified field, or move or copy the contents of
one field to another. You can do this for all references in the current Group, or
for only the currently-selected references. The Change Field dialog offers you
several options that you can adjust.

Check Spelling...
Checks the spelling of either the currently-selected text, field, or references, or
else all the references in the current Group. Papyrus performs spellchecking in
conjunction with a third-party spelling checker, such as Spellswell Plus.

Launch URL
If the currently-selected text, reference, or journal includes an Internet URL,
then Launch URL will instruct your Web browser to go to the indicated ad-
dress. Papyrus handles this via the Internet Config extension.

Show Clipboard
Displays the contents of the clipboard.
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CHAPTER 46

Reference Menu
New

Opens a fresh Reference Entry window for you to enter a new refer-
ence.

Find...
Opens the Find dialog to search for references.

Edit
Opens a Reference Entry window for each of the currently-selected references.

Delete
Permanently deletes the currently-selected references from your database.

Merge
Combines the currently-selected references into a single reference. You will use
this when you discover duplicate entries corresponding to the same publica-
tion. When some fields differ between the entries, such as keywords or
comments, Papyrus will ask you whether you wish to keep one version or the
other, or combine the two.

Add Notecards
Opens a new Reference Entry window where you can enter one or more new
notecards. These notecards will be linked to each of the currently-selected ref-
erences.

Cite...
Places the currently-selected reference into the clipboard, so that you can paste
them into another application, such as a word processor. The Cite dialog lets
you decide whether the references will be pasted as formatted citations or as
placeholders for a subsequent Process Manuscript operation.

Import...
Opens the Import dialog to load references from a text file.

Duplicates...
Opens the Duplicates dialog to locate and eliminate duplicate reference en-
tries in your Papyrus database.
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CHAPTER 47

Group Menu
New Group

Creates a new, empty Group window.

Open Group...
Opens an existing Group.

Edit Description
Allows you to edit the current Group’s description line.

Set Format...
Lets you change the format used for sorting and printing the current Group.

Sort...
Lets you change the scheme used for sorting the current Group, via the Sorting
dialog.

Refine Search...
The Refine Search dialog allows you to perform new searches, modify and re-
run old searches, or combine searches for the current Group.

Process Manuscript...
After you have inserted Papyrus reference placeholders throughout your word
processor manuscript, the Process Manuscript function will read through the
manuscript and automatically generate your finished manuscript. The Process
Manuscript dialog provides several options for you to adjust.

Specific Pages...
Occasionally a bibliography will indicate the exact pages cited within a cited
work. “Specific Pages...” allows you to indicate such pages for the currently-
selected reference. (See Specific Pages in the WORKBOOK.)

Cite Together
Tells Papyrus that when it prints or exports this Group as a bibliography, the
selected references are to be combined into a single citation within the bibliog-
raphy. (See Citing References Together in the WORKBOOK.)

Cite Separately
Cancels the effect of a previous Cite Together.
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CHAPTER 48

Font Menu
For Reference Entry windows, use this menu to set the font of text
you enter.

Almost all of the time you will stick to the first item in the menu,
BASE FONT. You can choose which screen font will be used to dis-
play this base font in the Reference Entry window, via the Preferences button.

When you later print or export your references, you will be able to set the font to be used for all
“base font” text.

In rare cases you will need to specify a particular font as you type. For example, you might need
to quote some Japanese or Hebrew or Greek text.

When you pick a font other than BASE FONT, that text will always be displayed in that specific
font, even if you later export the reference to your word processor.

• • •

For other windows, choosing a font from the Font menu will make that the font used in the
active window.
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CHAPTER 49

Style Menu
For Reference Entry windows, use this menu to set the style of text you enter.

You cannot adjust the size of text here, because that will be set later when you
print or export your references.

• • •

For other windows, choosing a font size from the Style menu will make that
the font size used in the active window.
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CHAPTER 50

Windows Menu
Use this menu to open one of Papyrus’s special windows (Keywords, Jour-
nals, etc.), or to switch to an already-open Group or Reference Entry window.

The active window is checked.

A bullet (•) indicates the target window.
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CHAPTER 51

Using Papyrus with TeX, LaTeX, and BibTeX

Introduction ........................................................R412
Character encodings ........................................R414
Customizing character conversions ................R416
TeX Settings dialog .............................................R417
Exchanging data between Papyrus

and BibTeX ...............................................R421
BibTeX → Papyrus ...............................................R422
Papyrus → BibTeX ...............................................R424
Inserting Papyrus placeholders ........................R425
Processing a TeX manuscript ............................R426
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Introduction

TeX is a high-quality computerized typesetting system, originally designed for mathematicians
but now widely used in other areas as well. LaTeX is a popular TeX-based document prepara-
tion system that includes a bibliography helper program named BibTeX.

If you didn’t already know all that, then probably you have no great need to read further
in this section! (And you’re probably also wondering why a high-quality typesetting sys-
tem seems to have so much trouble with capital letters in the middle of its own name.)

When working with TeX or LaTeX, you can use Papyrus in conjunction with BibTeX, or instead of
BibTeX. Frankly, I think that the latter makes much more sense—but I’ve learned never to argue
with TeX users about their personal preferences.

Using Papyrus in conjunction with BibTeX means transferring bibliographic data back and
forth between Papyrus and BibTeX bib files. You will then work with LaTeX and BibTeX as
usual.

Using Papyrus instead of BibTeX means that you will insert Papyrus placeholders into your
TeX document, and then use Papyrus to convert these to the appropriate in-text forms and to
append the corresponding bibliography to your document.

Regardless of which approach you take, you will need to give some thought to character
encodings, since TeX and Papyrus use different representations for symbols and accented let-
ters.
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See also:

WORKBOOK

Groups
Preparing a Manuscript and its Bibliography Together
Importing—Overview

CONCEPTS

Output Formats
Reference Types and Fields
Groups

REFERENCE

Group Window
Citing References
Import
Process Manuscript
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Character encodings

The most complicated issue in exchanging data between Papyrus and TeX is that of dealing
with symbols and accented letters. Papyrus uses the Macintosh character set (which fortunately
does include extensive support for non-English languages—unlike certain other popular oper-
ating systems which shall here remain nameless), while TeX uses its own character set.

In many cases there are straightforward correspondences between the two representations. For
example:

TeX Mac
\’e or \’{e} é

\c{C} or \c C Ç
\copyright ©

But TeX also includes symbols and typesetting notations that have no corresponding Mac/
Papyrus representations. And there are Mac characters and fonts that have no TeX equivalents.

Hence, transferring information between Papyrus and TeX can never be an absolutely faithful
process. On the other hand, Papyrus does have a rudimentary knowledge of TeX, so it will
usually do a fairly intelligent job of reading and writing TeX notations.

This is an area where we expect to improve Papyrus’s performance in the future, based
on feedback from you TeX users.

You need to decide whether you will use Papyrus only with TeX, or whether
you will also use it with other applications, such as a non-TeX word processor.

If your Papyrus data are always going to be exported as TeX documents before printing, then
you might choose to always use TeX notation when you enter information into Papyrus. For
example, when entering a reference into Papyrus, rather than typing:

According to LaFièvre, every instance of x2 in the equation is incorrect.

you could type:

According to LaFi\`{e}vre, {\it every\/} instance of $x^2$ in the equation is incorrect.

In practice, however, there is little reason to worry about that \`{e} or the {\it...\/}, because these
are both straightforward conversions that Papyrus can handle automatically when you ask it to
export your references as a TeX file.

Math mode, on the other hand, is an extremely powerful TeX tool with only a partial Papyrus
equivalent. Papyrus will automatically handle simple, common math mode notations, such as
converting x2 to x$^2$. Papyrus also knows how to convert characters from the Symbol font,
including all the Greek letters, to TeX. But for complex mathematical expressions you might
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wish to stick to TeX notation. The main drawback in doing so is that the TeX codes will appear
unchanged when you export your Papyrus references to a non-TeX word processor.

The ten reserved TeX characters ($ # % & \ { } ^ _ ~ ) also present a problem. When Papyrus
exports your references as a TeX file, you can specify whether these reserved characters are to
be converted to their equivalent TeX escape sequences (\$ \# \% etc.), or whether they are to be
exported without change. If you have decided to always type your information into Papyrus
using TeX notation, then you will tell Papyrus to leave these reserved characters alone—which
implies that you will always have to remember to use TeX notation when typing the reserved
characters.

In other words, you need to decide, for your entire database, whether to always type things like
this:

His fiancée charged him $15.

or like this:

His fianc\’{e}e charged him \$15.

Either of these approaches will allow Papyrus to produce a reasonable TeX file. But you must be
consistent—if you instead typed:

His fianc\’{e}e charged him $15.

then when Papyrus exports this sentence you can obtain either this:

His fianc\’{e}e charged him $15.

—which has an unterminated math mode expression—or else this:

His fianc$\backslash$’${$e$}$e charged him \$15.

which is not going to make that fiancée very happy.
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Customizing character conversions

Papyrus maintains a user-modifiable table of font maps for translating between Mac characters
and TeX notation. There are two default maps: one for the Symbol font, and one for the stan-
dard Roman set used by most English and Western European language fonts.

You can override Papyrus’s default settings, but please let us know if you believe that
we have erred in any of them!

Your computer may have additional special fonts that include characters not present in the
standard Roman set. For example, a letter with a macron accent, represented by the TeX control
sequence \={o}, has no equivalent in standard Roman fonts. If you work in a field that routinely
uses such non-standard characters, then you can set up an additional font map for your special
font.

When you tell Papyrus to export data as a TeX file, any characters you have typed in your
special font will be converted to the TeX control sequence given in your font map. Similarly,
when you tell Papyrus to import references from a TeX file, any occurrences of your indicated
TeX control sequence will be converted to the corresponding character in your special font.

During an import, in consulting its table of font maps Papyrus starts with your custom maps
and then works backwards through Symbol and finally the default Roman map. For example, if
an incoming reference contains the TeX notation \’{a}, Papyrus will check each of your custom
maps to see if you have entered this particular control sequence as the equivalent of a Mac
character. If not, then Papyrus will next examine the Symbol map. Failing to find the control
sequence there, Papyrus finally moves on to the default Roman map, where it will find \’{a} as
one of the equivalents entered for the letter á. So the control sequence will be turned into an á
(in the Papyrus BASE FONT).

On the other hand, if an incoming reference contains \={o}, then Papyrus will find this sequence
in your custom font map. The control sequence will be turned into the corresponding character
in your special font.

If an incoming control sequence does not appear in any of your database’s font maps, then
Papyrus will leave it intact. For example, if you are using only the default font maps then an
incoming reference containing the word f\={o}ln will be carried into Papyrus as f\={o}ln, in the
usual BASE FONT.
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TeX Settings dialog

To open this dialog, choose Database Settings... from the File menu, and then click the TeX
conversion button.

When the dialog opens it shows the default Roman font map:

The default map happens to provide a pair of TeX control sequences for each of the characters
shown here. The two possible sequences are separated by a comma. Other characters in the
default map specify only a single sequence.

When Papyrus exports references as a TeX file, it will use the first sequence given for a charac-
ter. Thus, É will always be exported as \’{E}.

When Papyrus imports references from a TeX file, it will accept any of the control sequences
shown in your font maps. Thus, both \’{E} and \’E will be converted to É.

The number shown to the left of each Mac character is simply the decimal value corre-
sponding to that character’s position in the Mac character set.

• • •
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You use the dialog’s pull-down menu to examine or modify your other font maps. Here is a
section of the Symbol map:

Here we see that Papyrus is prepared to substitute the math mode equivalents for individual
Greek letters from the Symbol font.

If you use actual Greek fonts in your work, you will definitely want to add a font map for
one of your true Greek fonts, so that incoming TeX sequences will convert to real Greek
rather than Symbol characters.

• • •
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To create a new font map, go to the Font menu and choose your special font. A new, empty
map will be created for that font. You can then fill in the map as appropriate:

Note that there is no need to provide TeX control sequences for characters that have already
been defined in the default Roman map. In fact, doing so would be a bad idea—whenever
Papyrus encountered one of those control sequences, it would set the Papyrus character to your
special font instead of allowing it to take on Papyrus’s usual BASE FONT.

• • •
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Clicking the Delete this font map button causes Papyrus to discard the currently-shown map.
(The button is disabled if the current map is the default Roman map or the Symbol map, since
those cannot be deleted.)

Clicking Use for BASE FONT tells Papyrus to use the currently-shown map when converting
to or from BASE FONT. This is helpful if you routinely use a non-standard Roman font in
Papyrus. For your routine text you can thus indicate a corresponding font map, rather than the
default Roman map. Meanwhile, anywhere that you have explicitly used a standard Roman
font such as Times or Helvetica Papyrus will continue to use the default map.

The Convert $#%&\{}^_~ checkbox determines whether or not Papyrus will convert the ten
reserved TeX characters into their corresponding TeX control sequences when exporting refer-
ences. As I explain elsewhere, you want to give this some thought.

The Add LaTeX header when exporting checkbox tells Papyrus to add a few standard LaTeX
lines at the start of any TeX output file it creates:

\documentstyle{article}
\begin{document}

as well as a matching line at the end of the file:

\end{document}



Chapter 51: Using Papyrus with TeX, LaTeX, and BibTeX R421

C
O

N
C

E
P

T
S

R
E

F
E

R
E

N
C

E

Exchanging data between Papyrus and BibTeX

Papyrus is able to import standard BibTeX data, as stored in a BibTeX bib file. Papyrus can also
export its own data in the form of a bib file that BibTeX can read.

We have based our conversion facilities on BibTeX version 0.99, as defined in Leslie Lamport’s
LaTeX: A Document Preparation System and supplemented by Oren Patashnik’s Internet-avail-
able document BibTeXing. We have also added some additional commonly-used fields such as
abstract, ISBN and URL.

The Good News...

If your references consist mainly of straightforward books, book chapters and journal articles,
then you can look forward to relatively painless and reliable transfers between Papyrus and
BibTeX. Particularly if you seldom need to use Central European or Asian characters, or math
mode.

... and The Bad News

BibTeX and Papyrus have strikingly different views of the bibliographic universe. For example,
Papyrus comes with 16 predefined reference types while BibTeX has 14 entry types—but only a
few of these have one-to-one correspondences. For example, Papyrus’s Article type matches
BibTeX’s article pretty well, but Papyrus’s Book commingles BibTeX’s book, booklet, manual
and techreport. On the other hand, there is no standard BibTeX entry type corresponding to
many of Papyrus’s reference types, such as Map, Patent, Issue of journal, Internet source, etc.

Similarly, the various fields available in the two systems overlap but differ in many details.

Things could be worse, though

While we cannot provide predefined templates for converting between non-standard or non-
matching Papyrus and BibTeX fields or reference types, you often can. As long as you can decide
which Papyrus field in your Papyrus database corresponds to each BibTeX field in your BibTeX
database, then you can modify the Papyrus import and output formats to transfer the informa-
tion as you like it.

Still, nothing is perfect

Papyrus has links and notecards. There are no corresponding features in BibTeX, so there is no
way to transfer such information to BibTeX.

BibTeX has cross-references. Papyrus does not (for the moment, anyhow), so a BibTeX entry
that depends on a cross-referenced entry for some of its essential information will import into
Papyrus as an incomplete reference.
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BibTeX →→→→→ Papyrus

You can import a BibTeX bib file into Papyrus using our predefined BibTeX import format, found
in the BibTeX formats format library. This format depends on two of our plug-in import filters:
BibTeX and Alphabetize Tags.

Adding the import format to your database

To open the BibTeX formats library, first use the Windows menu to open your Formats window.
Then use that window’s Library Open button to open BibTeX formats.

Or, if you prefer, you can simply go to the Finder and double-click the BibTeX formats docu-
ment.

If you do not have a copy of BibTeX formats, you can download it from our Web site.

Once the format library’s window is open, you can drag the BibTeX import format from the
library window to your Formats window. Then close both windows.

The plug-in filters

Make sure that a folder named Papyrus Additions is located in the same place as your Papyrus
application itself. For example, if Papyrus is in your “Applications” folder, then Papyrus Addi-
tions should also be in your “Applications” folder.

Papyrus Additions may contain several Papyrus plug-ins. Make sure that BibTeX and Alphabet-
ize Tags are among these. If they are not there, then you can download them from our Web site.

The BibTeX  filter does several things. It rearranges the first line of the reference so that
the key  field comes first, followed by the entry type . For each field, the filter removes
the surrounding quotation marks or braces, and ensures that each field is given a line to
itself. Also the entry type and the name of each field are changed to all-uppercase.

The Alphabetize Tags  filter then rearranges the fields so that they are sorted according
to the name of each field.

Preparing your bib  file for importing

Papyrus requires one or more blank lines between each incoming reference and the next. If the
references in your bib file are not so separated, use a text editor or word processor to add a
blank line before each reference.

BibTeX allows you to enter authors and editors either as firstname lastname or as lastname,
firstname. However, a Papyrus import format can only accept one form or the other. So you
need to edit your bib file to ensure that all author and editor names are entered in a single,
consistent form.
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Modifying the BibTeX import  format

If you have a straightforward bib file that uses only standard BibTeX entry types and fields,
then our predefined BibTeX import format should work for you without modification. Other-
wise, here are some considerations.

First, make sure that the Author Names and Editor Names parts of BibTeX import do indeed
match the way that names appear in your bib file.

Next, examine each of the format’s templates: Article in journal, Book/Monograph, Chapter in
book, etc. You need only consider those templates that correspond to entry types actually present
in your bib file.

Extraneous fields present in a template are not a problem, since each field in the template should
be enclosed in brackets indicating that it may or may not be present in every incoming refer-
ence.

If your bib file includes fields that are not present in a template, you will need to add these to
the template. Be sure to enter the name of the field all in uppercase letters, and to position the
field in alphabetical order.

If you need help in modifying this or any Papyrus import format, please contact our
Technical Support Department.

Actually running the import

Now that we have laid all the groundwork, you can finally try importing your BibTeX refer-
ences into Papyrus!

From the Reference menu, choose Import... Fill in this dialog in the usual fashion. In particu-
lar, be sure to use the following settings:

Tolerant will usually be the best Fussiness Level for a BibTeX import, but in some cases you
might need to use Oblivious. Start with Tolerant and see what happens.
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Papyrus →→→→→ BibTeX

To export references from Papyrus in the form of a BibTeX bib file, you will use our predefined
BibTeX output format. This format is found in the BibTeX formats format library.

To open the BibTeX formats library, first use the Windows menu to open your Formats window.
Then use that window’s Library Open button to open BibTeX formats.

Or, if you prefer, you can simply go to the Finder and double-click the BibTeX formats docu-
ment.

If you do not have a copy of BibTeX formats, you can download it from our Web site.

Once the format library’s window is open, you can drag the BibTeX output format from the
library window to your Formats window. Then close both windows.

Exporting your references

Select your references and choose Print/Export... from the File menu. Indicate which references
are to be exported, in the usual fashion.

Set the format to our predefined BibTeX output format, and make sure to pick Plain text as the
document type:

Trust me here—do not choose TeX as the document type. When Papyrus notes that
your chosen format’s name begins with the letters BibTeX , it will automatically convert
each exported field into TeX notation.

Modifying the BibTeX output  format

While our predefined format will work well for simple, straightforward references, you can
customize it to meet your particular needs and preferences. For example, you may need to add
fields that you use for special purposes, or add additional templates for your own custom refer-
ence types.
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Inserting Papyrus placeholders

To use Papyrus instead of BibTeX, you will follow the usual Papyrus approach for citing refer-
ences. That is, you will insert Papyrus placeholders into your TeX manuscript, using either the
Cite dialog, or copy/paste, or drag/drop.

Papyrus does not care what delimiters you use for your placeholders. You can certainly use the
default Papyrus delimiters:

...as we have seen [[4342, 4341]]...

or you might prefer more TeX-like delimiters:

...as we have seen \cite{4342, 4341}...

You can also use the Papyrus ID Field instead of Reference #:

...as we have seen [[Pouch96, Rosarch88]]...

or:

...as we have seen \cite{Pouch96, Rosarch88}...

You can set your preferences in the Cite Settings dialog:
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Processing a TeX manuscript

Once you have a TeX manuscript containing Papyrus placeholders, you can follow the usual
Papyrus Process Manuscript procedure.

Be sure to specify TeX/LaTeX for the file type:

This will create a new TeX file (manuscript1.tex in the above example) in which all of your
placeholders have been changed to the appropriate in-text forms, and in which the bibliogra-
phy has been inserted at the appropriate spot.

Note that in contrast to using BibTeX, there is no need to make multiple passes through BibTeX
and LaTeX to accomplish all of this. A single pass through Papyrus’s Process Manuscript func-
tion followed by a single pass through LaTeX will generate your final document.
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Introduction

EndNote is another popular bibliographic database application. In cooperation with the mak-
ers of EndNote, we have created Papyrus import and output formats to allow you to exchange
references between these two programs.

For ordinary books, chapters and journal articles, Papyrus and EndNote will usually transfer
all information quite smoothly.

However, each program provides some predefined reference types and fields lacking in the
other. And both allow you to create your own reference types and fields. When dealing with
such inconsistencies you will have to modify our predefined import and output formats to
match your specific needs.

As always, our Technical Support Department is happy to give you a hand with such
tasks.

One particular Papyrus reference type lacking in EndNote is Notecard. EndNote doesn’t have
a corresponding concept of records that aren’t actually reference citations, so you’ll have to
decide for yourself about how to handle these on the EndNote side.

EndNote also lacks the Papyrus concept of linking references together, so you will not be able
to preserve reference links when sending Papyrus data to EndNote.

See also:

WORKBOOK

Importing—Overview

CONCEPTS

Output Formats
Reference Types and Fields

REFERENCE

Print/Export
Import
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EndNote →→→→→ Papyrus

EndNote contains a built-in output style named Refer. You can tell EndNote to export refer-
ences to a plain text file using this style.

You can then import the resulting text file into Papyrus, using our predefined EndNote Refer
format (found in the EndNote Import/Export format library). This format depends on two of our
plug-in import filters: EndNote and Alphabetize Tags.

Adding the import format to your database

To open the EndNote Import/Export library, first use the Windows menu to open your Formats
window. Then use that window’s Library Open button to open EndNote Import/Export.

Or, if you prefer, you can simply go to the Finder and double-click the EndNote Import/Export
document.

If you do not have a copy of EndNote Import/Export, you can download it from our Web site.

Once the format library’s window is open, you can drag the EndNote Refer format from the
library window to your Formats window. Then close both windows.

The plug-in filters

Make sure that a folder named Papyrus Additions is located in the same place as your Papyrus
application itself. For example, if Papyrus is in your “Applications” folder, then Papyrus Addi-
tions should also be in your “Applications” folder.

Papyrus Additions may contain several Papyrus plug-ins. Make sure that EndNote and Alpha-
betize Tags are among these. If they are not there, then you can download them from our Web
site.

The EndNote Import/Export  filter adjusts the indentation of lines starting with a “%“ so
that Papyrus can easily identify the boundaries between each field and the next. It also
cleans up the extra lines that sometimes appear within the EndNote keyword field.

The Alphabetize Tags  filter then rearranges the fields so that they are sorted according
to the name of each field.

Preparing your EndNote references for importing

EndNote allows you to enter authors and editors either as firstname lastname or as lastname,
firstname. However, a Papyrus import format can only accept one form or the other. So you
may need to edit your EndNote references to ensure that all author and editor names are entered



R430 Miscellaneous

in a single, consistent form. You can do this either in EndNote, prior to exporting the references,
or else in your word processor after creating the text file of references.

Alternatively, you can try importing the file of mixed author styles twice —first with a
version of the EndNote Refer import format that expects lastname, firstname  and then
with a version that expects firstname lastname . Each import will reject the references
that the other accepts.

Modifying the EndNote Refer  format

If you are working with standard sorts of articles, chapters, etc., then our predefined EndNote
Refer format should work for you without modification. Otherwise, here are some consider-
ations.

First, make sure that the Author Names and Editor Names parts of EndNote Refer do indeed
match the way that names appear in your EndNote references.

Next, examine each of the format’s templates: Article in journal, Book/Monograph, Chapter in
book, etc. You need only consider those templates that correspond to entry types actually present
in your EndNote database.

Extraneous fields present in a template are not a problem, since each field in the template should
be enclosed in brackets indicating that it may or may not be present in every incoming refer-
ence.

If your incoming file includes fields that are not present in a template, you will need to add
these to the template. Be sure to enter the field tags (such as “%A“) using uppercase letters, and
to position each field in alphabetical order.

If you need help in modifying this or any Papyrus import format, please contact our
Technical Support Department.

Actually running the import

Now that we have laid all the groundwork, you can finally try importing your EndNote refer-
ences into Papyrus!

From the Reference menu, choose Import... Fill in this dialog in the usual fashion. In particu-
lar, be sure to use the following settings:
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Oblivious will usually be the best Fussiness Level for an EndNote import.

Be sure to set the character style to either Mac or DOS, depending on whether the incoming file
is from the Macintosh or Windows version of EndNote.
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Papyrus →→→→→ EndNote

To export references from Papyrus as a file that EndNote can read, you will use our predefined
EndNote Output format. This format is found in the EndNote Import/Export format library.

To open the EndNote Import/Export library, first use the Windows menu to open your Formats
window. Then use that window’s Library Open button to open EndNote Import/Export.

Or, if you prefer, you can simply go to the Finder and double-click the EndNote Import/Export
document.

If you do not have a copy of EndNote Import/Export, you can download it from our Web site.

Once the format library’s window is open, you can drag the EndNote Output format from the
library window to your Formats window. Then close both windows.

Exporting your references

Select your references and choose Print/Export... from the File menu. Indicate which references
are to be exported, in the usual fashion.

Set the format to our predefined EndNote Output format, and make sure to pick Plain text as the
document type:

Modifying the EndNote Output  format

While our predefined format will work well for most Papyrus databases, you can customize it
to meet your particular needs and preferences. For example, you may need to add fields that
you use for special purposes, or add additional templates for your own custom reference types.
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CHAPTER 1

Dialogs
In most Papyrus dialogs you can “press” the buttons by typing their first letter on your key-
board.

For example, in this dialog:

typing c is equivalent to clicking Cancel, d is equivalent to the Different people button, r to
Review existing items, and s to Same person.

Of course, as in all Macintosh applications esc  or �-  period  is equivalent to Cancel .
And pressing return  or enter  is the same as clicking the outlined default button—Same
person  in this case.

There are some dialogs in which this sort of keyboard shortcut is not available. Specifically,
when the dialog includes a text field all of your keystrokes will be directed there:
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CHAPTER 2

Switching Windows
You can always switch from any window to the next open Reference Entry, Group, Links or
All References window by pressing �-  tab.

Repeatedly pressing �-  tab will cycle you through all of the open windows of these types.

If the current active window is a dictionary window, then �-  tab will take you to the target
window.

Holding down Shift  while pressing �-  tab  takes you through the windows in the oppo-
site order.

As of Mac OS 8.5, the Macintosh system software treats �-  tab as an instruction to change
from the current application to the next running application. If you do not change this system-
wide setting, you can still use Papyrus’s shortcut by pressing Shift or Option or Control along
with �-  tab.

See also:

REFERENCE

The Target Window
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CHAPTER 3

Status Window
Clicking any of the counts in the Status window:

will open the corresponding All References, Journals, Keywords, or Formats window.

See also:

REFERENCE

Status Window
Database ID dialog
All References Window
Journals Window
Keywords Window
Formats Window
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CHAPTER 4

Reference Entry Window

Keyboard shortcuts

Enter Save this reference.

If you are entering new references, then Papyrus will reset the entry
window for your next reference.

If you are editing a reference from a Group, then Papyrus will close the
entry window.

�- Home Move to first field. (This is usually Reference #.)

�- End Move to final field. (This is usually Keyword.)

�- ↑↑↑↑↑ Move to previous reference. (Same as clicking the  button at the top
of the window.)

�- ↓↓↓↓↓ Move to next reference. (Same as clicking the  button at the top of
the window.)

Option-Return Insert a line-break within a Free Text field.

�- H Equivalent to clicking the Show hidden fields checkbox.
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Drag and Drop shortcuts

Drag from: Drag to:

Keywords window Reference Entry Add one or more keywords to reference.
window

Journals window Reference Entry Set reference’s Journal field.
window

Formats window Reference Entry Set the format for the window’s preview
window display.

Reference Entry Reference Entry Set empty fields in the entry window to the
window or window values present in the dragged reference.
Group window

For example, you might drag an existing Book
or Chapter reference onto a new Chapter ref-
erence to fill in the Editors, Book Title,
Publisher, etc.

Reference Entry Group window Add the reference to the Group.
window

Note: to drag the reference from a Reference Entry window to another window, click any-
where in the reference preview at the top of the window and drag.

Other Mouse shortcuts

To edit a particular field, click on that field in the reference preview at the top of the window.

You can move the border between the field names and values, or the border at the bottom of the
reference preview, by clicking on that border and dragging. (These changes will only apply to
the current window. To make the new border positions the default for all future Reference En-
try windows, you must click the Preferences button.)

Option-Double-click For a Name, Journal or Keyword field, open an editing window
for that item.

For a Quoting Reference field, open a Reference Entry window
for that reference.

Shift-Option-Double-click For a Keyword or Quoting Reference field, open a Links
window for that item.

�-  Double-click Equivalent to choosing Launch URL from the Edit menu.
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Data entry shortcuts

Look up (�-  L)

The “Look up” command in the Edit menu changes according to the type of field you are
currently entering or editing. For example, if you are working on an Author field, the menu
command will read “Look up Author”. This applies for Authors, Editors, Journals, Keywords,
and for any other field that is whole-indexed. For the remaining fields (such as Title), the com-
mand will read “Look up in Glossary”.

If you choose “Look up” for an empty field, the appropriate window will open from which you
can select your intended author, keyword, etc.

If you first type a few letters and then choose “Look up”, one of two things will happen. If
Papyrus knows of only one item that begins with those letters, it will insert that item immedi-
ately. If Papyrus knows of no such items, or it knows of two or more matching items, it will take
you to the appropriate window.

You can also use an asterisk as a wildcard. For example, typing neuro*gy and then choosing
“Look up” might open a window containing the choices Neurology, Neuropathology, and Neuro-
physiology.

Duplicate This Field (�-  D)
Duplicate Remaining Fields (�-  Option-D)

If a second Reference Entry window is open, then you can use these commands from the Edit
menu to copy information from that window to the present one.

Duplicate This Field will only be available if the present field is still empty. Choosing it will fill
in the present field with the value used in the other window.

Duplicate Remaining Fields will fill in all empty fields in the present window, using the corre-
sponding fields from the other window.

The references in the two windows may be of different reference types. For example, if the
present reference is a Chapter and the other a Book, then Papyrus understands that the Book’s
“authors” correspond to the Chapter’s “editors”.

Paste symbol (�-  Y)

Use this command to quickly insert a character from the Symbol font.
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Other shortcuts

If you have made some changes to a reference, or have begun to enter a new reference, but now
wish to close the window or move to the next reference without saving your work, then hold
down the Option key while you close the window or click the window’s  or  buttons.
Papyrus will skip its usual question about saving the reference.

See also:

WORKBOOK

Inputting References, Part 1
Inputting References, Part 2
Modifying References

CONCEPTS

Reference Types and Fields
Journals
Keywords
Names
Incomplete References

REFERENCE

Reference Entry Window
Edit Menu
Glossary Window
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CHAPTER 5

All References Window

Keyboard shortcuts

↑↑↑↑↑ Select the previous reference in the window.

↓↓↓↓↓ Select the next reference in the window.

�- ↑↑↑↑↑ Select the first reference in the window.

�- ↓↓↓↓↓ Select the last reference in the window.

Shift-↑↑↑↑↑ Add the previous reference in the window to the current selection.

Shift-↓↓↓↓↓ Add the next reference in the window to the current selection.

�-  Shift-↑↑↑↑↑ Add all preceding references in the window to the current selection.

�-  Shift-↓↓↓↓↓ Add all following references in the window to the current selection.

Return or Enter Switch between “Table” and “Individual items” view.

“Type-select” If you type the first few numbers or letters corresponding to a refer-
ence, Papyrus will select that reference.

If the window is currently in Alphabetic order, then typing a few let-
ters will take you to the first reference whose first author’s surname
starts with those letters.

Or if the window is currently in Numeric order, then typing a number
will take you to the reference bearing that number.
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Drag and Drop shortcuts

Drag from: Drag to:

Keywords window All References Add one or more keywords, either to every
window reference in the database, or to only the

currently-selected references in the window.

Formats window All References Change one of the window’s display formats.
window

All References Group window Add the reference(s) to the Group.
window

All References Reference Entry Set empty fields in the entry window to the
window window  values present in the dragged reference.

For example, you might drag an existing Book
or Chapter reference onto a new Chapter
reference to fill in the Editors, Book Title,
Publisher, etc.

Other Mouse shortcuts

Double-click Switch between “Table” and “Individual items” view for the
selected reference.

Option-Double-click Open a Reference Entry window for the selected reference.
(Equivalent to choosing Edit from the Reference menu.)

Shift-Option-Double-click Open a Links window for the selected reference. (Equivalent
to clicking the Links window button.)

�-  Double-click Equivalent to choosing Launch URL from the Edit menu.

Other shortcuts

You can use the Font and Style menus to change the font and font size used in the All Refer-
ences window on-screen display. (These changes will only apply to the All References window.
To make these new settings the default for all future Group windows, you must click the Pref-
erences button.)
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See also:

WORKBOOK

Modifying References
Concepts
Groups

REFERENCE

All References Window
Group Window
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CHAPTER 6

Group Window

Keyboard shortcuts

↑↑↑↑↑ Select the preceding reference in the Group.

↓↓↓↓↓ Select the next reference in the Group.

�- ↑↑↑↑↑ Select the first reference in the Group.

�- ↓↓↓↓↓ Select the last reference in the Group.

Shift-↑↑↑↑↑ Add the preceding reference in the Group to the current selection.

Shift-↓↓↓↓↓ Add the next reference in the Group to the current selection.

�-  Shift-↑↑↑↑↑ Add all preceding references in the Group to the current selection.

�-  Shift-↓↓↓↓↓ Add all following references in the Group to the current selection.

Return or Enter Switch between “Table” and “Individual items” view.

Delete or Remove currently-selected reference(s) from the Group.
Forward-Delete (Equivalent to choosing Clear from the Edit menu.)

“Type-select” If you type the first few numbers or letters corresponding to a refer-
ence, Papyrus will select that reference.

For example, if your Group is sorted by Authors, then typing a few
letters will take you to the first reference whose first author’s surname
starts with those letters.

Or if your Group is sorted by Reference #, then typing a number will
take you to the reference bearing that number.

Type-selecting does not work if your Group is sorted in citation order.
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Drag and Drop shortcuts

Drag from: Drag to:

Keywords window Group window Add one or more keywords, either to every
reference in the Group, or to only the cur-
rently-selected references in the Group.

Formats window Group window Change one of the Group’s display formats,
or the Group’s sorting/printing format.

Group window or Group window Add the reference(s) to the Group.
Reference Entry
window

Group window the same Group Move the reference to a different position in
window the Group. (Only makes sense for citation-order

Groups.)

Group window Reference Entry Set empty fields in the entry window to the
window values present in the dragged reference.

For example, you might drag an existing Book
or Chapter reference onto a new Chapter
reference to fill in the Editors, Book Title,
Publisher, etc.

Other Mouse shortcuts

Clicking within the Group’s description, at the top of the window, allows you to edit the de-
scription.

Clicking the name of the Group’s format, at the top-right of the window, allows you to change
to a different format for sorting and printing.

Double-click Switch between “Table” and “Individual items” view for the
selected reference.

Option-Double-click Open a Reference Entry window for the selected reference.
(Equivalent to choosing Edit from the Reference menu.)

Shift-Option-Double-click Open a Links window for the selected reference. (Equivalent
to clicking the Links window button.)

�-  Double-click Equivalent to choosing Launch URL from the Edit menu.
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Other shortcuts

You can use the Font and Style menus to change the font and font size used in the Group’s on-
screen display. (These changes will only apply to the current window. To make these new settings
the default for all future Group windows, you must click the Preferences button.)

If the Group is untitled (as with a Group created by doing a Search), then if you hold down the
Option key while closing the window, Papyrus will skip its usual question about saving the
Group.

See also:

WORKBOOK

Groups
Preparing a Manuscript and its Bibliography Together

CONCEPTS

Groups

REFERENCE

Group Window
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CHAPTER 7

Keywords Window

Keyboard shortcuts

↑↑↑↑↑ Select the preceding keyword in the window.

↓↓↓↓↓ Select the next keyword in the window.

�- ↑↑↑↑↑ Select the first keyword in the window.

�- ↓↓↓↓↓ Select the last keyword in the window.

Shift-↑↑↑↑↑ Add the preceding keyword in the window to the current selection.

Shift-↓↓↓↓↓ Add the next keyword in the window to the current selection.

Tab Switch between the main keyword panel and the links panel.

Delete or In the links panel, remove the link to the currently selected keyword
Forward-Delete or keywords. (Equivalent to choosing Clear from the Edit menu.)

“Type-select” If you type the first few letters of a keyword, Papyrus will select that
keyword.
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Drag and Drop shortcuts

Drag from: Drag to:

Keywords window Keyword Links Create new links for the dragged keyword(s).
window

Keywords window Reference Entry Add the dragged keyword(s) to the reference.
window

Keywords window Group window Add the dragged keyword(s) to the currently-
selected references in the Group, or to all of
the references in the Group.

Keyword Links Keywords window Create new links for the dragged keyword(s).
window (links panel)

Other Mouse shortcuts

Double-click Equivalent to clicking the Select button.

Option-Double-click Open an editing window for the selected keyword. (Equiva-
lent to clicking the Edit... button.)

Shift-Option-Double-click Open a Keyword Links window for the selected keyword.
(Equivalent to clicking the Links window button.)

Other shortcuts

You can use the Font and Style menus to change the font and font size used in the window.
This will affect either the main keywords panel or the links panel, whichever is currently active.
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See also:

WORKBOOK

Modifying References
Keyword Links

CONCEPTS

Keywords
Reference
Keywords Window
Keyword Links Window
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CHAPTER 8

Journals Window

Keyboard shortcuts

↑↑↑↑↑ Select the preceding journal in the window.

↓↓↓↓↓ Select the next journal in the window.

�- ↑↑↑↑↑ Select the first journal in the window.

�- ↓↓↓↓↓ Select the last journal in the window.

Shift-↑↑↑↑↑ Add the preceding journal in the window to the current selection.

Shift-↓↓↓↓↓ Add the next journal in the window to the current selection.

“Type-select” If you type the first few letters of a journal, Papyrus will select that
journal.

Drag and Drop shortcuts

Drag from: Drag to:

Journals window Reference Entry Set the reference’s Journal field (if this
window reference type has a Journal field) to

the dragged journal.

Other Mouse shortcuts

Double-click Equivalent to clicking the Select button.

Option-Double-click Open an editing window for the selected journal. (Equivalent
to clicking the Edit... button.)

�-  Double-click Equivalent to choosing Launch URL from the Edit menu.

Other shortcuts

You can use the Font and Style menus to change the font and font size used in the window.
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See also:

WORKBOOK

Inputting References, Part 1

CONCEPTS

Journals
Reference
Journals Window
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CHAPTER 9

Formats Window

Keyboard shortcuts

↑↑↑↑↑ Select the preceding format in the window.

↓↓↓↓↓ Select the next format in the window.

�- ↑↑↑↑↑ Select the first format in the window.

�- ↓↓↓↓↓ Select the last format in the window.

Shift-↑↑↑↑↑ Add the preceding format in the window to the current selection.

Shift-↓↓↓↓↓ Add the next format in the window to the current selection.

“Type-select” If you type the first few letters of a format’s name, Papyrus will select
that format.

Drag and Drop shortcuts

Drag from: Drag to:

Formats window Reference Entry Set the Reference Entry window’s Preview
window display to use this format.

Formats window All References Set the All Reference window’s table display
window or individual reference display to use this

format.

Formats window Group window Set the Group window’s table display or indi-
vidual reference display to use this format, or
set the Group’s format for sorting and print-
ing.

Formats window Format Library Add the format(s) to the Library.
window

Format Library Formats window Add the format(s) to your database.
window
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Other Mouse shortcuts

Double-click Equivalent to clicking the Select button.

Option-Double-click Open an editing dialog for the selected format. (Equivalent to
clicking the Edit... button.)

Other shortcuts

You can use the Font and Style menus to change the font and font size used in the window.

See also:

WORKBOOK

Formats, Format Libraries and Predefined Formats
Creating New Output Formats
Importing—Overview

CONCEPTS

Output Formats

REFERENCE

Formats Window
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CHAPTER 10

Names Window

Keyboard shortcuts

↑↑↑↑↑ Select the preceding name in the window.

↓↓↓↓↓ Select the next name in the window.

�- ↑↑↑↑↑ Select the first name in the window.

�- ↓↓↓↓↓ Select the last name in the window.

Shift-↑↑↑↑↑ Add the preceding name in the window to the current selection.

Shift-↓↓↓↓↓ Add the next name in the window to the current selection.

“Type-select” If you type the first few letters of a name, Papyrus will select that name.

Drag and Drop shortcuts

Drag from: Drag to:

Names window Any other window Copies a name to the destination.

Other Mouse shortcuts

Double-click Equivalent to clicking the Select button.

Option-Double-click Open an editing window for the selected name. (Equivalent to
clicking the Edit... button.)

Other shortcuts

You can use the Font and Style menus to change the font and font size used in the window.
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See also:

WORKBOOK

Inputting References, Part 2
Globally Changing Information
Exchanging Data With Another Papyrus Version 8 Database

CONCEPTS

Names

REFERENCE

Names Window
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CHAPTER 11

Glossary Window

Keyboard shortcuts

↑↑↑↑↑ Select the preceding entry in the window.

↓↓↓↓↓ Select the next entry in the window.

�- ↑↑↑↑↑ Select the first entry in the window.

�- ↓↓↓↓↓ Select the last entry in the window.

Shift-↑↑↑↑↑ Add the preceding entry in the window to the current selection.

Shift-↓↓↓↓↓ Add the next entry in the window to the current selection.

“Type-select” If you type the first few letters of an entry, Papyrus will select that
entry.

Drag and Drop shortcuts

Drag from: Drag to:

Glossary window Any other window Copies the entry to the other window.

Any other window Glossary window Makes a new Glossary entry from the
dragged text.

Other Mouse shortcuts

Double-click Equivalent to clicking the Select button.

Option-Double-click Open an editing window for the selected keyword.
(Equivalent to clicking the Edit... button.)

Other shortcuts

You can use the Font and Style menus to change the font and font size used in the window.
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See also:

WORKBOOK

Inputting References, Part 2

REFERENCE

Glossary Window
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CHAPTER 12

Keyword Links Window

Keyboard shortcuts

↑↑↑↑↑ Select the preceding keyword in the window.

↓↓↓↓↓ Select the next keyword in the window.

Shift-↑↑↑↑↑ Add the preceding keyword in the window to the current selection.

Shift-↓↓↓↓↓ Add the next keyword in the window to the current selection.

Delete or Remove the link to the currently selected keyword or keywords.
Forward-Delete (Equivalent to choosing Clear from the Edit menu.)

Drag and Drop shortcuts

Drag from: Drag to:

Keywords window Keyword Links Create new links for the dragged keyword(s).
window

Keyword Links Keyword Links Create new links for the dragged keyword(s).
window window

Keyword Links Reference Entry Add the dragged keyword(s) to the reference.
window window

Keyword Links Group window Add the dragged keyword(s) to the currently-
window selected references in the Group, or to all of

the references in the Group.

Other Mouse shortcuts

Option-Double-click Open an editing window for the selected keyword.

Shift-Option-Double-click Open another Keyword Links window for the selected key-
word. (Equivalent to clicking the Links window button.)
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Other shortcuts

You can use the Font and Style menus to change the font and font size used in the window.
(These changes will only apply to the current window. To make these new settings the default
for all future Keyword Links windows, you must click the Preferences button.)

See also:

WORKBOOK

Keyword Links

CONCEPTS

Keywords

REFERENCE

Keyword Links Window
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CHAPTER 13

Reference Links Window

Keyboard shortcuts

↑↑↑↑↑ Select the preceding reference in the window.

↓↓↓↓↓ Select the next reference in the window.

Shift-↑↑↑↑↑ Add the preceding reference in the window to the current selection.

Shift-↓↓↓↓↓ Add the next reference in the window to the current selection.

Return or Enter Switch between “compact” and “expanded” display formats for the
currently-selected references.

Delete or Remove the link to the currently selected reference or references.
Forward-Delete (Equivalent to choosing Clear from the Edit menu.)

Drag and Drop shortcuts

Drag from: Drag to:

Group window or Reference Links Create new links for the dragged reference(s).
Reference Entry or window
Reference Links
window

Formats window Reference Links Change one of the Reference Links window’s
window display formats.

Reference Links Reference Entry Set empty fields in the entry window to the
window window values present in the dragged reference.

For example, you might drag an existing Book
or Chapter reference onto a new Chapter ref-
erence to fill in the Editors, Book Title,
Publisher, etc.

Reference Links Group window Add the reference(s) to the Group.
window
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Other Mouse shortcuts

Double-click Switch between “compact” and “expanded” display formats
for the currently-selected references.

Option-Double-click Open a Reference Entry window for the selected reference.
(Equivalent to choosing Edit from the Reference menu.)

Shift-Option-Double-click Open a Links window for the selected reference. (Equivalent
to clicking the Links window button.)

�-  Double-click Equivalent to choosing Launch URL from the Edit menu.

Other shortcuts

You can use the Font and Style menus to change the font and font size used in the window.
(These changes will only apply to the current window. To make these new settings the default
for all future Reference Links windows, you must click the Preferences button.)

See also:

WORKBOOK

Reference Links

CONCEPTS

Notecards and Linked References

REFERENCE

Reference Links Window
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CHAPTER 14

Find Dialog

Type-select

Within the Field list, you can type the first few letters of a field to select it. For example, typing
ke will select the Keywords field.

Keyboard shortcuts

Tab When the Fields list or the Comparisons list is active, pressing Tab is
equivalent to double-clicking the selected item. The selected item will
be added to the search specification, and the comparison list or the
search specification, as appropriate, will become active.

�-  A Equivalent to clicking the AND button.

�-  O Equivalent to clicking the OR button.

�-  N Equivalent to clicking the NOT button.

�-  [ Equivalent to clicking the ( button.

�-  ] Equivalent to clicking the ) button.
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Look up

Look up, from the Edit menu, allows you to choose authors, editors, keywords, journals, pub-
lishers, cities of publication, etc. from a list of those available in your database.

For example, if you are searching for works by a particular publisher:

then Look up becomes:

Selecting this menu item (or pressing �-  L) will bring up a list of all the publishers in your
database:

Selecting an item from this list will add it to your search specification:
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If you type a few letters before choosing Look-up:

then the resulting list will be limited accordingly:

The Look up function does not work for fields of type Number, Ordinal, Yes-No, Pages, Year or
Date. For other non-indexed or piece-indexed fields, it becomes Look up in Glossary.

See also:

WORKBOOK

Finding References

REFERENCE

Find Dialog

SHORTCUTS

Refine Search Dialog
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CHAPTER 15

Refine Search Dialog

Keyboard shortcuts

N or �-  N Equivalent to clicking the New button.

E or �-  E Equivalent to clicking the Edit button.

R or �-  R Equivalent to clicking the Re-run button.

L  or �-  L Equivalent to clicking the Load button.

C or �-  C Equivalent to clicking the Cancel button.

See also:

WORKBOOK

Finding References

REFERENCE

Find Dialog

SHORTCUTS

Find Dialog
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CHAPTER 16

Cite Dialog

Keyboard shortcuts

P Equivalent to clicking the Placeholder button.

1 Equivalent to clicking the Format 1 button.

2 Equivalent to clicking the Format 2 button.

R Equivalent to clicking the Replace button.

A Equivalent to clicking the Append button.

S Equivalent to clicking the Settings... button.

C Equivalent to clicking the Cancel button.

O Equivalent to clicking the OK button.

See also:

WORKBOOK

Preparing a Manuscript and its Bibliography Together

REFERENCE

Citing references
Process Manuscript
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CHAPTER 17

Format Entry Dialog

Keyboard shortcuts

Tab Move to the next field.

Shift-Tab Move to the previous field.

Return In the list of format parts, open the dialog for the currently-selected
part.

“Type-select” In the list of format parts, typing the first few letters of a part (Sorting
& Citing, Authors, Article, etc.) will select that part.

See also:

WORKBOOK

Creating New Output Formats
Importing—Overview
Importing—Predefined, Straightforward
Importing—Predefined, Complicated
Importing—Word Processor Bibliography
Importing—Other Structured Databases

CONCEPTS

Output Formats

REFERENCE

Format Entry
Sorting & Citing
Numbering & Layout
Authors/Editors Format
Template Entry
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CHAPTER 18

Template Entry Dialog

Keyboard shortcuts

Tab In the Template view, switch between the field list and the template.

In the Details view, move from one textual setting to the next.

Shift-Tab In the Template view, switch between the field list and the template.

In the Details view, move from one textual setting to the previous.

Return In the Template view, with the field list active, pressing Return inserts
the currently-selected field into your template and then switches you
to the template.

“Type-select” In the field list, typing the first few letters of an entry will select that
entry.

�-  Tab or Switch between the Template and Details views.
Shift-�-  Tab

Keyboard equivalents for the special indicator buttons:

�-  |

�-  [ or �-  ]

�-  < or �-  >

�-  { or �-  }
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See also:

WORKBOOK

Creating New Output Formats
Importing—Overview
Importing—Predefined, Straightforward
Importing—Predefined, Complicated
Importing—Word Processor Bibliography
Importing—Other Structured Databases

CONCEPTS

Output Formats

REFERENCE

Format Entry
Sorting & Citing
Numbering & Layout
Authors/Editors Format
Template Entry
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Index 2

Index

Symbols
• (target window)  R78
# major keywords  R31, C36
* (wildcard)  R73, W92–W93
\ (backslash)  R67

A
Abbreviation styles

journal  R239–R240, C30
Abbreviations

indexing of  C58
journal  R239–R240, C21, C30

Abominable databases  W241
Abstract field  R30
Abstract from conference proceedings  R54
Accented letters  W18
Access Codes  R237, C68
Access, read-only  I4
Accession # field  R32

vs. Catalog # field  R32
Acronyms, indexing of  C58
Additions folder  R6
Address. See Affiliation/Address field
Affiliation/Address field  R34
Agreement, license  I5, I7–I11
Alias

to Papyrus database  R12
to Papyrus Help folder  R5

All References window  R114–R125
display formats  R117–R118
drag and drop  R121
elements of  R115
preferences  R118, R119
shortcuts  S13–S15

Allowable Reference Numbers  R231
Alphabetic order  R236–R237, R360, C4, C12
Alphabetize Tags plug-in filter  W262
Alphabetizing rules  W304–W306
Also Print field  R37
American Antiquity format  W199–W202
And others  R33, C14
AND vs. OR in searches  W89–W90
Anon.  R33, R94, C14, W201

Anonymous  R33, R94, R243, R381, C14, W193
vs. Anon.  R94, R381, W176, W201

Anthropology
American Antiquity format  W199–W202

Antonyms, keyword  C38–C39
Apple Computer

less than helpful  W122
Apple Events

printing/exporting via  R274
AppleScript

most feeble implementation  W52
printing/exporting via  R274, W52

AppleWorks  W51, W52, W122
shockingly inadequate  R274

Applications, helper  R241
Applications, patent  R52
Approach, cool  W52
Archival materials  R38
Article

in journal  R39
newspaper  R50

Associated Reference field  R98
Assumptions, overriding  R67
Author-Year citation. See Name-Year citation
Authors. See also Names

anonymous
R33, R94, R381, C14, W176, W193, W201

appearance in bibliographies  R376–R382, C13–
C14, C42–C44, W13

variations  C42–C43
corporate  R33, R95, C14
in-text citations

ALL CAPS  R362
small caps  R362

initials vs. first names  R32, R190, C42
looking up  R73
maximum number of  R20
repeated  C13, W193
sorting  R190, C43
suppress anonymous  R94, C14, W193, W201

Authors dialog  R376–R382
Authors field  R32–R33
Authors Role field  R33–R34, R40, W19

B
Backing up database  R249, W322
Backslash (\)  R67
Balloon help  R14–R15, W12

tour  R15, W12
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Base font  R275, W40
Base name for field  W289
Bibliographic styles. See Formats
Bibliography

authors in  R376–R382
automatically adding to manuscript. See Process

Manuscript
editors in  R376–R382
et al. in  R382
importing into Papyrus  W230–W237
indentation in  R372–R373
pictures in  R373, W281–W282
vs. footnote list  C4–C5

Bibliography editors  C8
BibTeX  R242, R412–R426
Biological Abstracts  W222
BIOSIS  W222
Book series  R41
Book/Monograph  R40–R43
Brackets

Capitalize  W196
If Any  W185
If Any vs. If First  W185
If First  W183–W184
Multiple  W258–W262

Browser, Web  R241
BRS  W222

C
Call number

journals  R163, C32
Capitalization

headline style  R30, C15
sentence style  R30, C15

Capitalize brackets  W196
Capitalizing titles  C15, W16
Card Title field  C50, W65
Catalog # field  R41

vs. Accession # field  R32
CD-ROM, installing Papyrus from  R4
Change Field Dialog  R290–R293, W112–W114
Change text  R284–R287, R292–R293, W104–

W115
Changes, global  W104–W115
Chapter # field  R45
Chapter in book  R44–R45
Character set

importing references  R329

Characters
accented  W18
non-English  W18

Check database integrity  R248
Checking spelling. See Spellchecking
Chem Abstracts  W222
Chicago Manual of Style format  W188–W199
Chihuly flasks  R352
Citation

Harvard style  C16
in text  C12, C15, C16

et al.  R364
names ALL CAPS  R362
names small caps  R362

name-year  C12, C16
adding initials  R362, C16
adding letter  C16

numeric  C15
Citation order  R360, C4, C12, C63, W78–W80
Cite dialog  R321–R322, W126–W127

shortcuts  S43, W126–W127
Cite Settings dialog  R323–R324
Citing

Internet sources  R47
multiple references at once  W136–W139
references in press  C14–C15
URLs  R47

Citing references  R314–R324
as plain text  R320
by ID Field  R361
by year only  R318, W124
formatted  W126–W127
hiding the citation  R319
inserting as formatted references  R319
sorting within manuscript citation  R318

Citing specific pages  R316–R317, C4, C17
ClarisWorks  W52, W122

shockingly inadequate  R274
Clerks, rogue data-entry  W222
Client-server  R24–R26
Closing windows

without being asked to save  S12, S19
Collapse fields  R102, W41
Colleagues, clamoring  I4
Collections of formats. See Format Libraries
Collections of references. See Groups
Column Break  W205
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Combining
databases  W322
journals  R165
keywords  R153
names  R192

Combining multiple references in one citation
W136–W139

Commentators  R33–R34, R41, R95
Comments

field  R30
journals  R163, C32

Compilers  R33, R34, R41, R95
Conference proceedings  R53–R57
Copies

of database  R26, W5
Copying

database to another computer  W322
formats  R178
formatted reference to manuscript  W126–W127
references  R108

to other applications  R323
Corporate author  R33, R95, C14
Creating

new database  R9, W4–W20
new fields  W292–W295
new formats  R177, W170–W207, W231–

W233, W240–W267
new glossary entries  R202
new Groups  W72–W73
new journals  R163
new keyword links  R212–R215, W142–

W145, W145
new keywords  R151, R238
new notecard  W64–W65
new reference links  R224–R226, W152–W154
new reference types  W295–W298
new references  R86–R111, W10–W20, W22–

W32
Creating a subset of a database  R266
Cross-Reference List  R279, W160–W163
Current Contents on Diskette  W222
Cursor, hollow  R81

D
Data entry shortcuts

Reference Entry window  S11

Database
alphabetizing  W304–W305
backing up  R249, W322
copies of  R26, W5
copying to another computer  W322
creating a subset of  R266
creating new  R9, W4–W20
description  R231, W5–W6
index file  R10, R249, W5
indexes  R249, C54–C59
integrity  R248
limits  R20
locked  R25–R26, R83
main document  R10, W5

alias to  R12
multi-user  R24–R26
new  R9
pieces of  R10, C20–C24
read-only  R25–R26, R83
repair  R246–R249
shared  R24–R26
sorting  W304–W305
splitting  R266
subset of  C62–C65. See also Groups
transferring data to another  R252–R266, W308–

W320, W322–W330
advanced concerns  R260–R263
exporting for Version 7  R264, W317
exporting for Version 8  R265–R266, W322–

W330
importing from Version 7 via *.BB files  R258–

R259, W308–W310
importing from Version 7 via PAPX  R256–

R257, W310–W312
importing from Version 8  R253–R255

Database Info dialog  R83, R231–R232, W5–W6
Database Repair dialog  R246–R249
Database Settings dialog  R234–R243
Databases

abominable  W241
combining  W322
distinct  I5, I7
merging  W322
multiple  W6

Date Accessed field  R47
Date field  R96
Date, journal  C30–C32
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Date Posted field  R47
Dates

entering  R96
ISO form  R96

Day & Month field  R95, W183
Day, Month & Year field  R96
Debugging

importing references  R334–
R335, W218, W233–W234

Degree field  R97
Deleting

formats  R178
glossary entries  R203
journals  R164
keyword links  R215, W145–W146, W147–

W152
keywords  R152
reference links  R226, W154
references  W41–W42

Delimiters
in-text placeholders  R315

Demande  R51
Demo version of Papyrus  I4, I7
Departmental site license  I8
Description

database  R231, W5–W6
Group  R132, W73

Dialog
Alphabetizing  W304–W305
Authors  R376–R382
Change Field  R290–R293, W112–W114
Cite  R321–R322

shortcuts  S43
Cite Settings  R323–R324
Cross-Reference List  R279, W160–W163
Database Info  R83, R231–R232, W5–W6
Database Repair  R246–R249
Database Settings  R234–R243
Editors  R376–R382
Fields & Reference Types  R235, W288–W301
Find  R298–R311

shortcuts  S37–S39
Find & Replace Text  R284–R287, R292–

R293, W109–W112
Format Entry  R353–R355

shortcuts  S45, W181
Import Set-up  R328–R331
Layout  W49–W51
List with Index  R281–R282, W166–W168
Miscellaneous Settings  R243

Dialog continued
New Keywords  R238
Numbering & Layout  R368–R373, R369
Papyrus-Papyrus Transfer  R252–R266
Print/Export  R268–R277, W46–W54
Process Manuscript  R345–R348, W122–W124
Refine Search  R309–R311

shortcuts  S41
Sorting & Citing  R358–R365
Template Entry  R384–R393

shortcuts  S47–S48, W181
Dialogs

shortcuts in  S3
Display formats

All References window  R117–R118
Group window  R136–R137
Reference Links window  R222

Dissertation/Thesis  R45–R46
Dissertations on Microfilm  R46
Distinct databases  I5, I7
Document Type field  R98
Document/Media Type field  R37
Drag and Drop

All References window  R121
Formats window  R182
Glossary window  R205
Group window  R140, R141
Journals window  R169
Keyword Links window  R215
Keywords window  R155
Names window  R194
Reference Entry window  R106
Reference Links window  R227
to other applications  R323

Drag and Drop shortcuts
All References window  S14
Formats window  S27
Glossary window  S31
Group window  S18
Journals window  S25
Keyword Links window  S33
Keywords window  S22
Names window  S29
Reference Entry window  S10
Reference Links window  S35

Dragging
formatted reference to manuscript  W126–W127
references to other applications  R323

Drones, underpaid undergraduate, ravages of
R238
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Duplicate references  R338–R341
during importing  R329–R330, W214–W215

Duplicates file
importing references  R326

Duplicating
fields  R108, S11, W30
formats  R178
references  S11, W30

E
Edit menu  R399–R400
Editing

formats  R178
globally  W104–W115
glossary entries  R202
journals  R164, W105–W106
keywords  R151, W104–W105
names  R190, W107–W109
references  W34–W43

Editing items in place  R71
Editor Role field  R95
Editors. See also Names

appearance in bibliographies  R376–R382, C13–
C14, C42–C44

variations  C42–C43
looking up  R73
series  R41

Editors dialog  R376–R382
Editors field  R32–R33
Eliminating duplicate references  R338–R341
EndNote

exchanging data with  R428–R432
Entering

dates  R96
journals  R71, W14
keywords  R70, R238
names  R32–R33, R94–R95, W13

et al.  R94
shortcuts  R94

notecards  W64–W65
notecards and references together  W68–W69
pages  R97
reference numbers  R93
references  R86–R111, W10–W20, W22–W32
years  R34, R95, W13

et al.  R33, R94, C14
in bibliographies  R382
in-text citations  R364

Excalibur  W284

Exchanging data between Papyrus databases. See
Transferring data between Papyrus databases

Exchanging data with EndNote  R428–R432
Exporting. See Printing/Exporting
Exporting to EndNote  R428–R432

F
Field types  R86, R93–R98, R235, W288–W301

associated reference  R98
day & month  R95
day, month & year  R96
degree  R97
document type  R98
editor role  R95
free text  R93
ID Field  R93
journal  R97
keyword  R96–R97
name  R94–R95
number  R94
ordinal  R94
pages  R97
picture  R98
Reference #  R93
title  R94
year  R95
yes or no  R97

Fields  R28–R64, R86, R235, C26–C33, W288–
W301

Abstract  R30
Accession #  R32
Affiliation/Address  R34
Also Print  R37
Associated Reference  R98
Authors  R32–R33
Authors Role  R40
Authors role  R33–R34
Card title  W65
Catalog #  R41
Chapter #  R45
collapsing  R102, W41
Comments  R30
creating new  W292–W295
Date  R96
Date accessed  R47
Date posted  R47
Day & Month  R95
Day, Month & Year  R96
Degree  R97
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Fields continued
Document Type  R98
Document/Media Type  R37
duplicating  R108, S11, W30
Editor Role  R95
Editors  R32–R33
hidden  R90, R102, W28, W291
ID Field  R93

in placeholders  R315
ID field  R30
in format templates  R386–R387
in searches  W84
Inventor  R51
ISBN  R41
Issue Editors  R39
Issue Title  R39, R48
Keywords  R31
Language  R36
Location  R37
maximum size of  R20
Message-id  R62
missing  C46
Month  R95
moving from field to field  R99
multiple  R90, W289
number of  R20
optional  R90, C46, W291
Original Title  R36
Photographer  R60
Picture  R31, R98, W280
Place in reference  R63, W65
Presentation Type  R54
Quotation  R63, W65
Reference #  R29, R93
required  R90, R101–R132, C46, W31, W291
Role of Editor  R34, R41
Short Title  R35
that are indexed  C56, W289–W290
Title  R30, R94
Total # pages  R40
unusual entries  R67
URL  R31, W274–W275
user-defined  R28
whole-indexed vs. piece-indexed  C57–C58
Work Reviewed  R36
Year  R34–R35, R95
Yes or No  R97

Fields & Reference Types dialog  W288–W301
File menu  R397–R398

Fileserver
legal issues  I7

Filters, plug-in  R6, R395–R396, W226–
W228, W262–W263

Alphabetize Tags  W262
Outdent Percents  W262

Find & Replace Text  R284–R287, R290–
R293, W109–W112

Find Dialog  R298–R311
shortcuts  S37–S39

Find dialog
use of Look up in  S38

Finding references  R298–R311, W84–W101
* (wildcard)  W92–W93
AND vs. OR  W89–W90
following keyword links  W147–W148
following reference links  W155
General “field”  R302, C56
loading search results  R298–R299, W100
NOT  W93–W94
quick finds  W86–W88
refining a search  R309–R311, W95–W100
Term “field”  R301, W91
use of parentheses  W94–W95

Folders
organization of  R5–R6

Font
base  R275, W40

Font menu  R405, W40
Fonts

IMPORTANT NOTE  W40
Footnote list

vs. bibliography  C4–C5
Footnotes  C4, C17

informational  C5
short titles in  R35

Format Entry Dialog  R353–R355
Format Entry dialog

shortcuts  S45
Format Libraries  R180–R181, W59–W60
Format Preview window  W57–W58
Format templates

fields in  R386–R387
Formats  W47–W48, W56–W61

Column Breaks  W205
copying  R178
creating  R177, W170–W207, W231–

W233, W240–W267
deleting  R178



Index 8

Formats continued
display

All References window  R117–R118
Group window  R136–R137
Reference Links window  R222

duplicating  R178
editing  R178
If Any brackets  W185
If First brackets  W183–W184
import  W231–W233, W240–W267
libraries  R180–R181, W59–W60
output  C8–C9, W170–W207
paragraphs in  W199
predefined  W59–W60
previewing  R179, W57–W58
printing/exporting  R272
selecting  R177
Sorting/Printing

Group  R133
tabular output  C9, W202–W206
transferring from Version 7  W316
transferring to another Version 8 database

W328
Formats window  R174–R185, W56–W59

drag and drop  R182
elements of  R176
shortcuts  S27–S28

Formatted reference
inserting into manuscript  R319

Free demo version of Papyrus  I4, I7
Free Text fields  R93
FTP sites

citing  R47, W270–W271
Full version of Papyrus  I4, I7
Fussiness level  R330, W212–W213

G
Garbage

in, out  W241
General “field”

as a search term  R302, C56
GeoRef  W228
German, umlauts in  R135, R236, R361, W304
GIGO  W241
Global find & replace  R284–R287, R290–

R293, R292–R293, W104–W115

Glossary entries
creating  R202, W22–W24
deleting  R203
editing  R202
exporting  R204
importing  R203
loading  R203
looking up  R73
printing/exporting  R204, R272
selecting  R201, W22–W24
transferring to another Version 8 database

W329–W330
Glossary window  R200–R207, W22–W24

drag and drop  R205
elements of  R201
shortcuts  S31–S32

Going out of business
avoiding  I5

Good-bye messages  R243
Graphics. See Pictures
Greek letters  R68
Group menu  R403
Group window  R128–R145

description  R132
display formats  R136–R137
drag and drop  R140, R141
elements of  R130
preferences  R138, R139
shortcuts  S17–S19
Sorting/Printing format  R133

Groups  C62–C65, W72–W82
adding and removing references  W73–W75
creating new  W72–W73
description  R132, W73
pointers in  C64
printing/exporting  W80–W81
sorting  R134–R135, C63, W75–W77, W305–

W306

H
Harvard style of citation  C16
Headers and footers

in printing/exporting  R276, W50
Headline-style capitalization  R30, C15
Hell

data sources from  W264–W267
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Help
balloon  R14–R15, W12
folder  R5

alias to  R5
key  R15
online  R14–R17, W11

navigating  R17
tour  R15, W12

Help menu  R14, R16
Helper applications  R241
Hidden fields  R90, R102, W28, W291
Hiding in-text citations  R319
Hierarchical keywords  C37–C38
Hoi polloi

members of  R237
Hollow cursor  R81
HTML

printing/exporting  R273, W53, W277

I
ID field  R30, R93

in placeholders  R315
Identifying

journals  R71
keywords  R70

If Any brackets  W185
vs. If First brackets  W185

If First brackets  W183–W184
vs. If Any brackets  W185

Import formats
creating  W231–W233, W240–W267

Import Set-up dialog  R328–R331, W210–W219
Import window  R332–R335, W217–W218

status  R333
Importing

another Papyrus database  W322
from EndNote  R428–R432
glossary entries  R203
journals  R166–R167
keywords  R153
names  R192–R193
plug-in filters  R6, R395–R396
references  R326–R335, W210–W219

character set  R329
creating a Group  R331
debugging  R333, R334–R335, W218, W233–

W234
duplicates  R329–R330, W214–W215
duplicates file  R326

Importing references continued
from word processor bibliography  W230–

W237
fussiness level  R330, W212–W213
indentation  R373, W243–W244
keywords  R330, W216–W217, W248
keywords, decapitalizing  R330
log file  R326, W213–W214
paragraphs in  W243–W244
plug-in filters  W226–W228, W262–W263
prerequisites  W211–W212
reference #  R330, R331, W216
reference type  R333
reject file  R326, W214
repeated fields  W258–W262
Set-up dialog  R328–R331, W210–W219
spaces within  W233, W247
speeding the process  R332, W218
troubleshooting  W222–W223, W249–W251

In preparation  C14–C15
In press  R37, C14–C15
In-text citation  C12, C15, C16

et al.  R364
names ALL CAPS  R362
names small caps  R362

INCOMPLETE (keyword)  R101–R132, C46–C47
Incomplete references  R101–R132, C46–

C47, W31
Indentation

during importing  R373, W243–W244
in bibliographies  R372–R373

Index file  R10, W5
Index Medicus format. See Vancouver format
Indexed list  W166–W168
Indexes  C54–C59

non-indexed words  C58, W289–W290
rebuilding  R249
which fields are indexed  C56, W289–W290
whole- vs. piece-indexing  C57–C58, W289–

W290
Indices. See Indexes
Individual Items view

All References window  R115
Group window  R130

Individuals, slightly less trusted  R237
Informational footnotes  C5
Initials

adding to name-year citation  R362, C16
vs. first names  R32, R190, C42
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Inputting
references  W10–W20, W22–W32

Insert symbol  R68
Inserting

formatted reference into manuscript
R319, W126–W127

line-break  R69
placeholders into manuscript  W120–W122

Installing Papyrus  R4–R6
Institutional site license  I8
Internet

installing Papyrus from  R4
Internet Config  R31, W272–W273
Internet source  R47, W270–W271
Inventor field  R51
ISBN field  R41
ISO form for dates  R96
ISSN  R163, C32
Issue Editors

journal  R39
Issue number

journal  C30–C32, W183
Issue of journal  R48
Issue Title

journal  R39
Issue Title field  R48

J
Jealousy  C15
Journal

abbreviation styles  R239–R240, C30
abbreviations  C21, C30
abbreviations, reasonable  R71
call number  R163, C32
comments  R163, C32
dates  C30–C32
ISSN  R163, C32
issue numbers  C30–C32
names  C30
other information  C32
series  C30–C32
supplements  C30–C32
URL  R163, C32, W276–W277
Web sites  C32

Journal articles. See Article in journal

Journals
combining  R165
creating  R163, W14
deleting  R164
editing  R164, W105–W106
entering  R71, W14
exporting  R168–R169
importing  R166–R167
loading  R166–R167
looking up  R71, R73
merging  R165
minor  C5
printing  R168–R169
printing/exporting  R272
selecting  R162
throw-away  R39
transferring from Version 7  W314–W315
transferring to another Version 8 database

W326–W327
transferring to Version 7  W319

Journals window  R160–R172
drag and drop  R169, R182
elements of  R161
shortcuts  S25–S26

K
Key

help  R15
Keyboard shortcuts

All References window  S13
Cite dialog  S43
dialogs  S3
Find dialog  S37
Format Entry dialog  S45
Formats window  S27
Glossary window  S31
Group window  S17
Journals window  S25
Keyword Links window  S33
Keywords window  S21
Names window  S29
Reference Entry window  S9, W39
Reference Links window  S35
Refine Search dialog  S41
switching windows  S5
Template Entry dialog  S47
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Keyword links  R210, C38–C39, W142–
W149, W143–W149, W152–W157

creating  R212–R215, W142–W145, W145
deleting  R215, W145–W146, W147–W152
following, in searches  R305, W147–

W148, W149–W151
in Keywords window  W146–W147, W148–

W152
types of  R213–R215

Keyword Links window  R210–R217, W142–
W149, W143–W149, W152–W157

drag and drop  R215
elements of  R211
opening  R155, R210
shortcuts  S33–S34

Keywords  R31, C36–C39, W36–W38
antonyms  C38
combining  R153
creating  R151, R238
deleting  R152
during reference importing  W216–W217
editing  R151, W104–W105
entering  R70, R238
exporting  R154
hierarchical  C37–C38
importing  R153
INCOMPLETE  C46–C47
linked  C38–C39, W142–W149, W143–

W149, W152–W157
loading  R153
looking up  R70, R73
major vs. minor  R31, C36, W248
maximum number of  R20
merging  R153
printing  R154
printing/exporting  R272
selecting  R150, R212
sub-category  C38
super-category  C38
synonyms  C38
transferring from Version 7  W313
transferring to another Version 8 database

W325–W326
transferring to Version 7  W318
truncated  W48
wildcards  R70

Keywords window  R148–R158, R150–R158
drag and drop  R155
elements of  R149, R150
shortcuts  S21–S23
Show Links button  W146–W147, W148–W152

Kokai  R51

L
LAN

legal issues  I7
use of Papyrus  R24–R26

Language
sorting based on  R135, W304–W306

Language field  R36
LaTeX  R242, R412–R426

printing/exporting  R273
Launching Papyrus  R8–R12
Law, Murphy's  C26
Layout

print/export  R275–R277, W49–W51
Legal copies of Papyrus  I4, I5, I7–I11
Letter

added to ID Field citation  R30, R270
added to name-year citation  R270, C16
added to year  R35, R270

Letters
accented  W18
Greek  R68
non-English  W18

Libraries, Format  R180–R181, W59–W60
License

agreement  I5, I7–I11
departmental  I8
institutional  I8
policy, ridiculously reasonable  I5, I7–I11

Limited version of Papyrus  I4, I7
Limits of database  R20
Line-break, inserting  R69
Link types

forward vs. reverse  R214, R225
keyword  R213–R215
reference  R225–R226

Linked keywords  R210–R217, C38–C39, W142–
W149

following, in searches  R305, W147–
W148, W149–W151

Linked references  R220–R230, C51, W152–W157
following, in searches  R307–R308, W155
printing  W156–W157
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Linking
keywords  W142–W145
notecards to references  W66–W67
references  W152–W154

Links Window button  R104, R119, R138, R155
List

Cross-Reference  R279, W160–W163
with Index  R281–R282, W166–W168

Lists
picking from  R75–R76

Loading
glossary entries  R203
journals  R166–R167
keywords  R153
names  R192–R193
references  R326–R335

Loading search results  R298–R299, W100
Location field  R37
Locked database  R25–R26, R83
Log file

importing references  R326, W213–W214
Look Up (Edit menu)  R73, S11, W27, W37

in Find dialog  S38

M
MacWrite, printing/exporting as  R273, W51–

W52
Major vs. minor keywords  R31, C36, W248
Manual order  W78–W80
Manuscript

inserting reference placeholders  R314–
R324, W120–W122

processing  R344–R352, W118–W128
additional text in citation  W124–W125
citing just the year  W124
clearing Group first  R349
formatted references  W125–W126
handling multiple chapter manuscripts  R349
including informational notes  R351–R352
multiple references at once  W136–W139
preparing for  R345
specific pages  W130–W133

Map  R49
Margins, in printing/exporting  R276
Martinet  C9
Masters Thesis  R45–R46, R97
Mathematical symbols  R68

Maximum number
of authors  R20
of records  R20

Medline  W222
Meeting proceedings  R53–R57
Menu

Edit  R399–R400
File  R397–R398
Font  R405
Group  R403
Help  R14, R16
Reference  R401
Style  R407
Windows  R409

Merging
databases  W322
journals  R165
keywords  R153
names  R192

Message-id field  R62
Messages, good-bye  R243
Microsoft Word  R274, W51
Minor journals  C5
Miscellaneous information  R37
Miscellaneous Settings dialog  R243
Missing fields  C46
Mode

read-only  I4
Modifying

formats  R178
glossary entries  R202
journals  R164
keywords  R151
names  R190
references  W34–W43

Money, large sums of  I4
Monograph. See Book/Monograph
Month field  R95
Mouse shortcuts

All References window  S14
Formats window  S28
Glossary window  S31
Group window  S18
Journals window  S25
Keyword Links window  S33
Keywords window  S22
Names window  S29
Reference Entry window  S10
Reference Links window  S36
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Moving data between Papyrus databases. See
Transferring data between Papyrus databases

Multi-user database  R24–R26
Multiple brackets  W258–W262
Multiple databases  W6
Multiple fields  R90, W289
Multiple references in one citation  W136–W139
Multitasking

and hollow cursor  R81

N
Name-Year citation  C12, C16

adding initials  R362, C16
adding letter  C16

Names
combining  R192
compound  C43
editing  R190, W107–W109
entering  R32–R33, R94–R95, W13
exporting  R193–R194
importing  R192–R193
in bibliographies  R376–R382, C13–C14, C42–

C44
in-text citations

ALL CAPS  R362
small caps  R362

initials vs. first names  R32, R190, C42
journal  C30
loading  R192–R193
merging  R192
printing/exporting  R193–R194, R272
repeated  C13
selecting  R189
sorting  R190, C43
transferring to another Version 8 database

W328–W329
variations  R190, C42–C43
vs. persons  R190, C43

Names window  R188–R197
drag and drop  R194
elements of  R189
shortcuts  S29–S30

Network
legal issues  I7
use of Papyrus  R24–R26

New
database  R9
formats  R177
glossary entries  R202
Groups  W72–W73
journals  R163
keyword links  R212–R215, W145
keywords  R151
reference links  R224–R226

New Keywords dialog  R238
Newsgroup post. See Usenet post
Newspaper article  R50
Nisus Writer  R274, W51
Non-English characters  W18
Non-indexed words  C58
NOT in searches  W93–W94
Notecards  R63, R86, C50–C51, W64–W70

Card Title field  W65
creating  W64–W65
entering with references  W68–W69
linking to references  W66–W67
Place in Reference field  W65
printing/exporting  W69–W70
Quotation field  W65
vs. Abstract field  R30
vs. Comments field  R31

Number
reference  R29, R93
sequence  R370

Number fields  R94
Numbering

references in bibliography  R370–R371, C12
Numbering & Layout dialog  R368–R373
Numeric citation  C15

O
Offenlegungsschrift  R52
Online help  R14–R17, W11

navigating  R17
Optional fields  R90, C46, W291
OR vs. AND in searches  W89–W90
Order

alphabetic  R360, C4, C12
citation  R360, C4, C12, C63, W78–W80

Ordinal fields  R94
Original Title field  R36
Other information

journal  C32
Other reference  R64
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Outdent Percents plug-in filter  W262
Output formats  C8–C9, W47–W48

creating  W170–W207
tabular  C9

Overriding Papyrus assumptions  R67
Ovid  W222

P
Pages

citing particular  R316–
R317, C4, C17, C63, W130–W133

discontinuous  R39, R97
entering  R97
specific  R316–R317, C4, C17, C63, W130–

W133
Paper, processing. See Manuscript: processing
PaperChase  W222
PAPX transfer

from Version 7  R256–R257, W310–W312
to Version 7  R264, W317

Papyrus
Additions folder  R6
client-server version  R24
Help folder  R5

alias to  R5
illegal copies of  R4
installing  R4–R6
launching  R8–R12
legal copies of  I4, I5, I7–I11
organization of folders  R5–R6

Papyrus database
alias to  R12
pieces of  C20–C24

Papyrus Help folder  R5
Papyrus-Papyrus transfer  R252–R266, W308–

W320, W322–W330
exporting for Version 7  R264, W317
exporting for Version 8  R265–R266, W322–

W330
importing

advanced concerns  R260–R263
importing from Version 7

via *.BB files  R258–R259, W308–W310
via PAPX  R256–R257, W310–W312

importing from Version 8  R253–R255
Paragraphs

in formats  W199, W243–W244
Parentheses in searches  W94–W95
Passwords. See Access Codes

Paste Symbol  R68
Pasting formatted reference into manuscript

W126–W127
Patent  R51–R52
Patent applications  R52
Persnicketiness  W235
Person

vs. name  C43
Personal Papyrus tutor  I6
Personal preferences of TeX users  R412
Ph.D. dissertation  R45–R46, R97
Phone calls, lengthy, overseas  R4
Photographer field  R60
Picking from a list  R75–R76
Picture field  R31, R98
Pictures  W280–W282

entering  W280
in bibliographies  R373, W281–W282
maximum size of  R20

Piece-indexed fields  C57–C58
Pirated copy of Papyrus  R4
Place in reference field  R63, C50, W65
Placeholders

additional text in  R316
delimiters  R315
ID Field in  R315
in manuscript  R314–R324
inserting into manuscript  W120–W122

Plain text
printing/exporting  R273, W53

Plug-in filters  R6, R395–R396, W226–
W228, W262–W263

Alphabetize Tags  W262
Outdent Percents  W262

Pointers, in Groups  C64
Policy, license  I5, I7–I11
Poster sessions  R54
Predefined formats  W59–W60
Preferences

All References window  R118, R119
Group window  R138, R139
Reference Entry window  R105
Reference Links window  R223

Presentation at meeting  R53–R57
Presentation Type field  R54
Previewing

formats  R179, W57–W58
Print/Export dialog  R268–R277, W46–W54
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Printing/Exporting
as HTML  R273, W53, W277
as MacWrite  R273, W51–W52
as plain text  R273, W53
as RTF  R273, W51–W52
as TeX  R273, W53
as Web page  R273, W53, W277
as word processor document  R273, W51–W52
cross-reference list  W160–W163
font  R275
formats  R272
glossary entries  R204, R272
Groups  W80–W81
headers and footers  R276, W50
index cards  R277, W51
indexed list  W166–W168
journals  R168–R169, R272
keywords  R154, R272
layout  R275–R277
margins  R276
names  R193–R194, R272
notecards  W69–W70
reference links  W156–W157
references  R269–R271, W46–W54

layout  R275–R277
truncating fields in  R271

single item per page  W51
title of list  R275
via AppleScript  R274, W52

Priority patent applications  R52
Process Manuscript  R344–R352, W118–W128

additional text in citation  W124–W125
citing just the year  W124
clearing Group first  R349
dialog  R345–R348, W122–W124
formatted references  W125–W126
handling multiple chapter manuscripts  R349
including informational notes  R351–R352
multiple references at once  W136–W139
preparing for  R314–R324, R345, W120–W122
specific pages  W130–W133

PubMed  W222

Q
Quick Find  W86–W88
Quotation field  R63, C50, W65
Quoted citation  R58–R59, R98

R
Raison d’être, Papyrus’s  W10

Read-only mode  I4, R25–R26, R83
Rebuild index file  R249
Record types. See Reference types
Records, maximum number of  R20
Reference #  R29

during importing  W216
entering  R93
field  R93
range  R231, W5

Reference Entry window  R86–R111, W10–
W20, W22–W32, W34–W43

drag and drop  R106
elements of  R88
preferences  R105
shortcuts  S9–S12
title bar  R88

Reference links  R220, W152–W157
creating  R224–R226, W152–W154
deleting  R226, W154
following, in searches  R307–R308, W155
printing  W156–W157
types of  R225–R226

Reference Links window  R220–R230, W152–
W157, W154

display formats  R222
drag and drop  R227
elements of  R221
opening  R104, R119, R138, R220
preferences  R223
shortcuts  S35–S36

Reference list
importing into Papyrus  W230–W237

Reference menu  R401
Reference types  R28–R64, R86, R235, C26–

C33, W288–W301
Archival materials  R38
Article in journal  R39
Book/Monograph  R40–R43
Chapter in book  R44–R45
choosing  R89
Conference proceedings  R53–R57
creating new  W295–W298
default  R89
Dissertation/Thesis  R45–R46
Dissertations on Microfilm  R46
Internet source  R47, W270–W271
Issue of journal  R48
Map  R49
Newspaper article  R50
Notecard  R63
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Reference types continued
number of  R20
Other reference  R64
Patent  R51–R52
Poster sessions  R54
Presentation at meeting  R53–R57
Quoted citation  R58–R59, R98
Reports  R42–R43
Slide/Visual  R60–R61
Usenet post  R62, W271–W272
user-defined  R28

References
adding to Group  W73–W75
anonymous  R33, R243, C14, W176
citing

as plain text  R320
hiding the citation  R319
inserting as formatted references  R319

citing in manuscript  R314
by year only  R318
sorting within manuscript citation  R318

collections of. See Groups
copying  R108
copying to other applications  R323
deleting  W41–W42
dragging to other applications  R323
duplicates  R338–R341
duplicating  R108, S11, W30
editing  W34–W43
entering  W10–W20, W22–W32
entering with notecards  W68–W69
fields  R235, C26–C33
finding  R298–R311, W84–W101
formatted

pasting into manuscript  W126–W127
groups of  C62–C65
importing  R326–R335, W210–W219

character set  R329
creating a Group  R331
debugging  R333, R334–R335, W218, W233–

W234
duplicates  R329–R330, W214–W215
from word processor bibliography  W230–

W237
fussiness level  R330, W212–W213
indentation  W243–W244
keywords  R330, W216–W217, W248
keywords, decapitalizing  R330
log file  W213–W214
paragraphs in  W243–W244

References, importing continued
plug-in filters  W226–W228, W262–W263
prerequisites  W211–W212
reference #  R330, R331, W216
reference type  R333
reject file  W214
repeated fields  W258–W262
Set-up dialog  R328–R331, W210–W219
spaces within  W233, W247
speeding the process  R332, W218
troubleshooting  W222–W223, W249–W251

in preparation  C14–C15, C46–C47
in press  R37, C14–C15, C46–C47
incomplete  R101–R132, C46–C47, W31
inserting into manuscript  R314–R324
linked  C51, W152–W157
linking to notecards  W66–W67
location of physical reference  R37
maximum size of  R20
numbering in bibliography  R370–R371, C12
obscure  R58–R59
printing/exporting  R269–R271, W46–W54
removing from Group  W73–W75
saving  R100
searching  R298–R311, W84–W101
selecting  R120, R139, R139–R140, R223
sorting  C63, W75–W77
spellchecking  W285–W286
submitted  C14–C15, C46–C47
type. See Reference types

Refine Search dialog  R309–R311, W95–W100
shortcuts  S41

Reject file
importing references  R326, W214

Repair Database dialog  R246–R249
Repair database integrity  R248
Repeated authors  C13, W193
Replacing text  W109–W112, W112–W114
Reports  R42–R43
Required fields  R90, R101–

R132, C46, W31, W291
Reviews  R36
Rogue data-entry clerks  W222
Role of Author field  W19
Role of Editor field  R34, R41
RTF, printing/exporting as  R273, W51–W52

S
Saving references  R100



Index 17

C
O

N
C

E
P

T
S

Search & Replace  R284–R287, R290–R293, W109–
W112

Searching references  R298–R311, W84–W101
* (wildcard)  W92–W93
AND vs. OR  W89–W90
following keyword links  W147–W148
following reference links  W155
General “field”  R302, C56
loading search results  R298–R299, W100
NOT  W93–W94
quick finds  W86–W88
refining a search  R309–R311, W95–W100
Term “field”  R301, W91
use of parentheses  W94–W95
which fields are indexed  C56

Season  R95
Security. See Access Codes
Selecting

by typing  R75–R76
formats  R177
glossary entries  R201
journals  R162
keywords  R150, R212
names  R189
references

in All References window  R120
in Group window  R139, R139–R140
in Reference Links window  R223

Sentence-style capitalization  R30, C15
Separate databases  W6
Sequence number  R370
Series, journal  C30–C32, W183
Series of books  R41
Shared database  R24–R26
Sharing data between Papyrus databases. See

Transferring data between Papyrus databases
Shifting title to author position

C14, W201, W202
Short Title field  R35
Shortcuts

All References window  S13–S15
Cite dialog  S43
dialogs  S3
editing items in place  R71
Editor Role fields  R95
entering names  R32, R94
entering years  R34, R95
Find dialog  S37–S39
Format Entry dialog  S45, W181
Formats window  S27–S28

Shortcuts continued
Glossary window  S31–S32
Group window  S17–S19
Journals window  S25–S26
Keyword Links window  S33–S34
Keywords window  S21–S23
looking up items  R73
moving from field to field  R99
Names window  S29–S30
picking from a list  R75–R76
Reference Entry window  S9–S12, W39
Reference Links window  S35–S36
Refine Search dialog  S41
saving references  R100
switching windows  S5
Template Entry dialog  S47–S48, W181

Show cogitation  R333
Show hidden fields  R90, R102, W28
Show Links button

in Keywords window  W146–W147, W148–
W152

Sign-off messages  R243
Silver Platter  W222
Single item per page, printing  W51
Site license

departmental  I8
institutional  I8

Slide/Visual  R60–R61
Snobbery  C14
Sorting

alphabetic order  R236–R237, R360, C4, C12
by author. See Sorting: alphabetic order
citation order  R360, C4, C12, C63, W78–W80
group  R134–R135, C63, W75–W77
language-dependent  R135, R236–R237, W304–

W306
names  R190, C43
rules  W304–W306
umlauts  R135, R236, R361, W304
within a manuscript citation  R318

Sorting & Citing dialog  R358–R365
Sorting/Printing format

Group  R133
Spaces within imported references  W233, W247
Specific pages  R316–R317, C4, C17, C63, W130–

W133
Specifications of database  R20
Spellchecking  R241, R295, W284–W286

references  W285–W286, W290
text  W284



Index 18

Spellswell Plus  W284
Splitting a database  R266
Status window  R83, W6

shortcuts  S7
STN  W222
Style menu  R407
Styles

bibliographic. See Formats
journal abbreviation  R239–R240, C30

Sub-category, keywords  C38–C39
Submitted  C14–C15
Super-category, keywords  C38–C39
Supplement, journal  C30–C32
Suppress anonymous  C14
Suppress year if "in press"  C15
Symbol font  R68
Symbol, inserting  R68
Symposium  R54
Synonyms, keyword  C38–C39
Systems, writing  R20

T
Table view

All References window  R115
Group window  R130

Tabular output formats  C9, W202–W206
Target window  R77–R79
Telnet sites, citing  R47
Template Entry dialog  R384–R393

shortcuts  S47–S48, W181
Templates, format

fields in  R386–R387
Term “field”

as a search term  R301, W91
TeX  R242, R412–R426

printing/exporting  R273, W53
Text, replacing  W109–W112, W112–W114
Thermodynamics, Second Law of  C26
Thesis. See Dissertation/Thesis
Title  R30, R94

capitalizing  C15, W16
issue  R39, R48
notecard  C50, W65
of list  R275
original  R36
series  R41
shift to author position  C14, W201, W202
short  R35
translated  R36

Total # pages field  R40
Tour of balloon help  R15, W12
Transferring data

between Papyrus databases  R252–R266, W308–
W320, W322–W330

advanced concerns  R260–R263
exporting for Version 7  R264, W317
exporting for Version 8  R265–R266, W322–

W330
importing from Version 7 via *.BB files  R258–

R259, W308–W310
importing from Version 7 via PAPX  R256–

R257, W310–W312
importing from Version 8  R253–R255

to/from EndNote  R428–R432
Translators  R33–R34, R34, R41, R95
Trouble

getting yourself into  C26
Troubleshooting imports  W222–W223, W249–

W251
Truncating fields

printing and exporting  R271, W48
Tutor, personal Papyrus  I6
Type select  R75–R76
Types of fields  R93–R98, R235

associated reference  R98
day & month  R95
day, month & year  R96
degree  R97
document type  R98
editor role  R95
free text  R93
ID Field  R93
journal  R97
keyword  R96–R97
name  R94–R95
number  R94
ordinal  R94
pages  R97
picture  R98
Reference #  R93
title  R94
year  R95
yes or no  R97

Types of links
forward vs. reverse  R214, R225
keyword  R213–R215
reference  R225–R226
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Types of reference  R28–R64,  R37, R86,
R235, C26–C33

Archival materials  R38
Article in journal  R39
Book/Monograph  R40–R43
Chapter in book  R44–R45
choosing  R89
Conference proceedings  R53–R57
default  R89
Dissertation/Thesis  R45–R46
Dissertations on Microfilm  R46
Internet source  R47
Issue of journal  R48
Map  R49
Newspaper article  R50
Notecard  R63
Other reference  R64
Patent  R51–R52
Poster sessions  R54
Presentation at meeting  R53–R57
Quoted citation  R58–R59
Reports  R42–R43
Slide/Visual  R60–R61
Usenet post  R62

U
Umlauts  R135, R236, R361, W304
Uniform Requirements for Biomedical

Journals. See Vancouver format
Unusual entries  R67
URL

in exported reference lists  W277
in reference  W274–W275
in text  W274
journal  R163, C32, W276–W277

URL field  R31, R47, W274–W275
Usenet post  R62, W271–W272
Users

hard-core  C68
types of  C68

V
Vancouver format  W170–W188
Versions of Papyrus  I4, I5, I7
Viewing formats  R179

W
Web browser  R241

Web page
printing/exporting  R273, W53

Web sites, journal  C32
Wedgewood crucibles  R352
Whole-indexed fields  C57–C58
Wildcard (*)  R73, W92–W93
Window

All References  R114–R125
display formats  R117–R118
drag and drop  R121
elements of  R115
preferences  R118, R119
shortcuts  S13–S15

closing, without being asked to save  S12, S19
Format Preview  W57–W58
Formats  R174–R185, W56–W59

drag and drop  R182
elements of  R176
shortcuts  S27–S28

Glossary  R200–R207
drag and drop  R205
elements of  R201
shortcuts  S31–S32

Group  R128–R145
description  R132
display formats  R136–R137
drag and drop  R140, R141
elements of  R130
preferences  R138, R139
shortcuts  S17–S19
Sorting/Printing format  R133

Import  R332–R335, W217–W218
status  R333

Journals  R160–R172
drag and drop  R169, R182
elements of  R161
shortcuts  S25–S26

Keyword Links  R210–R217
drag and drop  R215
elements of  R211
opening  R155, R210
shortcuts  S33–S34

Keywords  R148–R158, R150–R158
drag and drop  R155
elements of  R149, R150
shortcuts  S21–S23

Names  R188–R197
drag and drop  R194
elements of  R189
shortcuts  S29–S30
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Window continued
Reference Entry  R86–R111, W10–W20, W22–

W32, W34–W43
drag and drop  R106
elements of  R88
preferences  R105
shortcuts  S9–S12
title bar  R88

Reference Links  R220–R230, W154
display formats  R222
drag and drop  R227
elements of  R221
opening  R104, R119, R138, R220
preferences  R223
shortcuts  S35–S36

Status  R83, W6
shortcuts  S7

switching
shortcuts  S5

target  R77–R79
Windows menu  R409
Word processor

printing/exporting to  R273, W46–W54
properly designed  W52

nonexistent  R274
Word processor bibliography

importing into Papyrus  W230–W237
Word Services  W284
WordPerfect  R274, W51
Words, non-indexed  C58, W289–W290
Work Reviewed field  R36
Workforms. See Reference types
World Wide Web (WWW)  W270–W278

citing  R47
installing Papyrus from  R4
linking to  R31

WorldScript  R20, R135, R236–R237
Writing systems  R20, R135

Y
Year

adding a letter  R35, R95, R270
entering  W13
field  R34–R35, R95, W13
non-numeric  R35
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